GRADE 10

DESIGN AND TECHNOLOGY COMPUTING
UNIT 3

SPREADSHEET 2

Published by:

FLEXIBLE OPEN AND DISTANCE EDUCATION
PRIVATE MAIL BAG, P.O. WAIGANI, NCD
FOR DEPARTMENT OF EDUCATION
PAPUA NEW GUINEA
GRADE 10
DESIGN AND TECHNOLOGY-COMPUTING

UNIT 3

SPREADSHEET 2

- REVIEWING THE SPREADSHEET
- FORMATTING AND PRINTING SPREADSHEET
- FORMULA
- GRAPHICAL REPRESENTATION OF DATA
## Acknowledgments

You acknowledge the contributions of all Secondary Teachers who in one way or another helped to develop this Course.

Our profound gratitude goes to the former Principal of FODE, Mr. Demas Tongogo for leading FODE team towards this great achievement. Special thanks to the FODE IT Edit Team and SRC Members who played an active role in critiquing and editing to ensure quality control for this Course.

You also acknowledge the professional guidance provided by the Curriculum Assessment Division throughout the process of writing especially to the late Mr. Tobias Gena.

The development of this book was co-funded by GoPNG and World Bank.

**DIANA TEIT AKIS**  
PRINCIPAL

Written and Compiled by Maria Imelda Somtragool and Ileen Palan.

First Published in 2017 by Flexible Open and Distance Education, Papua New Guinea

Printed by Flexible Open and Distance Education

**ISBN: 978-9980-89-661-2**

National Library Services of Papua New Guinea
SECRETARY’S MESSAGE

Achieving a better future by individual students and their families, communities or the nation as a whole, depends on the kind of curriculum and the way it is delivered.

This course is a part of the new Flexible, Open and Distance Education curriculum. The learning outcomes are student-centred and allows for them to be demonstrated and assessed.

It maintains the rationale, goals, aims and principles of the national curriculum and identifies the knowledge, skills, attitudes and values that students should achieve.

This is a provision by Flexible, Open and Distance Education as an alternative pathway of formal education.

The course promotes Papua New Guinea values and beliefs which are found in our Constitution, Government Policies and Reports. It is developed in line with the National Education Plan (2005 -2014) and addresses an increase in the number of school leavers affected by the lack of access into secondary and higher educational institutions.

Flexible, Open and Distance Education curriculum is guided by the Department of Education’s Mission which is fivefold:

To facilitate and promote the integral development of every individual
To develop and encourage an education system satisfies the requirements of Papua New Guinea and its people
To establish, preserve and improve standards of education throughout Papua New Guinea
To make the benefits of such education available as widely as possible to all of the people
To make the education accessible to the poor and physically, mentally and socially handicapped as well as to those who are educationally disadvantaged.

The college is enhanced to provide alternative and comparable pathways for students and adults to complete their education through a one system, many pathways and same outcomes.

It is our vision that Papua New Guineans’ harness all appropriate and affordable technologies to pursue this program.

I commend all those teachers, curriculum writers, university lecturers and many others who have contributed in developing this course.

UKE KOMBRA, PhD
Secretary for Education
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Topic</th>
<th>Lessons</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TOPIC 1: SPREADSHEET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lesson 1</td>
<td>Exploring the Excel Window</td>
<td>9</td>
</tr>
<tr>
<td>Lesson 2</td>
<td>Moving Around in the Workbook</td>
<td>21</td>
</tr>
<tr>
<td>Lesson 3</td>
<td>Setting Up Rows and Columns</td>
<td>31</td>
</tr>
<tr>
<td>Lesson 4</td>
<td>Adding and Deleting Rows and Columns</td>
<td>43</td>
</tr>
<tr>
<td>Lesson 5</td>
<td>Editing Data</td>
<td>53</td>
</tr>
<tr>
<td>Lesson 6</td>
<td>Sorting Data</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td><strong>Answers to Practical Exercises 1 – 6</strong></td>
<td>68</td>
</tr>
<tr>
<td><strong>TOPIC 2: CREATING A SAMPLE WORKSHEET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lesson 7</td>
<td>Formatting Font and Alignment</td>
<td>74</td>
</tr>
<tr>
<td>Lesson 8</td>
<td>Formatting Headers and Footers</td>
<td>85</td>
</tr>
<tr>
<td>Lesson 9</td>
<td>Formatting Cells</td>
<td>89</td>
</tr>
<tr>
<td>Lesson 10</td>
<td>Editing Cells</td>
<td>99</td>
</tr>
<tr>
<td>Lesson 11</td>
<td>Using the Page Set Up Dialogue Box</td>
<td>110</td>
</tr>
<tr>
<td>Lesson 12</td>
<td>Using the Print Dialogue Box</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td><strong>Answers to Practical Exercises 7 – 12</strong></td>
<td>120</td>
</tr>
<tr>
<td><strong>TOPIC 3: MAKING SIMPLE CALCULATIONS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lesson 13</td>
<td>Adding Numbers in Various Cells</td>
<td>126</td>
</tr>
<tr>
<td>Lesson 14</td>
<td>Subtracting Numbers in Various Cells</td>
<td>136</td>
</tr>
<tr>
<td>Lesson 15</td>
<td>Multiplying Numbers in Various Cells</td>
<td>143</td>
</tr>
<tr>
<td>Lesson 16</td>
<td>Dividing Numbers in Various Cells</td>
<td>149</td>
</tr>
<tr>
<td>Lesson 17</td>
<td>Using Auto Sum</td>
<td>154</td>
</tr>
<tr>
<td>Lesson 18</td>
<td>Copying Data or Formula</td>
<td>165</td>
</tr>
<tr>
<td></td>
<td><strong>Answers to Practical Exercises 13 – 18</strong></td>
<td>175</td>
</tr>
<tr>
<td><strong>TOPIC 4: DOING MORE WITH SPREADSHEET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lesson 19</td>
<td>Creating a Chart from a Set of Data</td>
<td>181</td>
</tr>
<tr>
<td>Lesson 20</td>
<td>Applying Different Styles of Chart</td>
<td>192</td>
</tr>
<tr>
<td>Lesson 21</td>
<td>Applying Chart Lay Outs</td>
<td>201</td>
</tr>
<tr>
<td>Lesson 22</td>
<td>Using Chart Components and Controls</td>
<td>213</td>
</tr>
<tr>
<td>Lesson 23</td>
<td>Formatting Data Series</td>
<td>223</td>
</tr>
<tr>
<td>Lesson 24</td>
<td>Formatting Data Series</td>
<td>230</td>
</tr>
<tr>
<td></td>
<td><strong>Answers to Practical Exercises 19 – 24</strong></td>
<td>236</td>
</tr>
<tr>
<td>Glossary</td>
<td></td>
<td>241</td>
</tr>
<tr>
<td>Reference</td>
<td></td>
<td>242</td>
</tr>
</tbody>
</table>

When you complete each lesson, tick the box for that lesson.
INTRODUCTION TO UNIT 3

Unit 3 is Spreadsheet 2 where you will learn about the basic concepts concerning the understanding of what is a computer. The Unit consists of the following Topics:

<table>
<thead>
<tr>
<th>Topic 1:</th>
<th>Reviewing the Spreadsheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic 2:</td>
<td>Formatting and Printing Spreadsheets</td>
</tr>
<tr>
<td>Topic 3:</td>
<td>Formula</td>
</tr>
<tr>
<td>Topic 4:</td>
<td>Graphical Representation of Data</td>
</tr>
</tbody>
</table>

By the end of this Unit you will have gained the skills and proficiency in the use of the Spreadsheet programs, able to demonstrate skills and techniques to produce Spreadsheet, to be able to design, create and evaluate appropriate Spreadsheet solutions to a range of problems and be able to use ethical practices when dealing with information and computer technology.
Below are steps to guide you in your course of study.

Step 1: Read each lesson in the Unit Book carefully. In most cases, reading through a lesson once is not enough. It helps to read something over several times until you understand it. You are not expected to memorise the information in the Unit Book. You should use it as a reference and to learn from the examples given to illustrate important points.

Step 2: After reading the summary of the lesson, start doing the Practice Exercise. You must do only one practice exercise at a time. Then mark it according to the following instruction.

Step 3: After marking your Answers, go back to the lesson and correct any mistakes you may have made. Then move on to the next lesson.

Step 4: After completing all the Practice Exercises, do Assignment 1.

Step 5: Now send the completed Assignment booklet to FODE for marking.

Follow all these steps 1 - 5 when completing all Unit Books.

Be honest with yourself when you are doing and marking your Practice Exercises as well as completing your Assignment Booklets.

This Unit has a separate assignment booklet for you to use. The information at the end of the last lesson in every Topic will let you know what to do with the assignment exercises.

Whenever you need help and advice, contact your tutor or your Provincial Coordinator for assistance. If you are in the NCD or Central Province, you are available on Mondays to Fridays. You can call in anytime between 8 a.m. and 4 p.m. You would be glad to help you.

The following icons are used in each Lesson in this Unit. Icons are the symbols used in this book to indicate the parts of your lessons. The following are the meanings of these icons.

- Lesson Introduction - All other Activities
- Lesson Objectives - Summary
- Reading Activities - Additional Information

You hope you enjoy learning this course. All the best!

Your Tutor
Information Technology Department
FODE
TOPIC 1

REVIEWING THE SPREADSHEET

<table>
<thead>
<tr>
<th>LESSON 1:</th>
<th>Exploring the Excel Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>LESSON 2:</td>
<td>Moving Around in the Workbook</td>
</tr>
<tr>
<td>LESSON 3:</td>
<td>Setting Up Rows and Columns</td>
</tr>
<tr>
<td>LESSON 4:</td>
<td>Adding and Deleting Rows and Columns</td>
</tr>
<tr>
<td>LESSON 5:</td>
<td>Editing Data</td>
</tr>
<tr>
<td>LESSON 6:</td>
<td>Sorting Data</td>
</tr>
</tbody>
</table>
TOPIC 1: REVIEWING THE SPREADSHEET

In this topic you will learn about the concepts of a Spreadsheet. The Topic is designed to be more familiarised to you about Spreadsheet. It aims for you to gain understanding of facts and concepts necessary to have a start in the study of Spreadsheet.

It also provides an overview of the Excel 2010 user interface and covers how to perform basic tasks such as creating a new workbook, moving around a worksheet, selecting cells, setting up rows and columns, adding and deleting rows and columns, entering and editing data, and sorting data.

In this topic you will study the following:

**Lesson 1** explores the Excel Window. You will learn the definition of Microsoft Excel, identify the use of Excel, locate the parts of an Excel window and determine the importance of using the Microsoft Excel.

**Lesson 2** is about moving around in the workbook. You will learn the definition of a Workbook, identify the parts of the workbook and use certain keys to move around in the workbook.

**Lesson 3** is about setting up rows and columns. You will learn the difference of rows and columns and identify the steps in setting them up.

**Lesson 4** is about adding and deleting rows and columns. You will learn the steps in adding and deleting rows and columns and the importance of adding and deleting them.

**Lesson 5** is about editing data. You will learn the definition of editing data; identify the steps in editing and changing data and their importance.

**Lesson 6** is about sorting data. You will learn the definition of sorting data, identify the steps in sorting data and determine its importance.
Lesson 1: Exploring the Excel Windows

Welcome to Lesson 1 of Unit 3. Unit 3 starts with the brief history and introduction of Spreadsheet.

In this lesson, you shall learn about the definition and uses of Microsoft Excel.

Your Aims:
- define Microsoft Excel
- identify the uses of Excel
- identify the parts of an Excel window
- determine the importance of using the Microsoft Excel

The Microsoft Excel

The Microsoft Excel is a Spreadsheet Program which is an application program commonly used for budgets, forecasting, and other finance-related tasks. In a Spreadsheet program, data and formulas to calculate those data are entered into ledger like forms (spread sheets or worksheets) for analysis, tracking, planning, or “what-if” evaluations of the impacts of real or proposed changes on an economic strategy. Spreadsheet programs use rows and columns of cells; each cell can hold text or numeric data or a formula that uses values in other cells to calculate a desired result. Grade 9 Design and Technology Spreadsheet 1 Lesson 1 had mentioned that Spreadsheet has a wide range of uses. They can be used as a simple way to store numerical data or as an analytical tool making use of complex mathematical formulas.

When personal computers first began appearing, one of the first applications was a program released in 1979 called VisiCalc. It was used as a tool for performing spreadsheet style calculations that would have been difficult to do on a calculator. The program quickly became so popular that people began buying personal computers for their businesses just so they could use VisiCalc. Since then, many other spreadsheet programs have been popular over the years, such as Quattro Pro and Lotus 123. Microsoft Excel was first released in 1985 with newer versions being released every couple of years. The most recent version is Excel 2010.
The VisiCalc.

It handles much larger sets of numerical data at much greater speeds and has a richer set of functions and general calculating and data visualization tools. For example, the computer could be told to automatically work out the summary amounts such as total, average, minimum and maximum. A spreadsheet program can also create graphs and other types of charts, based on information in your tables.

The Purposes of Spreadsheet
Spreadsheet has evolved to be very useful to man. Study the following items below as these are the different purposes of Spreadsheet.
* Spreadsheet is to hold and store data.
* Commonly used in the business and scientific fields, a Spreadsheet can be set up in a thousand ways using rows and columns.
* A Spreadsheet provides structure and organization for data and often makes calculations.
* Anything you might need to graph, since all Spreadsheet have a graphing program built into them.
* Any problem where you need to play with numbers in order to find a solution.

In some industries, Spreadsheet programs are used heavily in the financial sector where keeping track of numerical data is extremely important.

The Uses of Excel
In Grade 9 Design and Technology Spreadsheet 1 Lesson 2 had mentioned the uses of Excel in businesses and it is for:

* budget preparation - using a Spreadsheet to help you plan your budget can be useful because it helps with complex calculations and you can see at glance the incoming and outgoing. It also means that any changes to figures can be automatically updated in calculations by Spreadsheet so that it does all the hard work.
working trial balances – the trial balance is a report listing the ending debit and credit balances in all accounts at the end of reporting period.
business modelling – The primary focus is on using personal computers as platforms for asking, combining, and giving information (data, assumptions and relationships) to build exploratory models for business problems. Thereafter, using the models to drive understanding and consensus towards generating possible actions, and the selection of a final course of action and the assurance of execution success.

sales forecasting – the sales forecasting in excel is the process of making predictions of the future based on past and present data and analysis of trends. It uses the method of at least squares to find a line that best fits the points.
• investment analysis – defined as the process of evaluating an investment for profitability and risk, ultimately has the purpose of measuring how the given investment is good for a portfolio.

Omega ratio is an example of investment analysis.

• payroll – a list of employees receiving wages or salaries with the amounts due to each.

<table>
<thead>
<tr>
<th>Name of company: [Mention the name of the company for which the excel payroll is being created]</th>
<th>Excel payroll for the financial year [mention the year for which the excel payroll is being created]</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name of the employee</strong></td>
<td><strong>Designation of the employee</strong></td>
</tr>
<tr>
<td>[Employee 1]:</td>
<td>[Post of Employee 1]:</td>
</tr>
<tr>
<td>[Employee 2]:</td>
<td>[Post of Employee 2]:</td>
</tr>
<tr>
<td>[Employee 3]:</td>
<td>[Post of Employee 3]:</td>
</tr>
<tr>
<td>[Employee 4]:</td>
<td>[Post of Employee 4]:</td>
</tr>
<tr>
<td>[Employee 5]:</td>
<td>[Post of Employee 5]:</td>
</tr>
<tr>
<td>[Employee 6]:</td>
<td>[Post of Employee 6]:</td>
</tr>
<tr>
<td>[Employee 7]:</td>
<td>[Post of Employee 7]:</td>
</tr>
</tbody>
</table>

Signature of the employer [acknowledge the payroll by the employer]

Sample of payroll.

• real estate management - there are a lot of Excel users in the property management community. An outstanding Spreadsheet program, Excel frequently plugs in the gaps commonly found in accounting programs.
Sample of real estate management.

- **Taxes** - A **tax** (from the Latin *taxo*; "rate") is a financial charge or other levy imposed upon a taxpayer (an individual or legal entity) by a state or the functional equivalent of a state to fund various public expenditures.

Using Excel in calculating Tax - *Formula*
• investment proposals – Investment proposal is a document prepared by the sponsor of a new investment project, or of the management of an existing firm, for prospective investors and or lenders. It details the

1. Nature of project or business,

2. It's history (if any),

3. The growth potential,

4. Objective and the amount of finance required to realise them,

5. Promised collateral or security and

6. A plan for timely repayment of interest and principal.

Project Investment Proposal Template

<table>
<thead>
<tr>
<th>PROJECT INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project title</td>
</tr>
<tr>
<td>Date of submission</td>
</tr>
</tbody>
</table>

| Focal Areas (Select one): | Enabling technologies | Animal health inputs | Strategic infrastructure investments | Controlled and notifiable disease |

<table>
<thead>
<tr>
<th>Total amount requested</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total co-funding amount</td>
</tr>
<tr>
<td>Expected start date</td>
</tr>
<tr>
<td>Expected completion date</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CLUSTER PRINCIPAL INVESTIGATORS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title, first name, surname</td>
</tr>
<tr>
<td>Institution</td>
</tr>
<tr>
<td>Expertise or Specialisation</td>
</tr>
</tbody>
</table>

Using Excel in calculating Tax – Answer.

1. **TO CALCULATE THE PRICE WITH TAX**

<table>
<thead>
<tr>
<th>TAX</th>
<th>NET AMOUNT</th>
<th>GROSS AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>8%</td>
<td>$120.00</td>
<td>$129.60</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HOW TO CALCULATE TAXES USING MICROSOFT EXCEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN THIS EXERCISE, TAX ON AN ITEM HAS TO BE CALCULATED. WE CAN ALSO FIND THE ORIGINAL PRICE GIVEN THE TAX RATE AND THE FINAL PRICE.</td>
</tr>
<tr>
<td>1. TO CALCULATE THE PRICE WITH TAX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TAX</th>
<th>NET AMOUNT</th>
<th>GROSS AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>8%</td>
<td>$120.00</td>
<td>$129.60</td>
</tr>
</tbody>
</table>
Now, let us start to identify the parts of an Excel Window:

- **Quick Access Toolbar**
- **Minimize Button**
- **Maximize Button**
- **Close Button**
- **Ribbon**
- **Tabs**
- **Title Bar**
- **Columns**
- **Formula Bar**
- **Active Cell**
- **Name Box**
- **Rows**
- **Workbook Window**
- **Sheet Tabs**
- **Status Bar**
- **Scroll Bars**
- **Zoom Slider**
- **View Shortcuts Toolbar**
- **Workbook Window**

Spreadsheets are often used for business documents such as invoices where numbers and totals are important. A program such as Excel can automatically add up totals for a document such as the invoice shown below. A document like this could be given a customer to provide details of how much money they owe to the business.

**Example of an Invoice.**

**The Spreadsheet Contents**
The cells in a Spreadsheet can contain 3 types of information. Excel will treat cells differently depending on the cell contents.

- **Text** – Any names or labels that are required on the spreadsheet
• Number – All numerical values including dates/times, percentages and dollar values

• Formula – different mathematical operations are written in a cell to automatically calculate an Answer.

The Spreadsheet Content.

Activity 1: Define the following words:

1. Microsoft Excel

2. Spreadsheet

3. Text

4. Numbers

5. Formula
Activity 2: Label the Parts of the Excel Window.

1. ______________________________________________________________
2. ______________________________________________________________
3. ______________________________________________________________
4. ______________________________________________________________
5. ______________________________________________________________
6. ______________________________________________________________
7. ______________________________________________________________
8. ______________________________________________________________
9. ______________________________________________________________
10. ______________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 1. In this lesson you learned the definition of Microsoft Excel, identified the uses and the parts of an Excel Window and the importance of using the Spreadsheet.

NOW DO PRACTICE EXERCISE 1 ON THE NEXT PAGE.
Practice Exercise 1

A. Write at least five uses of Excel in Businesses (in any order)
1. ______________________________________________________________
2. ______________________________________________________________
3. ______________________________________________________________
4. ______________________________________________________________
5. ______________________________________________________________

B. In your own words write four importance of Microsoft Excel.
1. ______________________________________________________________
2. ______________________________________________________________
3. ______________________________________________________________
4. ______________________________________________________________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activities

Activity 1

1. Microsoft Excel is a program that is used for creating spreadsheets.

2. Spreadsheet referred to large sheets of lined paper, which were used by people in various businesses to record facts and figures in rows and columns, and then make calculations based on the information.

3. Text – any names or labels that are required on the spreadsheet.

4. Number – all numerical values including dates/times, percentages and dollar values.

5. Formula – formulas are written in a cell to automatically calculate an Answer.
Activity 2
1. title bar
2. minimize button
3. maximize button
4. rows
5. sheet tabs
6. workbook window
7. columns
8. scroll bar
9. view shortcuts toolbar
10. zoom slider
Lesson 2: Moving Around in the Workbook

Welcome to Lesson 2 of Unit 3. In Lesson 1, you learned about the definition of Excel and identified its uses and its parts and identified its importance.

In this lesson, you shall learn to identify the parts of workbook and use of certain keys to move around in the workbook.

Your Aims:

- define a workbook
- identify the parts of the workbook
- use certain keyboard keys to move in the workbook

The Excel Workbook

From your Grade 9 Design and Technology Spreadsheet 1 Lesson 5 had mentioned that a blank workbook is displayed when you open a new Excel document and is named Book 1. Technically, the workbook looks like a notebook and contains sheets, called worksheets. Worksheets contain numerical information presented in tabular row and column format with text that labels the data. They can also contain graphics and charts. A new workbook contains three worksheets and it can also be added. Each sheet has a name displayed on a sheet tab at the bottom of the workbook.
An array of cells is called a sheet or worksheet. The box formed by the intersection of a row and a column is called **cell**. Each cell is identified by its address which consists of its column letter and row number (e.g. cell A1 is the cell in the first column and first row). A group of cell is called a **range**. A range is identified by the addresses of the cells in the upper-left and lower-right corners of the selected block of cells, separated by a colon (:) e.g. A1:C10. Only one cell can be active at a time. The active cell has a thick black border around it and its address appears in the Name Box on the left end of the Formula Bar.

The default new workbook in Excel 2010 has three worksheets. You can add more worksheets or delete existing worksheets as needed. Each worksheet consists of 1,048,576 rows (numbered 1 through 1,048,576) and 16,384 columns (labelled A through XFD). That means there are well over 17 billion cells in which you can store data.

If you printed out a full spreadsheet on paper and laid it out on the ground, you would need an area the size of close to 350 football fields. That should be enough for any spreadsheet applications you might have in mind. Usually, you will use the mouse to select the cell you want to work in by clicking on the cell, once you have entered data into a particular cell.
Now, let us recall from our Lesson 1 the parts of a workbook.

**The Excel 2010 Window Elements**

- **Title Bar** – displays the name of the workbook and the program.
- **Minimize Button** – to hide the window.
- **Maximize Button** – to adjust the size of the window.
- **Close Button** – to exit Excel.
- **Quick Access Toolbar** – contains frequently used commands that are independent of the tab displayed on the Ribbon.
- **Ribbon** – contains all the commands related to managing workbooks and working with the workbook content.
- **Formula Bar** – displays the data or formula stored in the active cell. It can also be used to enter or edit a formula, a function, or data in a cell.
- **Name Box** – displays the active cell address or the name of the selected cell, range, or object.
- **Workbook Window** – displays a portion of the worksheet.
Sheet Tabs – each tab represents a different worksheet in the workbook. A workbook can have any number of sheets, and each sheet has its name displayed on its sheet tab.

Scroll Bars – used to scroll through the worksheet.

Status Bar – displays various messages as well as the status of the Num Lock, Caps Lock and Scroll Lock keys on the keyboard.

View Shortcuts Toolbar – used to display the worksheet in a variety of views, each suited to a specific purpose.

Zoom Slider – used to change the magnification of the worksheet.

Moving around the Worksheet
There are various ways to navigate a Worksheet. You can use the mouse or keyboard, you can move from cell to cell, move up or down a page at a time, or move to the first or last used cell in the worksheet. You can also navigate to a specific cell in the worksheet by entering its address in the Name Box.

A. Navigating with the Mouse
The mouse can be used to change the active cell. If the cell you want to select is not visible in the workbook window, you can use the scroll bars to scroll through the worksheet in any direction.

Note: Scrolling with the mouse does not change the location of the active cell. To change the active cell, you must click a new cell after scrolling.

The sheet in front of you will be made up of numerous cells. You can select a particular cell by clicking on it with your mouse. Each cell is referred to by its column letter and then its row number. In the example shown below, the cell in column D and row 10 is selected. Follow the steps on how to select a particular cell using the mouse.

This cell would be referred to as cell D10.
1. Click on cell C7. You will see that the column and row headings are both highlighted to let you know which cell you have selected.

2. Look at the area to the left of the Formula Bar. This area is taken up with the Name Box (surrounded by a circle in the example below). It shows the address of cell(s) that you have selected.

3. You can use the scrollbars to the right and bottom of your Spreadsheet to move around.

Note: The scrollbar will change the part of the sheet that you can see. It will not change the part of the sheet you have selected.

B. Navigating with the Keyboard
Now try these on your keyboard.

1. Press any of the arrow keys on your keyboard to move one cell in that direction.

2. Hold down the [Ctrl] key and press [Home]. This will move you to cell A1.

3. Press the down arrow ↓ 5 times and press the right arrow → 3 times. You should have cell D6 selected.

4. Press [Home]. This will move you to column A.
5. Hold down [Ctrl] and press the down arrow ↓ to move to the last non-empty cell in that direction.

6. Hold down [Ctrl] and press the right arrow → to move to the last non-empty cell in that direction. You should now be on cell D103 (if there are no more non empty cells in that direction then it will go all the way to the bottom of the sheet).

7. Press [Ctrl] [Home] again and then practice the additional shortcuts listed below.

**Useful Shortcuts Keys when moving around the Excel**
Excel offers a number of options or methods to perform a given task. One way to speed up certain tasks is to use the Short – cut keys. Short-cut keys are key combinations that allow you to quickly execute a task or function, without having to use Excel’s menus or repeat other keystrokes at length. Knowing these keys will ensure a more efficient use of the Spreadsheet. Study the following shortcut keys

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl O</td>
<td>📝</td>
<td>Open a spreadsheet.</td>
</tr>
<tr>
<td>Ctrl S</td>
<td>📝</td>
<td>Save a spreadsheet.</td>
</tr>
<tr>
<td>Ctrl N</td>
<td>📝</td>
<td>Create a new blank spreadsheet.</td>
</tr>
<tr>
<td>Ctrl X</td>
<td>✂️</td>
<td>Cut the selection to the Office Clipboard.</td>
</tr>
<tr>
<td>Ctrl C</td>
<td>📝</td>
<td>Copy the selection to the Office Clipboard.</td>
</tr>
<tr>
<td>Ctrl V</td>
<td>📝</td>
<td>Paste the selection from the Office Clipboard.</td>
</tr>
<tr>
<td>Ctrl P</td>
<td>📝</td>
<td>Print the current spreadsheet. Note that the icon will not give you any printing options. The shortcut will.</td>
</tr>
<tr>
<td>F2</td>
<td></td>
<td>Enter edit mode for a cell.</td>
</tr>
<tr>
<td>F4</td>
<td></td>
<td>Change formula references between absolute, relative and mixed references. E.g. Absolute - $A$1, Relative A1, Mixed $A$1 or A$1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Merge cells and center text. Useful for table headings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change the cell border. Click the arrow for more border options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change cell background color. Click the arrow for more colors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change cell text color. Click the arrow for more colors.</td>
</tr>
<tr>
<td>Ctrl Enter</td>
<td></td>
<td>Fill several cells with what you type.</td>
</tr>
<tr>
<td>Ctrl ;</td>
<td></td>
<td>Insert the current date.</td>
</tr>
<tr>
<td>Ctrl Shift ;</td>
<td></td>
<td>Insert the current time.</td>
</tr>
</tbody>
</table>

**Editing a cell’s contents**
Select the cell you want to edit and then click in the Excel formula bar.
Double click the cell you want to edit.
Select the cell you want to edit and press F2.

**Format Painter**

The format painter can be used to copy formatting from one part of your spreadsheet to another.

To copy formatting once – click in the cell that has the formatting you want to copy. Click the format painter icon. Drag over the cells you want to format.

To copy formatting more than once - click in the cell that has the formatting you want to copy. Double-click the format painter icon. Drag over the first cells you want to format. Drag over all the other cells you want to format. Click the format painter icon to turn it off.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Down</td>
<td>Move down one screen</td>
</tr>
<tr>
<td>Page Up</td>
<td>Move up one screen</td>
</tr>
<tr>
<td>Alt Page Down</td>
<td>Move right one screen</td>
</tr>
<tr>
<td>Alt Page Up</td>
<td>Move left one screen</td>
</tr>
</tbody>
</table>

**Activity 1:** Using the pool of words below, fill-in the blanks with the correct word or words. Write your Answers on the space provided.

<table>
<thead>
<tr>
<th>Name Box</th>
<th>Close Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ribbon</td>
<td>Workbook Window</td>
</tr>
<tr>
<td>Scroll Bars</td>
<td>View Shortcuts Toolbar</td>
</tr>
<tr>
<td>Zoom Slider</td>
<td>Title Bar</td>
</tr>
<tr>
<td>Maximize Button</td>
<td>Minimize Button</td>
</tr>
</tbody>
</table>

1. It is used to exit Excel.  
2. It displays the active cell address or the name of the selected cell, range, or object.  
3. It is used to scroll through the worksheet.  
4. It is used to change the magnification of the worksheet.  
5. It is used to hide the window.  
6. It is used to adjust the size of the window.  
7. It displays the name of the workbook and the program.
8. It contains all the commands related to managing workbooks and working with the workbook content.

9. It displays a portion of the worksheet.

10. It is used to display the worksheet in a variety of views, each suited to a specific purpose.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 2. In this lesson you learned the definition of a workbook, identified the parts of a workbook and used certain keys to move around the workbook.

NOW DO PRACTICE EXERCISE 2 ON THE NEXT PAGE.
Practice Exercise 2

A. Match the items found under column A with commands in column B.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>a. Format Painter</td>
</tr>
<tr>
<td>2.</td>
<td>b. Insert the current date</td>
</tr>
<tr>
<td>3.</td>
<td>c. Enter edit mode for a cell</td>
</tr>
<tr>
<td>4.</td>
<td>d. Open a Spreadsheet</td>
</tr>
<tr>
<td>5.</td>
<td>e. Insert the current time</td>
</tr>
<tr>
<td>6.</td>
<td>f. Move right one screen</td>
</tr>
<tr>
<td>7.</td>
<td>g. Print the current Spreadsheet</td>
</tr>
<tr>
<td>8.</td>
<td>h. Fill several cells with what you type</td>
</tr>
<tr>
<td>9.</td>
<td>i. Save a Spreadsheet</td>
</tr>
<tr>
<td>10.</td>
<td>j. Create a new blank sheet</td>
</tr>
</tbody>
</table>

B. Fill-in the correct words.

1. The default new workbook in Excel 2010 has ________ and can add more worksheets or delete existing worksheets as needed.

2. Each worksheet consists of ________.

3. Each worksheet consists of ________ (labelled A through XDF).

4. The box formed by the intersection of a row and a column is called a ________.

5. A ________ is identified by the addresses of the cells in the upper-left and lower-right corners of the selected block of cells, separated by a colon (:).

6. The active cell has a thick black border around it and its address appears in the ________ on the left end of the Formula Bar.

7. The ________ looks like a notebook and contains sheets, called worksheets.
8. Worksheets contain numerical information presented in tabular ________ and ________ format with text that labels the data. They can also contain graphics and charts.

9. The ________ can be used to copy formatting from one part of your spreadsheet to another.

10. The ________ is used to scroll through the worksheet.

Answers to Activity 1

1. Close Button
2. Name Box
3. Scroll Bars
4. Zoom Slider
5. Minimize Button
6. Maximize Button
7. Title Bar
8. Ribbon
9. Workbook Window
10. View Shortcuts Toolbar

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.
Lesson 3: Setting Up Rows and Columns

Welcome to Lesson 3 of Unit 3. In Lesson 2, you learned about the definition of a workbook, identified the parts of a workbook and manipulated certain keys in Excel.

In this lesson, you shall learn the definition of rows and columns and identify the steps in setting up rows and columns.

**Your Aims:**
- define rows and columns
- identify the menu for setting up rows and columns
- draw diagram to illustrate rows and columns

Working with Rows and Columns

You have learned in the Grade 9 Design and Technology Spreadsheet 1 Lesson 7 that **rows** are the horizontal lines of cells that run from side to side and the vertical lines of cells that runs up and down are called **columns**. Each row is numbered down the left hand side and to identify the columns. There are letters running along the top. Each cell is referenced by intersection of a row and a column so cell A1 is the cell at the intersection of column A with row 1.

Although the number of rows and columns in a worksheet is fixed, you can still insert rows and columns if you need to make room for additional data, or delete rows and columns if the data they contain is no longer needed. These operations do not change the total number of rows or columns. You can also change the width of columns or the height of rows. The cells group on the Home Tab contains commands that can be used to easily insert, delete, or format rows and columns.
Selecting Rows and Columns
You must select rows and columns in order to perform operations such as applying the same formatting to an entire row or column, changing the height of more than one or the width of more than one column at a time, and inserting or deleting rows and columns. When a row or column is selected, every cell in the row or column is highlighted, except for the active cell. Following are the steps for selecting.

1. To Select the Entire Worksheet
Follow this step on how to select a worksheet.

Click the Select All button or press Ctrl + A.

2. To Select a Single Row or Column
Follow this step on how to select a column header.

Click the row or column header.
3. **To Select Multiple Adjacent Rows and Columns**

Follow this step on how to select multiple rows and columns.

Drag across the row or column headers or click the header of the first row or column you want to select, hold down the **Shift** key, and then click the header of the last row or column you want to select.

4. **To Select Multiple Non-Adjacent Rows or Columns**

Follow this step on how to select a multiple non-adjacent rows or columns.

Hold down the **Ctrl** key, and then click the headers of the rows or columns you want to select.

**Changing Column Width**

The default worksheet columns are wide enough to display about eight characters. If your data is too long and does not fit in a cell, you can widen the column to display the entire contents of the cell. You can also make columns narrower to save
worksheet space. The default column width is 8.34 characters. You can specify a column width of 0 (zero) to 255 characters. If a column has a width of 0 (zero), then the column is hidden.

A. To Change the Width of a Column
Follow these steps on how to change the width of a column.

1. Position the mouse pointer over the right border of the column header until the pointer turns into a two-headed arrow.
2. Drag the border right to increase or left to decrease the column width.

Note: Double-clicking the right border of a column header sets the column width to the widest entry in the column.

B. To Set a Specific Column Width
Follow these steps on how to a specific column width.

1. Select the column.
2. On the Home tab, go to the Cells group.
3. Click the Format button and select Column Width or right-click the column header and select Column Width from the shortcut menu. The Column Width dialog box opens.
4. Enter a value in the **Column width** box.

5. Click the **OK** button.

**To Change Row Height**
Excel automatically adjusts row heights to accommodate the tallest font in the row. You can, however, manually increase or decrease row heights as needed. The default row height is 14.25 points. You can specify a row height of 0 (zero) to 409 points. If a row has a height of 0 (zero), then the row is hidden.

A. **To change the Height of a Row**
Follow these steps on how to change a specific column width.

1. Position the mouse pointer over the bottom border of the row header until the pointer turns into a two-headed arrow.

2. Drag the border down to increase or up to decrease the row height.
Note: Double clicking the bottom border of a row header sets the row height to the tallest entry in the row.

B. To Set a Specific Row Height
Follow these steps on how to set a specific row height.

1. Select the row.
2. On the Home tab, in the Cells group, click the Format button and select Row Height from the shortcut menu. The Row Height dialog box opens.
3. Enter a value in the **Row height** box.

4. Click the **OK** button.

**Re-size several columns at the same time**

Follow these steps on how to resize several columns at the same time.

1. Select column **B** through to column **F** by dragging across the column headings.

2. Move your mouse in between columns **B** to **F**, wait for the double arrow to appear ➜, drag the mouse to your right or according to the size you want. All of the selected columns will have the same width.

**To Re-Size Several Rows at the Same Time**

Follow these steps on how to resize several columns at the same time.

1. Select row 1 to row 6 by dragging the row headings down ward.
To re-size several rows at the same time.

2. Move your mouse in between rows 1 to 6, wait for the double arrow to appear drag the mouse down ward or according to the size you want. All of the selected rows will have the same height.

To Fit a Selection of Cells in Columns
If you have a heading in the top of the column that is very wide then you may not want the whole column to be that wide. You can choose if you want a column width to fit a selection of cells instead of the entire column. Follow the steps on how to fit a selection of cells in columns.

1. Type and enter **My Favorite Hobby** in cell A2.

![Image of a spreadsheet with text in A2]

   The text in cell A2 is too wide for the normal cell, adjust cell A2 to fit in the text.

2. On the **Home** tab, in the **Cells** group, click the **Format** button and select **Auto Fit Column Width** from the shortcut menu. The **Auto Fit Column Width** dialog box opens.

![Image of the Auto Fit Column Width menu]

   The Auto Fit Column Width.
Click the **Auto Fit Column Width**, cell **A1** will adjust according to the length of the text.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>My Favorite Hobby</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

**To Fit a Selection of Cells in Rows**
If you have a heading in the side of the row that has larger text size than the standard size, then you may change it using the Auto Fit Row Height. Follow these steps on how to fit a selection of cells in rows.

1. Try to re-size the cell **A1** from size 12 to size 18.

2. Click **Enter**.

**Activity 1:** Write the steps on how to select rows and columns.

1. To select the entire worksheet.

2. To select a single row or column.

3. To select multiple rows or columns.
4. To select multiple non adjacent rows or columns.

Thank you for completing this activity. Make sure you do the necessary corrections before moving on to the next part of this lesson.

SUMMARY

You have come to the end of Lesson 3. In this lesson, you have learned the definition of rows and columns, identified the menu for setting up rows and columns and to set up rows and columns.

NOW DO PRACTICE EXERCISE 3 ON THE NEXT PAGE.
Practice Exercise 3

A. Type the data into your new worksheet and follow the instructions.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To insert rows</td>
<td>To insert columns</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>To delete rows</td>
<td>To delete columns</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Change the column width for cells A3 and A4 from 8.38 (72 pixels) to 13.38 (112 pixels).
2. Change the column width for cells C3 and C4 from 8.38 (72 pixels) to 17.25 (143 pixels).
3. Change the row height for cells A3 and C3 from 14.25 (19 pixels) to 21.00 (28 pixels).
4. Change the row height for cells A4 and C4 from 14.25 (19 pixels) to 27.75 (37 pixels).

B. Number the correct sequences for changing the column width or row height.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.
Answers to Activity

1. Click the **Select All** button or press **Ctrl + A**.

2. Click the row or column header.

3. Drag across the row or column headers or click the header of the first row or column you want to select, hold down the **Shift** key, and then click the header of the last row or column you want to select.

4. Hold down the **Ctrl** key, and then click the headers of the rows or columns you want to select.
Lesson 4: Adding and Deleting Rows and Columns

Welcome to Lesson 4 of Unit 3. In Lesson 3, you learned about the definition of rows and columns and identified the steps in setting up rows and columns.

In this lesson, you shall learn to identify the steps in adding and deleting rows and columns and identify the importance of adding and deleting rows and columns.

Your Aims:
- identify the steps in adding and deleting rows and columns
- add and delete rows and columns
- importance of adding and deleting rows and columns

Adding Rows and Columns

You can insert rows and columns into an existing worksheet to add additional data. Rows are inserted above the selected row. Columns are selected to the left of the selected column. If you selected multiple rows or columns, Excel inserts the same number of rows or columns into the worksheet.

By adding rows and columns in your worksheet, you can insert data into your worksheets. When you need to add a particular information or data into a particular worksheet then adding rows and columns is your solution.

To add a Row

Follow the steps below in adding a row.

1. Select the row which you want to insert the new row.
2. On the Home tab, in the Cells group, click the arrow on the Insert button and select Insert Sheet Rows.

Insert Menu from Home Tab.
You can also right click the row header and select Insert from the Shortcut menu.

From the Insert shortcut menu.

After clicking the Insert shortcut menu.

1. Try to type the data into your blank worksheet.
2. Position your active cell in A4 and drag your mouse to your right until you are at D4.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>4</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>5</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
</tbody>
</table>

3. Right click the row header and select **Insert** from the shortcut menu.

4. Select shift cells down to move one step down and click OK.

5. Try it again to A6, and follow steps 2 to 4.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>4</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>5</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
</tbody>
</table>

To add a column
Follow the steps below in adding a column.

1. Select the column to the left of which you want to insert the new column.

2. On the **Home** tab, in the **Cells** group, click the arrow on the **Insert** button and select **Insert Sheet Columns**.
The following steps can also be done.

Right click the column header and select **Insert** from the shortcut menu.

1. Position your active cell to D1 and drag your mouse downward up to D7.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>2</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>3</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
</tbody>
</table>

2. Right click the row header and select Insert from the shortcut menu.

3. Select shift cells right to move one step to the right and click OK.

4. If you see this ######## appearing, it means that the data in the cell is more than eight characters. Adjust the cell to your right to show the numbers that were written under Profit, since the maximum characters for one cell is eight characters.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>2</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>3</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
</tbody>
</table>

**Deleting Rows and Columns**

You can easily delete unwanted rows and columns from the worksheet. Before deleting a row or column, you should make sure that it does not contain any data you want to keep.

The beauty of an electronic spreadsheet such as Excel is that, even when you add or delete rows or columns, the system automatically updates the formulas where appropriate to match the new state of the data. If you make changes like this that you want to keep, you must save your work once again.
To delete a Row
Follow the steps below in deleting a row. Using the same Spreadsheet:

1. Select the row that you want to delete.
2. On the Home tab, in the Cells group, click the arrow on the Delete button and select Delete Sheet Rows.

![Delete Menu.](image)

Note: You can also right-click the column header and select Delete from the shortcut menu.

To delete a Column
Follow the steps below in deleting a column.

1. Select the column that you want to delete.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-----</td>
<td>----------------</td>
<td>------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>1</td>
<td>Movie</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>4</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>5</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. On the Home tab, in the Cells group, click the arrow on the Delete button and select Delete Sheet Rows.
3. Click the **delete sheet rows** with your mouse. The cell will move upward.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
</tr>
<tr>
<td>2</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
</tbody>
</table>

After clicking the delete sheet rows.

4. Now, do the same thing with cells A3 and A5, delete the spaces in between, and follow steps 2 and 3.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Movie</td>
<td>Budget</td>
<td>World Gross</td>
<td>Profit</td>
</tr>
<tr>
<td>2</td>
<td>The Iron Man 3</td>
<td>258,000,000</td>
<td>8,875,625,874</td>
<td>8,617,625,874</td>
</tr>
<tr>
<td>3</td>
<td>Fast and the Furious 6</td>
<td>260,000,000</td>
<td>9,000,000,410</td>
<td>8,740,000,410</td>
</tr>
<tr>
<td>4</td>
<td>Spiderman 3</td>
<td>500,100,100</td>
<td>7,020,100,235</td>
<td>6,520,000,135</td>
</tr>
</tbody>
</table>

After deleting the spaces in between.

**Note:** You can also right-click the column header and select **Delete** from the shortcut menu.

---

**To delete Cells**

Follow the steps below in deleting cells.

1. Highlight the cells that need to be deleted.
2. Right click the row header and select **Delete** from the shortcut menu.

3. Select **shift cells left** to move one step to the right and click **OK**.
4. Save your work with the filename Movie.

Activity 1: Answer the following.

A. Write the steps on how to add row in the Home tab menu.
   1. ___________________________________________________________
      ___________________________________________________________
      ___________________________________________________________
   2. ___________________________________________________________
      ___________________________________________________________
   3. ___________________________________________________________
      ___________________________________________________________

B. Write the steps on how to delete column using the Shortcut menu.
   1. ___________________________________________________________
      ___________________________________________________________
   2. ___________________________________________________________
      ___________________________________________________________
   3. ___________________________________________________________
      ___________________________________________________________
   4. ___________________________________________________________
      ___________________________________________________________

Thank you for completing this activity. Make sure you do the necessary corrections before moving on to the next part of this lesson.
SUMMARY

You have come to the end of Lesson 4. In this lesson, you have learned the steps in adding and deleting rows and columns and the importance of adding and deleting rows and columns.

NOW DO PRACTICAL EXERCISE 4 ON THE NEXT PAGE
Practical Exercise  4

Type the following data into your blank worksheet and follow the instructions.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Nursing</td>
<td>3,982</td>
<td>3,999</td>
<td>4,012</td>
<td>4,350</td>
<td>3,330</td>
<td>3,502</td>
</tr>
<tr>
<td>5</td>
<td>Law</td>
<td>5,001</td>
<td>5,330</td>
<td>4,998</td>
<td>5,220</td>
<td>5,120</td>
<td>5,101</td>
</tr>
<tr>
<td>6</td>
<td>Art</td>
<td>1,060</td>
<td>1,870</td>
<td>1,509</td>
<td>1,777</td>
<td>1,670</td>
<td>1,830</td>
</tr>
<tr>
<td>7</td>
<td>Science</td>
<td>2,646</td>
<td>2,300</td>
<td>2,100</td>
<td>2,222</td>
<td>3,100</td>
<td>1,998</td>
</tr>
<tr>
<td>8</td>
<td>Music</td>
<td>480</td>
<td>390</td>
<td>389</td>
<td>410</td>
<td>376</td>
<td>296</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Total Graduates</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Add cells in between A1 and A2.
2. Delete cells A3 and A9.
3. Add cells in between Law and Art. Type the following data.
   Engineering 6,889 7,001 7,521 6,699 7,001 6,885
4. Compute for the Total and the Total Graduates. (Please refer to Grade 9 Design and Technology – Spreadsheet 1 Lesson 13) for your guide in computing the Totals.
5. Save your work with the filename Graduates.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity

A.
1. Highlight the cells that you want to add your rows.
2. Click the Insert button on the Home tab in the Cells group.
3. Select the Insert Sheet rows.

B.
1. Highlight the cells that need to be deleted.
2. Right click the mouse and choose delete.
3. Select shift cells left.
4. Click OK.
Lesson 5: Editing Data

Welcome to Lesson 5 of Unit 3. In Lesson 4, you learned about adding and deleting rows and columns and the importance of adding and deleting them.

In this lesson, you shall learn to define editing data, identify the steps in editing and changing data and identify the importance of editing data.

Your Aims:
- explain what it meant to edit data in Excel.
- list down the steps in editing data in an Excel workbook sheet.
- edit entered data in cells.
- discuss the importance of editing data.

Data in a Cell
Open a new Spreadsheet. Select or go to any cell. You can enter text, numeric data, or a formula into the cell. In this practice, you will enter some text and numbers into some cells.

Editing Data in a Cell
When you want to enter some data in a cell, you simply click on an individual cell and started typing. But you cannot edit the data in a cell using that method. If there is already something in a cell, and you try to type something else, the old contents would be entirely erased. Here are the steps in typing data in a cell.

- To directly type in values use text and numeric data.
- To enter Formulas, you can use the formula bar and/or the built-in functions.
- To format the data in a cell or a group of cells, you can use the functions under the Format menu.
- You can edit and change the data in a cell either directly in the cell or through the formula bar.
  - To edit directly in the cell, double click the cell and then edit.
  - To edit using the formula bar, first select that cell and then click the formula bar. The data in the cell will be displayed in the formula bar and you can edit the data.

Usually, you will use the mouse to select the cell you want to work in by clicking on the cell. Once you have entered data into a particular cell, you can use the commands to proceed to other related cells. You can also use the key to select the cell. You call this key pressed effect for cell selection commands.
Key Pressed Effect for Cell Selection Commands
The following are the keys used for cell selection commands.

- **Tab** moves selection to the right, to the left cell in the same row.
- **Shift-Tab** moves selection to the left, to the previous cell in the same row.
- **Arrow keys** move selection one cell in any direction.
- **Shift-Enter** moves selection up to the previous cell in the same column.
- **Enter** moves selection down to the next cell in the same column.
- **Scroll bars** scroll vertically and horizontally through the spreadsheet.
- **Accept button** (√) accepts data in a cell but does not move to another cell.
- **Cancel button** (×) cancels entry in a cell.

Try out each option now before proceeding. This will help you follow later directions.

Practice by moving around the spreadsheet after you have visited several cells, end up by clicking on cell A1 to make it the current or active cell. Be sure your spreadsheet is open.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select a block of cells</td>
<td>Drag from the first cell to the last cell in the block</td>
</tr>
<tr>
<td>To select an entire row of cells (horizontally from left to right)</td>
<td>Click on the number (the row label) on the left edge of the Spreadsheet</td>
</tr>
<tr>
<td>To select an entire column of cells (vertically, from top to bottom)</td>
<td>Click in the letter(s) of the alphabet (the column label) at the top of the column</td>
</tr>
<tr>
<td>To select several rows</td>
<td>Drag the row numbers on the left edge of the spreadsheet</td>
</tr>
<tr>
<td>To select several columns</td>
<td>Drag across the column labels at the top of the columns</td>
</tr>
</tbody>
</table>

Cell A1 is in column A and in Row 1
For example, A1 identifies the cell at the intersection of column A, row 1. Click on cell A1 now and look at the cell's coordinates in the top left corner of the spreadsheet window.

**Location of the Active (Selected) Cell after Entering Data into a Cell**

When you type the data for a cell, the data appears both in the cell you have selected and in the **Entry bar** at the top of the spreadsheet.

See how this works for yourself now.

1. Click on **Cell A1** and type the number **1234**, then look at the **Entry bar** above the spreadsheet cells.

2. The data are again in both places at once, but they are not yet **permanently** accepted into the cell.

3. The number 1234 awaits your acceptance of it into the spreadsheet. The data are displayed in the cell to give you the opportunity to:
   - check that they are correct before accepting them into the active (selected) cell;
   - make up your mind whether they should be entered into the spreadsheet at all;
   - decide which cell you would like to be the active cell next after the data have been copied to the currently active cell.
You accept the data by either:

- Moving to another cell in the spreadsheet by clicking on the Enter key or Tab key on the keyboard.
- Or by using the mouse to click on some other cell.
- Or clicking on the Accept (√) icon to the left of the Entry bar.

You may decide not to enter the data into the spreadsheet. In this case, you would click on the Cancel box (×) in the Entry bar and start over. If, on the other hand, the data are correct, you would click the Accept button (√), which also keeps the cell you are working in as the active cell.

4. Click the Accept button (√) now.

Notice that the number 1234 in cell A1 is immediately right aligned, aligned on the right edge of the cell, which is the correct justification for numbers in mathematics.

Alternatively, you may want to proceed to the cell immediately to the right of the active cell into which the number you just typed will go. Or you may want to proceed to the cell just below the active cell.

Blanking out a cell or cells in the spreadsheet
The quickest way to blank out a selected cell or cells is to hit the Del (delete key) on the keyboard.
Let us try this now.

1. Using the same spreadsheet.

2. Type Excel 2010 in cell **A1**.

3. Click on the cell holding the data **Excel2010** in cell **A1** and hit the **Del** (delete key).

Now, cell **A1** is empty. The Delete key saves you having to use the mouse and menus.

**Undo** what you just did by pressing **Ctrl-z** (to put back **Excel2010** in cell **A1**).

To delete the data in a group of cells, you would drag across the cells to select them then they will become highlighted.

Then you select **Clear** from the **Edit** menu or hit the **Del** (delete key) as before.

**Note:** You can undo the **Delete** operation (or any other Edit operation) by immediately pressing **Ctrl-z** on the keyboard.
Editing the Data in the Entry Bar
While you are typing in data in the Entry bar, you can edit them as if you are using Word.

Editing Data After They Have Been Entered Into a Cell
If you are past the cell where you have an error and want to make a correction or change, move back to the cell in question by selecting (clicking on) it. The data in that cell will be displayed in the Entry bar at the top of the spreadsheet. Click in the Entry bar (the cursor will show where you clicked on the text) and then just go ahead and make any changes you want. Replace the old entry by clicking the Accept button (√) or by selecting another cell in the spreadsheet.

Activity 1: Answer the following questions.

A. Fill in the correct Answers. Choose from the pool of words below.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Shift-Tab</th>
<th>Arrow keys</th>
<th>Shift-Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Scroll bars</td>
<td>Accept button</td>
<td>Cancel button</td>
</tr>
</tbody>
</table>

1. Moves selection one cell in any direction. _______________
2. Moves selection in one cell in any direction. _______________
3. Scroll vertically and horizontally through the spreadsheet. _______________
4. Accepts data in cell but does not move to another cell. _______________
5. Cancels entry in cell. _______________
6. Moves selection to the left, to the previous cell in the same row. _______________
7. Moves selection to the right, to the next cell in the same row. _______________
8. Moves selection up to the previous cell in the same column. _______________

B. Write TRUE if the statement is correct and write the CORRECT WORD if the statement is false.

1. You can edit and change the data in a cell either directly in the cell or through the formula bar. _______________
2. To edit using the formula bar, first select that cell and then click the formula bar. The data in the cell will be displayed in the formula bar and you can edit the data. _______________
3. To edit directly in the cell, triple click the cell and then edit. ____________

4. To edit directly in the cell, double click the cell and then edit. ____________

5. Text and numeric data can be entered by directly typing in the values. ____________

6. You can enter text, numeric data, or a formula into the cell. ____________

7. You can undo the Delete operation (or any other Edit operation) by immediately pressing Ctrl-Y on the keyboard. ____________

8. Moving to another cell in the spreadsheet by clicking on the Caps Lock key or Tab key on the keyboard. ____________

9. When you type the data for a cell, the data appear both in the cell you have selected and in the Entry bar at the top of the spreadsheet. ____________

10. While you are typing in data in the Entry bar, you can edit them as if you are using Word. ____________

Thank you for completing this activity. Make sure you do the necessary corrections before moving on to the next part of this lesson.

______________________________

SUMMARY

You have come to the end of Lesson 5. In this lesson, you have learned to edit data in Excel, edit entered data in cells and the importance of editing data.

______________________________

NOW DO PRACTICAL EXERCISE 5 ON THE NEXT PAGE
Practical Exercise  5

Type the following data in your blank worksheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>First Year - Narra Recycling Efforts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Kilograms</td>
<td>Kilograms</td>
<td>Kilograms</td>
<td>Total for the Month</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>September</td>
<td>2</td>
<td>15</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>October</td>
<td>4</td>
<td>14</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>November</td>
<td>5</td>
<td>24</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Edit September by replacing it with October in cell A5.
2. Edit October by replacing it with November in cell A6.
3. Edit November by replacing it with December in cell A7.
4. Edit Kilograms with Wt. in Kg. in columns B, C, D.
5. Edit Total for the Month by replacing it with Month's Total in column E.
6. Arrange the columns by adjusting it according from the given data to fit in the cell.
7. Finally, edit the title from First Year – Narra Recycling Efforts to Second Year – Narra Recycling Effort.
8. Compute for the Month's Total by referring to Grade 9 Design and Technology –Spreadsheet 1, Lesson 13 for adding numbers in Excel.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity

A.  
1. Arrow Keys  
2. Enter  
3. Scroll Bars  
4. Accept Button  
5. Cancel Button
6. Shift-Tab
7. Tab
8. Shift Enter

B.
1. TRUE
2. TRUE
3. False, double
4. TRUE
5. TRUE
6. TRUE
7. False, Control-z
8. False, Enter Key
9. TRUE
10. TRUE
Lesson 6: Sorting Data

Welcome to Lesson 6 of Unit 3. In Lesson 5, you learned about editing data, identified the steps in editing and changing data and the importance of editing data.

In this lesson, you shall learn to identify the steps in sorting data properly and its importance.

Your Aims:
- define sorting data
- identify the steps in sorting data
- identify the importance of sorting data

Sorting Data
Excel 2010 includes a number of features that can be used to easily sort a worksheet. Sorting Data means to arrange data in alphabetical order, to arrange data in ascending order or in descending order. By sorting, it enhances the appearance of the worksheet and makes it look professional.

Sort a List Using Toolbar Icons
Follow the steps below on how to sort a list using toolbar icons.

1. Type the following data into your blank worksheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>Quarterly</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Gasoline</td>
<td>$100</td>
<td>$85</td>
<td>$80</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Phone Bill</td>
<td>$65</td>
<td>$60</td>
<td>$63</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Entertainment</td>
<td>$50</td>
<td>$35</td>
<td>$45</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Car Insurance</td>
<td>$50</td>
<td>$50</td>
<td>$50</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Food</td>
<td>$100</td>
<td>$85</td>
<td>$90</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Rent</td>
<td>$175</td>
<td>$175</td>
<td>$175</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Cable</td>
<td>$45</td>
<td>$45</td>
<td>$45</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Internet</td>
<td>$45</td>
<td>$45</td>
<td>$45</td>
<td></td>
</tr>
</tbody>
</table>

2. Save it as Expense.

This list contains five columns. Each column contains a heading.

Excel will assume that the first row in the list contains column headings and will not move them during the sorting process.

3. In sorting the list, click on a cell inside the column you want to sort by. In this instance, you want to sort the list alphabetically.

4. Click on a cell in column A.
5. On the Excel standard toolbar, (from the upper right hand corner of your screen) there are two icons for sorting a list.

6. Click the **Sort Ascending** icon. The list will be sorted in alphabetical order on the Item.

7. The **Sort** warning will on your screen, select **Continue** with current selection, click Sort.
8. The Item (Cable) is now in A3. And the data from columns B, C, D did not change at all.

9. Now, try the other sorting by using the descending order.

Click the **Sort Descending** icon to sort the list in the other direction.

This time, try the **Expand the selection** from the **Sort Warning**.

![Sort Warning](image)

10. Click **Sort**.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>Quarterly</td>
</tr>
<tr>
<td></td>
<td>Rent</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phone Bill</td>
<td>45</td>
<td>45</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Internet</td>
<td>175</td>
<td>175</td>
<td>175</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gasoline</td>
<td>100</td>
<td>85</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Food</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Entertainment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Car Insurance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cable</td>
<td>100</td>
<td>85</td>
<td>80</td>
<td></td>
</tr>
</tbody>
</table>

As you can see, even your $ sign is rearranged when you sort in descending order. You can just apply the Copy and Paste commands and refer to the Grade 9 Design and Technology – Spreadsheet 1 Lesson 18.

**Note:** You select **Expand the selection** when you want to change the data in the row of the selected column. Otherwise, you can select the column and sort with **continue with the current selection** command.
After arranging it in descending order.

Activity 1: Answer the following.

A. Name the following for Sort Menu

1. ____________
2. ____________
3. ____________
4. ____________
5. ____________
B. Write the steps in sorting by ascending order using the command Expand the selection from the sort warning.

1. 
2. 
3. 
4. 

Thank you for completing this activity. Make sure you do the necessary corrections before moving on to the next part of this lesson.

SUMMARY

You have come to the end of Lesson 6. In this lesson, you have learned to sort data in Excel and the importance of sorting data.

NOW DO PRACTICAL EXERCISE 6 ON THE NEXT PAGE
Practical Exercise 6

Type the data into your blank worksheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Test 2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Student Names</td>
<td>Student ID</td>
<td>Exam 1</td>
<td>Exam 2</td>
<td>Exam 3</td>
<td>Exam 4</td>
<td>Total</td>
</tr>
<tr>
<td>3</td>
<td>Thomas, Steven</td>
<td>999-25-5683</td>
<td>20</td>
<td>18</td>
<td>20</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Alexander Suzette</td>
<td>999-52-6938</td>
<td>18</td>
<td>15</td>
<td>21</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Richards, Billy Joe</td>
<td>998-71-2838</td>
<td>15</td>
<td>12</td>
<td>23</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Rasmussen, Betty</td>
<td>997-74-4447</td>
<td>14</td>
<td>18</td>
<td>15</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Anjo, Benedict</td>
<td>998-72-5632</td>
<td>23</td>
<td>19</td>
<td>15</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Manly, Manny</td>
<td>999-58-5658</td>
<td>21</td>
<td>20</td>
<td>15</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

1. Sort in Ascending Order. Use the whole worksheet from columns A to F.
2. Compute for the Total.
3. Write the steps on how to sort it in Ascending Order.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity

A.
1. Sort A to Z
2. Sort Z to A
3. Custom Sort
4. Sort & Filter
5. Editing

B.
1. Open an Existing Spreadsheet
2. Click the Sort Ascending icon to sort the list in the other direction.
3. Click the Expand the selection from the Sort Warning.
4. Click Sort.
Answers to Practice Exercise in Topic 1

Practical Exercise  1

A. The uses of Microsoft Excel in businesses (any from the nine Answers)

1. budget preparation
2. working trial balances
3. business modelling
4. sales forecasting
5. investment analysis
6. payroll
7. real estate management
8. taxes
9. investment proposals

B.

1. It can be used as a simple way to store numerical data or as an analytical tool making use of complex mathematical formulas.
2. It can be used as a tool for performing spreadsheet style calculations that would have been difficult to do on a calculator.
3. It handles much larger sets of numerical data at much greater speeds and has a richer set of functions and general calculating and data visualization tools.
4. A spreadsheet program can create graphs and other types of charts, based on information in your tables.

Practical Exercise  2

A. Match column A to column B

1. d 6. e
2. g 7. b
3. j 8. h
4. a 9. c
5. I 10. F
B. Fill-in the blanks
1. three worksheets  
2. 1,048,576 rows  
3. 16,384 columns  
4. cell  
5. range  
6. Name Box  
7. Workbook  
8. row/column  
9. Format Painter  
10. Scroll bar

Practical Exercise 3

A.

B.
Practical Exercise 4

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**GRADUATES FROM UNIVERSITY**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nursing</td>
<td>3,982</td>
<td>3,999</td>
<td>4,012</td>
<td>4,350</td>
<td>3,330</td>
<td>3,502</td>
</tr>
<tr>
<td>Law</td>
<td>5,001</td>
<td>5,330</td>
<td>4,998</td>
<td>5,220</td>
<td>5,120</td>
<td>5,101</td>
</tr>
<tr>
<td>Engineering</td>
<td>6,889</td>
<td>7,001</td>
<td>7,521</td>
<td>6,699</td>
<td>7,001</td>
<td>6,885</td>
</tr>
<tr>
<td>Art</td>
<td>1,060</td>
<td>1,870</td>
<td>1,509</td>
<td>1,777</td>
<td>1,670</td>
<td>1,830</td>
</tr>
<tr>
<td>Science</td>
<td>2,646</td>
<td>2,300</td>
<td>2,100</td>
<td>2,222</td>
<td>3,100</td>
<td>1,998</td>
</tr>
<tr>
<td>Music</td>
<td>480</td>
<td>390</td>
<td>389</td>
<td>410</td>
<td>376</td>
<td>296</td>
</tr>
<tr>
<td>Total Graduates</td>
<td>22054</td>
<td>22887</td>
<td>22527</td>
<td>22677</td>
<td>22597</td>
<td>21613</td>
</tr>
</tbody>
</table>

Practice Exercise 5

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Second Year - Narra Recycling Efforts**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Second Year - Narra Recycling Efforts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Wt. in Kg.</td>
<td>Wt. in Kg.</td>
<td>Wt. in Kg.</td>
<td>Month's Total</td>
</tr>
<tr>
<td>5</td>
<td>October</td>
<td>2</td>
<td>15</td>
<td>12</td>
</tr>
<tr>
<td>6</td>
<td>November</td>
<td>4</td>
<td>14</td>
<td>10</td>
</tr>
<tr>
<td>7</td>
<td>December</td>
<td>5</td>
<td>24</td>
<td>15</td>
</tr>
</tbody>
</table>

Practice Exercise 6

1. 

2. 

3. Steps on how to sort in Ascending Order.
   a. Highlight the cells that need to be sort.
   b. Click the Edit Menu.
c. Choose Sort and Filter and click the drop down arrow.
d. Click Sort A to Z from the Sort and Filter command.
e. Choose either Expand the selection or Choose from the current selection.
f. Click Sort.

End of Topic 1.

Now Do Exercise 1 in Assignment Book 1 Then Go to Topic 2.
TOPIC 2

FORMATTING AND PRINTING SPREADSHEETS

LESSON 7: Formatting Font and Alignment
LESSON 8: Formatting Headers and Footers
LESSON 9: Formatting Cells
LESSON 10: Editing Cells
LESSON 11: Using the Page Set Up Dialogue Box
LESSON 12: Using the Print Dialogue Box
TOPIC 2: FORMATTING AND PRINTING SPREADSHEETS

In this topic, you will learn about the basic concepts of formatting and printing of Spreadsheet. The topic is designed to assist you acquire the necessary skills in formatting. Your aim is to gain basic skills that will guide you to make your Spreadsheet neater and attractive.

In this topic, you will study about the following:

Lesson 7 is all about formatting font and alignment in Spreadsheet. You will identify the steps in formatting font and alignment and its importance.

Lesson 8 focuses on headers and footers. You will identify the steps involved in formatting Headers and Footers.

Lesson 9 focuses on the steps on how to format cells.

Lesson 10 presents the steps in editing cell data entry.

Lesson 11 explains the steps in using the Page Set Up dialogue box.

Lesson 12 highlights on the process of using Print dialogue box.
Welcome to Lesson 7 of Topic 2. In lesson 6, you learned about sorting data, identified the steps in sorting data and its importance.

In this lesson, you will learn how to format font and do alignment whilst using MS Excel Spreadsheet.

**Your Aims:**
- identify the steps in formatting fonts and alignment
- determine the importance of formatting fonts and alignment

**Formatting**

Let us define formatting. **Formatting** a spreadsheet means changing the way it looks to make it neater and attractive. Spreadsheets that have not been formatted can be difficult to read. Thus, it is important to format as well as to align characters in the cell before printing. In Topic 1, you have explored the Excel Window, moved around in the Workbook, set up rows and columns, done adding and deleting of rows and columns as well as editing and sorting data into the spreadsheet. You are now going to adjust the spreadsheet.

One way of Formatting is changing the font. You will find the font group in the Home tab. There are seven commands found in the font group.

a. The font style
b. The font size
c. The grow and shrink command
d. The font color
e. The fill color command
f. The Bold, Italic and Underline command
g. The border

Seven commands in the font group.
Firstly, type a Weekend budget from cell A1 – E9 before you use the font group. The Weekend budget should contain

1. A title
2. Sub – title and
3. The list

You are going to use this Weekend budget to format it.

A. **To Change The Font Style**
To format font style in a spreadsheet, you use the font group in the Home tab of the ribbon.

2. While the cells are highlighted, click the **drop-down arrow** next to the font command on the Home tab. The drop- down menu will appear.

3. Once the drop down menu appears, move your mouse over the various fonts. A **live preview** of the font will appear in the worksheet which will allow you to see the changes occurring.
4. Looking at the live preview in the window, you may now select the font you want to use, for this example, you may select Arial black for the title. If Arial Black is your default, then click another font style.

B. To Change The Font Size
To change font size in a spreadsheet, you use the font group in the Home tab of the ribbon.


2. Click the drop-down arrow next to the font size command on the Home tab. The drop-down menu will appear.

3. Move your mouse over the various font sizes. A live preview of the font will appear in the worksheet.

4. Select the font size 16 for the title. You can also use the Grow Font and Shrink Font command to change the size. The Grow font will increase the font size and shrink font will decrease size. You may click there to increase or decrease font size instead of using the font size. While clicking from the Grow and Shrink icon, the changes can be seen in the font size.
C. To Change The Font Color

To change font color, you use the font group in the Home tab of the ribbon. The font color is the icon beside a spill bucket.

1. Select the cells A3 – E3, which is the sub – title.
2. Click the drop-down arrow next to the font color command on the Home tab. The drop-down menu will appear.
3. Move your mouse over the various font colors. A live preview of the font will appear in the worksheet.
4. Select red as your font color.

D. To Add A Fill Color

To fill color, you use the font group in the Home tab of the ribbon. The fill color is the icon with a spill bucket.

1. Select the cells A4 – E7 which is the list.
2. Click the drop-down arrow next to the fill color command on the Home tab. The drop-down menu will appear.
3. Move your mouse over the various colors. A live preview of the font will appear in the worksheet.

4. Select the color green for the cells

E. To Use the Bold, Italic, and Underline Commands
Follow the steps below on how to use the Bold, Italic and Underline commands.

2. Click the Bold (B), to make fonts bolded, click Italic (I), to make text or characters italics or Underline (U) command on the Home tab to underlined fonts.

3. In this example you are going to perform the three commands to the total. Excel will bold, italicize and underline the total.

F. To Add A Border
To add a border, you use the font group in the Home tab of the ribbon.

1. Now, Select the cells from the sub-topic to the total (A3- E9)

2. Click the drop-down arrow next to the Border command on the Home tab. The drop-down menu will appear.
3. Move your mouse over the various borders. A **live preview** of the border will appear in the worksheet.

4. Select *All Borders* from the list.

You have now completed the font group, you will notice that your table now is much neater than before.

Now, you are going to align the text in the boarded table.

**To Change Horizontal Text Alignment**

To change the alignments, you select from the alignment group in the Home tab of the ribbon.

1. Select the cells from C4 – E7.

2. Select one of the three horizontal **Alignment** commands on the Home tab.
   
   a. **Align Text Left**: aligns text to the left of the cell.
   b. **Center**: aligns text to the center of the cell.
   c. **Align Text Right**: aligns text to the right of the cell.

You are going to align your figures to the right. By selecting right align; you will notice that the figures will move to the right side of the cell.
To Change Vertical Text Alignment
Follow the steps below on how to change vertical text alignment.

1. Select the cells you want to change.
2. Select one of the three vertical Alignment commands on the Home tab.
   a. Top Align: this Aligns text to the top of the cell.
   b. Middle Align: Aligns text to the middle of the cell.
   c. Bottom Align: Aligns text to the bottom of the cell.

Orientation
The orientation is used to rotate the cells. You can rotate the selected cells to the angle that you want.

Select cells A4 – A7
1. Go to the orientation command in the alignment group from Home tab.
2. Select the drop-down arrow, a list of angles will appear.
3. Select **rotate text up** from the drop down menu. Using the orientation will make your table neater and clearer.

![Table](image-url)

You can practice the different angles and observe the changes made to the cell.

**Merge and Center**

In this part of alignment you are going to use the cell C1, Saturday Game. This is the icon used for Merge and Center.

1. Click the cell **C1**.
2. Using the mouse, select the arrow in the merge command.
3. A drop-down menu will appear.
4. Select **Merge and Center**. Notice that the cell will hide behind Weekend Game, if the characters are behind the Weekend Budget. Then select the left alignment and align it to the left.

![Merge and Center](image-url)

Your new table should look like this.
Formatting alignment is important as it bring texts or characters into line. It also allows the cells to rotate and unnecessary line to be merged.

Activity 1: Answer the following.

A. List the four (4) different kinds of fonts and alignment.

1. Fonts

2. Alignment

B. List the different steps involved in formatting font size.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving onto next part of this lesson.

Summary

You have come to the end of Lesson 7. In this lesson, you learned the importance of formatting and identified the steps involved in formatting font and alignment.
Practice Exercise 7

Follow the given instruction and format a spreadsheet.
2. In cell A3 and B3 type in Item and Cost respectively as your Sub-Title.
3. Then, type in your shopping list.
4. Go back to cell A1 and do the following:
   a. Change the font style to Monotype Corsiva.
   b. Change the font size to 18,
   c. Modify font color to green.
5. Select a portion of the items in one cell and make only that part bold. For example, if the words “Hottest pot” is in the cell, make only the word “Hottest” bold. (Select one word from the cell above).
6. Merge and center the title.
7. Align the content of all the cost to the right.

Answers to Activities
A
1. Any order of the four below is correct respectively.
   a. Font: font style, font size, font color, fill color and border
   b. Alignment: horizontal alignment, vertical alignment, orientation and merging

B Steps involved in formatting font size.
1. Using the Font size command:
   a. Select the cells that you want to modify
   b. Move mouse to the font size drop-down arrow in the font group of the Home tab
   c. Select the size that you want from the drop – down menu
Another way is to use the Grow and Shrink font command

a. Select cell
b. Click Grow command to increase font and Shrink to reduce font size
Welcome to Lesson 8. In lesson 7, you learned the steps in formatting fonts and alignment its importance.

In this lesson, you will learn to format Headers and Footers whilst using MS Excel Spreadsheet.

Your Aims:
- identify the steps in formatting Headers and Footers.
- determine the importance of formatting Headers and Footers.

Headers and Footers

Headers and footers are commonly used for inserting information such as page numbers, date, or title. Before you begin, decide if you want the information in the Header or Footer. Header means that the information will appear in every page at the top. Footer means that the information will appear at the bottom of every page.

Create Headers and Footers

Follow the steps below to create headers and footers.

1. Choose the insert tab.

   ![Insert Tab]

   Click the header and footer in the Text group. Your worksheet changes to page layout view and the design context tab appears. Note that your cursor is located in the center section of the header area.

2. From the Headers and Footers tools in the design, select the command, go to Header. Here you are going to use the Header but you can select Footer and follow the same procedures.
3. Click the right side of the Header area.

4. Click Page number in the Header and Footer Elements group. The page number will appear in the right side of the header area.

5. Click the left side of the header area.

6. Type your name. Your name will appear on the right side of the header area.

---

**Note:** When you print, your name and page number will appear at the top of every page with page number on the top right corner and your name on the top left corner. You may select other commands such as number of pages, date, time, file path or file name in the Header and Footer Element group to include into the Header area instead of name and page number.

---

**Return to Normal View**

Follow the steps below to return to the normal view:

1. Click outside of the header area.

2. Choose the view.

3. Click the normal button in the Workbook View group.

Headers and Footers are important when you want to add page numbers, titles location or author to the Workbook that you create.
Activity 1: State the main difference between the Header and the Footer commands.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving onto next part of this lesson.

Summary
You have come to the end of Lesson 8. In this lesson, you learned the steps involved in formatting headers and footers as well as the importance of using these commands.

NOW DO PRACTICE EXERCISE 8 ON THE NEXT PAGE.
Practice Exercise 8

List down the steps involved in formatting headers & footers. Begin with confidential in the right side, date in the center and pages in the left side of the footer area.

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2.

Answers to Activity 1

The main difference between Headers and Footers;

When creating Headers and Footers; Headers are located at the top of the page and footers are located at the bottom of the page in the Workbook.
Lesson 9: Formatting Cells

Welcome to Lesson 9. In lesson 8, you learned the steps in formatting Headers and Footers and its importance. In this lesson, you will learn to format cells whilst using MS Excel Spreadsheet.

Your Aims:
- identify the steps in formatting cells
- determine the importance of formatting cells

Formatting Cells

There are a lot of ways that you can format cells. Here in this lesson you are going to look at three commands in the cell group, the two commands had been discussed in Topic 1 when you want to add and delete Rows and Columns. In this lesson you are going to format the cells thus the third command in the cell group will be our focus.

Formatting cells depend on how you want our cells to look like. You will look at the steps involved in formatting the cell size, visibility, organizing sheet and protection. These are commands found in the format.

Formatting the cell size

Follow the steps below on how to format cell size.

1. Select the cell you want to modify.
2. Choose Home Tab.
3. Click the arrow next to format in the cell group, a drop-down menu will appear.
4. Click the Row Height, type in 25 in the pop up dialogue box.
5. Click OK, notice that row 1 will increase in height to 25.

Note: Remember: the cells are identified with letters for columns and numbers for the rows.
6. Repeat steps 1 -3, then select column width from the drop- down menu
7. Type in 45 in the Column width field from the dialogue box
8. Click OK. Column A is set to width 45. These actions will allow you to see all the text when you type in cell A1.
9. If you want to go back to the original width and height of the cell:
   a. Select cell that you want to change back to original.
   b. Go to Format in the cell group in the Home tab.
   c. Click the drop down arrow next to word format.
   d. Select AutoFit Row Height and AutoFit Column Width in the cell size command.
   e. Notice that the cell will return to original size.

Hide Cells
Follow the steps below to hide cells.
1. To hide cell A1, go to the cell group in the Home tab.
2. Select the drop down arrow from the Format.
3. Move mouse to the Visibility.
4. Click hide & unhide, a pop - up menu will appear.
5. Click Hide Rows to hide row.
6. Notice that the row 1 will hide.

Note: If you click Hide column in Step 5, Column A will hide. Hide cell is not deleted. The cell content and the cell are hidden. This command is important when it comes to Printing, especially when you do not want to print cell content or discuss it, you can hide the cell.

Organizing Sheet
Here you are going to organize the spreadsheet by naming the sheet, move or copy the sheet and tab color.

A. Rename the sheet
Follow the steps below to rename sheets.

1. To rename Sheet1, go to the cell group in the Home tab.

2. Select the drop down arrow from the Format.

3. Move mouse to the Organize Sheet.

4. Select Rename, Sheet 1 will be highlighted.

5. Type ‘Practice’ in place of Sheet1.
B. **Copy Sheet**

Before you move or make a copy of the spreadsheet, decide carefully the location so you know where to find your spreadsheet. In this example, you are going to make a copy of sheet1 and place it between sheet2 and sheet3.

1. To make a copy of Sheet1, go to the cell group in the **Home tab**.
2. Select the drop down arrow from the **Format**.
3. Move mouse to the **Organize Sheet**.
4. Select **Move or Copy Sheet** command.

5. A dialogue box will appear.
6. Book1 is the workbook you are in and sheet1 is the spreadsheet you are working in.
7. Select Sheet3, under **Before Sheet** command.
8. Then move mouse to 'create a copy' and click it the square.
9. Click **OK**.

10. Notice the difference below from the action taken. You have made a copy and move Sheet1 to be between Sheet2 and Sheet3. The new sheet is known as Sheet1 (2).

    ![Before and After screens](image)

C. **Worksheet Color Tab**
Tab color will color the spreadsheet Tab. Since you had renamed and make a copy of spreadsheet, you will now color the copied spreadsheet.

1. To color Sheet1, go to the cell group in the **Home tab**.
2. Select the drop down arrow from the **Format**.
3. Move mouse to the **Organize Sheet**.
4. Select **Tab Color** command. A drop down menu will appear.

    ![Menu options](image)

5. Select **Green**, to color tab. Notice that the tab will be in green color.
**Cell Protection**

Security is vital for information protection. When working with data, you also have to think about protecting the data or file from other people to see. In Microsoft Excel there is a way of protecting it. The steps are:

1. When finished typing click **MS Office** button.
2. Scroll down **Save As** and left click mouse. This generates **Save As** window.
3. Click on **Tools** on the bottom left of the **Save As** Window.
4. On the drop-down window click on **General** option.

5. A security dialogue box will appear.
6. Type in password in **Password** to open.
7. Type in **Password** to modify.
8. Click **OK**.
9. Confirm **Password** to open.
10. Confirm Password to modify.
A password is case sensitive. If the password Typed is in Upper case, then you have to type exactly that when opening the file. A password can be all letters, all numbers or a mixture of both.

Another way of Protecting Excel Workbook is to use the **Protection** command in the cell group under the format drop down menu.

Follow these steps:
1. Go to format in the cell group from **Home tab**.
2. Click the drop-down arrow beside **Format**.
3. Move mouse to the protect sheet under **Protection**.
4. A pop up dialogue box will appear.
5. Type the Password then click **OK**.
6. Another pop up dialogue box will appear to confirm password.
7. Retype password to confirm password.
8. Click **OK**.
There are many ways you can format cells depending on how you want your cells to look like. Here in this lesson, you have looked at the steps involved in formatting the cell size, visibility, organizing sheet and protection. Using these commands, you are able to hide cells that you do not want to use, rename sheet and even protect the worksheet so that others cannot have access to.

Activity 1: List the steps involved in format command to format a worksheet.

1. To increase the row height of D2 to 35

2. To Hide column E

3. To rename sheet3 as Accounts

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving onto next part of this lesson.

Summary

You have come to the end of Lesson 9. In this lesson, you learned the steps involve in formatting cells as well as the importance of using these commands.

NOW DO PRACTICE EXERCISE 9 ON THE NEXT PAGE.
Practice Exercise 9

A. Write letter of instruction next to the Commands.

A (Instruction)  B (Command)

a. Move a worksheet  Format

b. Change the name of a worksheet  Confirm Password

c. Delete a worksheet  Protect sheet

d. Select from format in the cell group  Move or Copy sheet

e. Enter password to unprotect sheet  Delete

f. Format cell  Rename

g. Retype Password  Drop down Arrow

B. Organize a new Workbook. Re-arrange the jumbled steps in their correct order.

Color each tab with different red from dark to light color

Hide the original sheet2

Make a copy of sheet2 next to itself

Open up a new Microsoft Excel

Rename sheet1 as Business

Rename sheet2 as Family

Rename sheet3 as Personal

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2.
Answers to Activity 1

A. To increase the row height of D2 to 35
   1. Bring cursor to column D, row 2
   2. Go to cell group in the Home Tab
   3. Select the drop-down arrow next to Format in the cell group
   4. Scroll to row height and click
   5. Type in 35 the dialogue box
   6. Click OK

B. To Hide column E
   a. To hide column E, take cursor to column E
   b. Go to cell group in the Home Tab
   c. Select the drop-down arrow next to Format in the cell group
   d. Scroll to hide and unhide command, a drop-down menu will appear
   e. Select hide column
   f. Column E will not appear on the Worksheet

C. To rename sheet3 as Accounts
   a. To rename sheet3, take cursor to sheet3
   b. Go to cell group in the Home Tab
   c. Select the drop-down arrow next to Format in the cell group
   d. Scroll to rename sheet and click the command
   e. Sheet3 will be highlighted by a black box
   f. Type Accounts
   g. Click anywhere outside the sheet had been renamed
Lesson 10: Editing Cells

Welcome to Lesson 10. In Lesson 9, you had done formatting using the format in the cell group.

In Lesson 10, you are going to do formatting but this time manipulating the data. You will learn to format cells using the edit group in the Home Tab whilst using MS Excel Spreadsheet.

Your Aim:
- identify the steps in editing cell data entry

Editing Cells
Excel has a lot of features that make it perfect for working with large lists and manipulating columns of data. Using Excel, you can sort lists, filter lists and subtotal lists. You can also import lists from other sources and have the information converted in to Excel rows and columns. Here you will work with the editing group in the Home Tab.

AutoSum
Auto Sum is one of the editing commands that are used to do calculations in Excel. It contains the predefined formulas or functions that perform calculations using specific values in a particular order. Let us begin with these statistical functions:

- Sum: summation adds a range of cells together
- Average: average calculates the average of a range of cells
- Count: counts the number of chosen data in a range of cells
- Max: identifies the largest number in a range of cells
- Min: identifies the smallest number in a range of cells

These Functions appear in the AutoSum command. (It is found on the Home and Formulas tabs).

To begin, you must open an existing Workbook or type in some data into the Workbook. You may use the example. Here in the example you are going to use the
Grade 10 marks of a Computer Studies class to work out the year total, class average, the high and the low scores. See table below;

<table>
<thead>
<tr>
<th>Student</th>
<th>Term 1</th>
<th>Term 2</th>
<th>Term 3</th>
<th>Term 4</th>
<th>Year Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jean Picard</td>
<td>15</td>
<td>12</td>
<td>14</td>
<td>17</td>
<td>58</td>
</tr>
<tr>
<td>John Archer</td>
<td>18</td>
<td>14</td>
<td>17</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>James Kirk</td>
<td>23</td>
<td>22</td>
<td>19</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Chris Pike</td>
<td>8</td>
<td>11</td>
<td>7</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Jeff Schule</td>
<td>19</td>
<td>19</td>
<td>18</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>Kate Jack</td>
<td>13</td>
<td>12</td>
<td>10</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Ben Cisco</td>
<td>16</td>
<td>22</td>
<td>20</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>Highest mark</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lowest Mark</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of Students</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A. **To Calculate the sum of a range of Data Using AutoSum**

Since the Sum function is used so often, this special tool has been provided to make it easy to use.

1. Click in cell F6.

2. Click the **AutoSum** icon on the Ribbon bar.

Excel will create a Sum **function** referring to the cells left. Excel will assume the cells on left are the ones to be added together. These cells will remain selected in case you would rather select a different group of cells. Otherwise the nearest group of cells will be selected.

3. Press **Enter** to confirm that the correct cells are selected and complete the function.

This formula, **=SUM(E2:E8)** is called a **function**.

You can also use the AutoSum tool by selecting the cells to be added first.
Select cells B6 to E6.

5. Click the **AutoSum** icon.  

A Sum function will be automatically created based on the cells you selected.

**B. To Calculate the Average of a Range of Data**

The AutoSum icon can also be used to create other common functions such as Average and Count.

1. Click in cell B13 from the example.
2. Click the arrow next to the **AutoSum** icon.
3. A list of common functions will be displayed.
4. Click on **Average**.

An Average function will be created in the selected cell. Notice that it is written the same as a Sum function.

5. Check that the function reads `=AVERAGE(B6:B12)`

Press [Enter] to complete the function.

6. Save the changes to the workbook and then close it.
C. To Access Other Functions in Excel

1. Select a cell range to be included in the formula, for example A3
2. On the Edit group click the drop-down part of AutoSum icon
3. Move the mouse to the more function, the last option from the list
4. The Insert Function dialogue box opens
5. There are three ways to locate a function in the Insert Function dialogue box
6. You can type a question in the Search for a function box and click GO, or
7. You can scroll through the alphabetical list of functions in the Select a Function field or

You can select a function category in the Select a category drop-down list and review the corresponding function names in the Select a Function field. Select the function you want to use and then click the OK button.

Sorting

Sorting lists is a common spreadsheet task that allows you to easily reorder your data. The most common type of sorting is alphabetical ordering, which you can do descending or ascending order.

In this example you are going to sort the previous example, Grade 10 Computer Studies Marks.

A. To Sort in Alphabetical Order

Follow the steps below on how to sort in an alphabetical order.

1. Select a cell in the column you want to sort (here you are going to choose column A6 – E12, from your previous example)
2. Click the Sort & Filter command in the editing group on the Home Tab.

4. Now, the information in the Category column is organized in alphabetical order. (From Ben to Kate)
Note: If Excel cannot determine the range of your table, you may need to select it first and then press [Tab] until a cell in the sorting column is highlighted.

B. To Sort from Smallest to Largest
Follow the steps below on how to sort from smallest to largest.

1. Select a cell in the column you want to sort (here you are going to choose column F6 – F12).
2. Click the Sort & Filter command in the editing group on the Home Tab.
3. Select Sort from Smallest to Largest, in the drop – down menu.

Filtering Cells
Filtering, or temporarily hiding, data in a spreadsheet, allows you to focus on specific spreadsheet entries. Follow the steps below to filter data.

1. Select the Sort & Filter command on the Home Tab in the Editing group. Click on the arrow beside the Sort & Filter command, a drop down menu will appear.
2. Move mouse to Filter command.
3. Select the command: Notice that drop-down arrow will appear besides each column heading. (In this example, you are going to use the Computer Studies marks.)

4. Click the drop-down arrow next to Term 1.

5. Uncheck Select All.

6. Now click 7 and 8 under Select All.

7. Then click OK command.
8. Notice that Chris’ marks and the Lowest and number of students will appear.

To Clear One Filter
Follow the steps below on how to clear one filter.

1. Select the drop down arrow next to Term 1 column.
2. Choose **Clear Filter From** Term1.
3. Clicking the command will remove all Filter.

Find and Select Data
Follow the steps below on how to find and select data.

1. Click the **Find & Select** button on the **Editing** group of the **Home Tab**.
2. Click **Find** command.

3. A dialogue box will pop up.

4. Type in name of cell you want to **Find**.

5. Click **Find All** and the command will give you reference.

By sorting and filtering information in a worksheet, you can find values quickly. You can sort and filter on one or more columns of data. With filtering, you can control not only what you want to see, but what you want to exclude. You can filter based on choices you make from a list, or you can create specific filters to focus on exactly the data that you want to see.
You can search for text and numbers when you filter by using the Search box in the filter interface.

When you filter data, entire rows are hidden if values in one or more columns don't meet the filtering criteria. You can filter on numeric or text values, or filter by color for cells that have color formatting applied to their background or text.

Activity 1: Answer the following.

A. Give the main features of the following commands in the editing group.
   1. Sorting
   2. Filtering

B. List the steps involved in Sorting out data from smallest to largest values.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving onto next part of this lesson.

Summary
You have come to the end of Lesson 10. In this lesson, you learned the steps involve in editing cells as well as the importance of using these commands.

NOW DO PRACTICE EXERCISE 10 ON THE NEXT PAGE.
Practice Exercise 10

A. Filtering cells. Re-arranged the jumbled steps to its correct order.

1. Uncheck Select All
2. Then click OK command.
3. Then click the appropriate number under Select All.
4. Select the Sort and Filter command.
5. Select the command Filter.
6. Open an existing Workbook.
7. Move mouse to the Filter command.
8. Click the drop down arrow next to the column you want to filter.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 2.

Answers to Activity 1

A.
1. **Sorting** is a spreadsheet task that allows you to easily reorder your data.
2. Filtering, or temporarily hiding, data in a spreadsheet, allows you to focus on specific spreadsheet entries.

B.
1. a) Select a cell in the column you want to sort
2. b) Click the Sort & Filter command in the editing group on the Home Tab
3. c) Select Sort from Smallest to Largest, in the drop – down menu
Lesson 11: Using the Page Setup Dialogue Box

Welcome to Lesson 11 of Topic 2. In Lesson 10, you learned the steps in editing data entry and formatted cells using edit group in the Home Tab while using Excel Spreadsheet.

In this lesson, you will learn to use the Page Setup dialogue Box.

Your Aims:
- identify the steps involved in using the page Setup dialogue box.
- determine the importance of page setup dialogue box.

Using the Page Set Up Dialogue Box

The page setup box is found in the Page Layout Tab. There are four (4) Tabs in the Page Setup box (page, margin, Header/Footer and Sheet). You are going to look at each one of them in relation to setting up the page of a Worksheet. You may find some of their commands in the Print Preview. For the purpose of this lesson, you are going to focus on the Page Setup group.

To locate the page setup dialogue box, follow the steps below.

1. Go to the Page Layout Tab.

2. Select the arrow next to the Page Setup group.
Page setup is important as it prepares the worksheet for printing.

**A. To Modify the Page**

**To Change Page Orientation**

Change the page orientation to **Portrait** to orient the page vertically or **Landscape** to orient the page horizontally. Portrait is useful for worksheets needing to fit more **rows** on one page, and Landscape is useful for worksheets needing to fit more **columns** on one page.

1. Go to the **Page Layout Tab**.
2. Select the arrow next to the page setup group.
3. In the **Page Setup Dialogue Box**, select the **Page Tab**.
4. From Orientation, you can select **Portrait** to orient the page vertically, while **Landscape** orients the page horizontally.

**To Use Scale to Fit**

Follow the steps below on how to use scale to fit.

1. Go to the **Page Layout Tab**.
2. Select the arrow next to the **Page Setup** group.
3. In the **Page Setup Dialogue Box**, select the **Page Tab**.
4. Use the percentage field to decrease the spreadsheet by a specific percentage.
5. Select **Fit to 1 Page** to have the worksheet on one page.

- Scale to fit is a useful feature that can help you format spreadsheets to fit on a page. Be careful with how small you scale the information – it can become difficult to read.

**To Change the Paper Size**

Follow the steps below on how to use scale to fit.

1. Go to the **Page Layout Tab**.
2. Select the arrow next to the **Page Setup** group.
3. In the **Page Setup Dialogue Box**, select the **Page Tab**.
4. Select a size option from the drop down arrow list.

A. To Modify Page Margin
The margins of your worksheet may need to be adjusted to make data fit more comfortably on the printed page. Follow the steps below to adjust the margins.

1. Go to the Page Layout Tab.
2. Select the arrow next to the Page Setup group.
3. In the Page Setup Dialogue Box, select the Margin Tab.
4. You can adjust the margins by typing in the size that you want.

B. To Modify the Header/ Footer
Follow the steps below on how to modify the header or footer.

1. Go to the **Page Layout Tab**.
2. Select the arrow next to the **Page Setup** group.
3. In the **Page Setup Dialogue Box**, select **Header/Footer Tab**.
4. Select either **Header or Footer** drop - down arrow and select or type in your option.

D. To Modify Sheet
Modifying the sheet can be done in many ways to ensure the proper presentation of the Excel Sheet.

To Define a Print Area
Follow the steps below on how to define a print area.

1. Go to the **Page Layout Tab**.
2. Select the arrow next to the **Page Setup** group.
3. In the **Page Setup Dialogue Box**, select **Sheet** Tab.
4. Left – click and drag your mouse to select the cells you wish to print.
5. Now, only the selected area will be printed. You can confirm this by viewing the spreadsheet in the Print Preview.

Selecting the cells will appear in the print area.
6. To return to the default setting, which is the entire worksheet, click the Print Area command and select Clear Print Area.

**To use Print Titles Command**
Imagine how difficult it would be to read a worksheet if the column and row headings only appeared on the first page. The **Print Titles** command allows you to select specific rows and columns to appear on each page. Follow the steps below on how to use the Print Titles command.

1. Click the **Page Layout** tab.

2. Select the **Print Titles** command.

3. The **Page Setup** dialog box appears. Click the icon at the end of the **Rows to repeat at top** field.

4. Your mouse becomes the small **selection arrow**. Click on the rows you want to appear on each printed page. The **Rows to repeat at top** dialog box will record your selection.

5. Click the icon at the end of the **Rows to repeat at top** field.

6. Repeat for **Columns to repeat at left**, if necessary.

7. Click **OK**. You can go to **Print Preview** to see how each page will look when printed.
Activity 1: List the needed steps below.

1. Change the page orientation from Portrait to Landscape.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving onto next part of this lesson.

Summary
You have come to the end of Lesson 11. In this lesson, you learned the steps involved in Page Setup Dialogue Box as well as the importance of using these commands.

NOW DO PRACTICE EXERCISE 11 ON THE NEXT PAGE.
Practice Exercise  11

Using the example from the Computer Studies Students marks, identify the steps you are going to apply Print Titles command to make row 1 and column A appear on every page.

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2.

Answers to Activity 1

1. To change the page orientation to Landscape.
   a. Go to the Page Layout Tab
   b. Select the arrow next to the page setup group
   c. In the Page Setup Dialogue Box, select the Page Tab
   d. From orientation select Landscape
   e. The page will orient horizontally.
Lesson 12: Using the Print Dialogue Box

Welcome to Lesson 12 of Topic 2. In Lesson 11 you have learned to use the Page Setup dialogue Box. You are now going to study the Print Dialogue box so that you can use it to print the Workbook.

Your Aims:
- identify the steps in using the print dialogue box
- determine the importance of print dialogue box

Using the Print Dialogue Box

If you have multiple worksheets in your workbook, you will need to decide if you want to print the whole workbook or specific worksheets. Follow these steps:

1. Go to File, left click the mouse.

2. Select Print → Print. The Print Dialogue box will appear.

3. Select the printer if you want to use a printer other than the default setting.

4. Click Properties to change any necessary setting.

5. Choose whether you want to print specific pages, all the worksheet, a selected area, the active sheet or the entire workbook.

6. Select the number of copies you would like to print.

7. Click OK
Activity 1: List the steps on how to go to the print dialogue box.

__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving onto next part of this lesson.

Summary

You have come to the end of Lesson 12. In this lesson, you learned the steps involved in using the Print Dialogue box as well as the importance of using these commands.

NOW DO PRACTICE EXERCISE 12 ON THE NEXT PAGE.
Practice Exercise 12

Print a Workbook. Re-arrange the jumbled steps below into their correct order.

Select printer that is connected to your computer.
Select print in the pop-up menu.
Select All, number of copies one.
Pick up your print out of Grade 10 marks.
Open the Workbook containing the Grade 10 Computer Studies student’s marks.
Left Click, move mouse to the Print.
Go to File.
Click OK command.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 2.

Answers to Activity 1
1. Go to File, left click the mouse.
2. Select Print → Print.
3. The Print Dialogue box will appear.
Answers to Practice Exercises

Practical Exercise 7
Follow the given instruction and format a spreadsheet.

1. Open a Workbook, and type ―Shopping List‖ in cell A1.

2. In cell A3 and B3, type in Item and Cost respectively as your Sub-Title;

3. Type in your shopping list.

4. Go back to cell A1 and do the following

5. Change the font style to Monotype Corsiva

6. Change the font size to 18 and

7. Modify font color to green

8. Select a portion of the items in one cell and make only that part bold. For example, if the words ―Hottest pot‖ is in the cell, make only the word ―Hottest‖ bold. (Select one word from the cell above)

9. Merge and center the title

10. Align the content of all the cost to the right.
Practice Exercise 8

List down the steps involved in formatting footers. Begin with confidential in the right side, date in the center and pages in the left side of the footer area.

1. Choose the insert tab.

2. Click the header and footer in the Text group. Your worksheet changes to page layout view and the design context tab appears. Note that your cursor is located in the center section of the header area.

3. From the Headers and Footers tools in the design, select the command go to Footer.

4. Click the down arrow, and move to option four (4) on the list.
Practice Exercise 9

A. **Matching** – match the following instruction to Commands. Write the letter of command next to the instruction.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Move a worksheet.</td>
<td>Format</td>
</tr>
<tr>
<td>b. Change the name of a worksheet.</td>
<td>Confirm Password</td>
</tr>
<tr>
<td>c. Delete a worksheet.</td>
<td>Protect sheet</td>
</tr>
<tr>
<td>d. Select from format in the cell group</td>
<td>Move or Copy sheet</td>
</tr>
<tr>
<td>e. Enter password to unprotect sheet</td>
<td>Delete</td>
</tr>
<tr>
<td>f. Format cell</td>
<td>Rename</td>
</tr>
<tr>
<td>g. Retype password</td>
<td>Drop down Arrow</td>
</tr>
</tbody>
</table>

B. **Organize a new Workbook**

1. Open up a new Microsoft Excel
2. Rename sheet1 as Business
3. Rename sheet2 as Family
4. Rename sheet3 as Personal
5. Color each tab with different red from dark to light color
6. Make a copy of sheet2 next to itself
7. Hide the original sheet2

Practice Exercise 10

A. **Filtering Cells**

1. Open an existing Workbook.
2. Select the **Sort and Filter** command.
3. Move mouse to the **Filter** command.
4. Select the command **Filter**.
5. Click the drop down arrow next to the column you want to filter.
6. Uncheck Select All
7. Then click the appropriated number under Select All.
8. Then click OK command.

**Practice Exercise 11**
Using the example from the Computer Studies Students marks identify the steps you are going to Print Titles command to make row 1 and column A appear on every page.

1. Click the Page Layout tab.
2. Select the Print Titles command.
3. The Page Setup dialog box appears.
4. Click on the rows you want to appear on each printed page. The Rows to repeat at top dialog box $1:$1.
5. Repeat for Columns to repeat at left, $A$B
6. Click OK. You can go to Print Preview to see how each page will look when printed.

**Practice Exercise 12**
A. Print a Workbook

1. Open the Workbook containing the Grade 10 Computer Studies students' marks.
2. Go to File.
3. Left Click, move mouse to the Print.
4. Select print in the pop-up menu.
5. Select printer that is connected to your computer.
6. Select All, number of copies one.
7. Click OK command.
8. Pick up your print out of Grade 10 marks.

End of Topic 2.

Now Do Exercise 2 in Assignment Book 1 Then Go to Topic 3.
TOPIC 3

SPREADSHEET 2

LESSON 13: Adding Numbers in Various Cells
LESSON 14: Subtracting Numbers in Various Cells
LESSON 15: Multiplying Numbers in Various Cells
LESSON 16: Dividing Two Numbers
LESSON 17: Using Auto Sum
LESSON 18: Copying Data or Formula
TOPIC 3: FORMULA

In this topic you will learn about the concepts of using formula in Excel. Excel can be used to calculate and analyze numerical information. However, you will need to know how to write formulas to maximize Excel's capabilities. A formula is an equation that performs a calculation using values in the worksheet.

Formulas are powerful tools in spreadsheets which can save you hours of work. Functions are routines that are built into the Excel spreadsheet, in other words, there is not much you need to do to set them up and make the work. Formulas, on the other hand, are defined by the user to know what you are doing and set everything up yourself. Formulas will often include the built-in functions as part of the formula. Both functions and formulas accomplish the same task. They tell Excel to do some kind of more or less complex calculation for you. In this topic it will show how to create formulas using mathematical operators such as the addition, subtraction, multiplication, and division signs.

In this topic, you will study about the following:

Lesson 13 discusses on adding numbers in various cells. You will enumerate the steps in adding numbers in various cells and to perform addition of numbers in various cells.

Lesson 14 focuses on subtracting numbers in various cells. You will enumerate the steps in subtracting numbers in various cells and to perform subtraction of numbers in various cells.

Lesson 15 elaborates on multiplying numbers in various cells. You will enumerate the steps in multiplying numbers in various cells and to perform multiplication of numbers in various cells.

Lesson 16 explains on dividing two numbers. You will enumerate the steps in dividing numbers in various cells and to perform division of numbers in various cells.

Lesson 17 expounds on the uses of Auto Sum. You will discuss the steps in using the Auto Sum, to use Auto sum and to enumerate the importance of using the Auto Sum.

Lesson 18 emphasizes on copying data or formula. You will enumerate the steps in copying data or formula, to make copying of data or formula from various cells and enumerate the importance of copying data or formula in an Excel sheet.

By the end of Topic 3, you should be able to compute and use various formulas for the given data in Spreadsheet.
Lesson 13: Adding Numbers in Various Cells

Welcome to Lesson 13 of Unit 3. In Lesson 12, you learned to use the Print Dialogue Box and to print a worksheet box.

In this lesson, you will be able to enumerate the process of adding numbers in various cells and to calculate numbers using the sum in various cells.

Your Aims:
- identify the steps in adding numbers in various cells
- add numbers in various cells

Calculations in Excel

Although calculations are one of the main uses for spreadsheets, Excel can do most of the hard work for you by using a formula. When you enter a formula into a cell in a spreadsheet, Excel will calculate the Answer and display the Answer in that cell. Please refer to our Grade 9 workbook Design and Technology-Computing, Spreadsheet1 in Lesson 8, page 72 for Creating Simple Formulas. It was briefly discussed in Lesson 8 of this unit as well. You defined formula as an equation that performs a calculation. Like calculator, Excel can execute formulas that add, subtract, multiply and divide. One of the most useful features of Excel is its ability to calculate using the cell address to represent the value in a cell. This is called cell reference.

SUM is one of many Excel built-in functions. It Adds Up or Totals the series of additions to produce the required result. You will look at other built-in functions in a moment.

There are a few rules to remember when creating a spreadsheet formula.

1. A formula always begin with an equal sign (=). It is not enough to type 1+1 in Excel because what will appear in the cell is —1+1”. You must begin the equation with an equal sign, or =1+1. This holds true for any formula, simple or complicated, that adds, subtracts, multiplies or divides.

As soon as you begin a cell with a (=) Excel will know that you are creating a formula.

2. A formula will follow the order of operations Parenthesis, Exponential, Multiplication, Division, Addition and Subtraction (PEMDAS). Generally if there is more than one part to a formula, the calculations will work from left to right but any part of the formula in brackets will be calculated first. Indices or exponential will be left. Multiplication and division will be next. Addition and subtraction will be calculated last.

P Parenthesis ( )
E Exponential or Indices ^
M Multiplication *
D Division /
A mnemonic that can help you remember this is Please Excuse My Dear Aunt Sally (P.E.M.D.A.S).

3. A formula can refer to other cells in the spreadsheet using cell references.

4. If any part of the formula is referring to text, the text must be enclosed in quotation marks “ ”.

5. The cells referred to in a formula cannot include the cell the Answer will be in. This will cause a circular reference error.

Now let us try to type the following data into our Spreadsheet.

For example, at the end of a semester, you will want to calculate a total point value for each student. To do this, you can program the spreadsheet to carry out a formula on the values in the cells that contain the students’ scores (Column I in our spreadsheet).

You can have the spreadsheet add up the numbers in a set of cells. Or you can have the spreadsheet tell you the average score in a range of cells, and so on. You can also have the system copy a formula into other cells.

Let us try a few things along these lines now.

Creating a formula
Let us enter a formula and see what it does.

1. Select cell I12, click Function formula fx in the Ribbon.
2. Choose SUM for addition.
3. Click OK.
4. After clicking **OK**, the Function Arguments will appear and show us the cell references that need to be added. Since D12 to H12 are the cell references that you need to add, then just click **OK**.

The colon (:) indicates the range of cells, in this case from D12 to H12.

`=SUM(D12:H12)`, no spaces in between the characters.
After clicking OK from the Function Arguments.

The "=" symbol at the beginning is a clue to the system that what follows is a function or formula. So remember this:

All Spreadsheet functions or formulas begin with the equal (=) sign.

Or

There are still other ways to type the formula.

1. From the formula bar you can type the formula manually as long as you know cells that you are adding with. Position your active cell to your Total which is the I12.

2. Type the formula to the formula bar \(=(D12+E12+F12+G12+H12)\) or \(=D12+E12+F12+G12+H12\), you can remove the parenthesis since you only have single equation to make.

3. Then click the Accept button (✓) or the Enter key.
Note: Click the Accept button (✓) when you are sure all is you’ll (or press one of the arrow keys, Enter key. Tab key which accept data into the spreadsheet).

Or

1. You can type the numbers or the data you typed in your formula.
   
   \(=12+14+28+98+3\) or you can use the parenthesis by \((12+14+28+98+3)\)

2. Click the Accept button (✓) or the Enter key.

   The disadvantage of typing the data or numbers as your formula is you cannot change the given data. Once you type it as your formula then you cannot change it, or else if you change the data, the Total will still be the same. Try to change...
the data in cell reference D12 from 12 to 20 and observe that the Total will not change.

Therefore, using the cell references in creating your formula is the correct way to add the data correctly. It changes for the Total when you change or edit the data in the cell reference. Now, let us proceed to I13 to get the Total for the next student, Excel provides a neat tool to duplicate the contents of cells into a set of adjacent cells. Assume you will have just ten students in the class. You are going to duplicate the formula that is in cell I12 into the other nine cells below it. As before, Excel will automatically adjust the cell addresses so that they are appropriate (relative) to each student's record. Select cell I12, if it is not already selected.

**Relative References**

The system is copying the formula in cell I12 to cell I13 in relation to ("relative to") cell I12. In other words, just as the formula in I12 sums the values stored in cells D12 through H12, so the formula copied to cell I13 will sum the values relative to cells D13 through H13.

**Filling down (copying the formula into the rest of the TOTAL column)**

1. Use the mouse pointer to grab hold of the small black Fill handle in the lower right corner of cell I12.

   Notice that the mouse cursor changes from 🍃 to +.

The small square at the bottom right of the active cell is the Fill Handle, which is used to copy the contents of a cell into a range of adjacent cells. For instance, if you want to have series of numbers from 1 – 10. Here in this example, you want to have the Total from L12 to L121. Here are the steps:
Drag the small black Fill handle down to highlight all the cells from cell I12 to cell I21. Notice that the set of cells from I12 through I21 are now selected as a block on the screen.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Grade Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Class: Grade 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Semester 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Year: 2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>TEST1</td>
<td>TEST2</td>
<td>TEST3</td>
<td>TEST4</td>
<td>TEST5</td>
<td>TOTAL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Max</td>
<td>20</td>
<td>20</td>
<td>30</td>
<td>100</td>
<td>20</td>
<td>190</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>LAST NAME</td>
<td>FIRST NAME</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Urchick</td>
<td>Pamela</td>
<td>12</td>
<td>14</td>
<td>28</td>
<td>98</td>
<td>3</td>
<td>155</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Gasick</td>
<td>Barbara</td>
<td>10</td>
<td>15</td>
<td>23</td>
<td>65</td>
<td>16</td>
<td>129</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Gogo</td>
<td>Marilyn</td>
<td>13</td>
<td>18</td>
<td>25</td>
<td>74</td>
<td>17</td>
<td>147</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Mitnick</td>
<td>Teresa</td>
<td>16</td>
<td>15</td>
<td>20</td>
<td>32</td>
<td>15</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Bond</td>
<td>Patrick</td>
<td>14</td>
<td>13</td>
<td>20</td>
<td>78</td>
<td>18</td>
<td>143</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Dane</td>
<td>Stephanie</td>
<td>18</td>
<td>19</td>
<td>19</td>
<td>65</td>
<td>19</td>
<td>140</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Bond</td>
<td>Andrew</td>
<td>15</td>
<td>16</td>
<td>21</td>
<td>85</td>
<td>16</td>
<td>153</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Fraher</td>
<td>Brigid</td>
<td>18</td>
<td>17</td>
<td>26</td>
<td>98</td>
<td>20</td>
<td>179</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Brown</td>
<td>Lyn</td>
<td>20</td>
<td>15</td>
<td>19</td>
<td>73</td>
<td>15</td>
<td>142</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Polochar</td>
<td>Charlene</td>
<td>16</td>
<td>20</td>
<td>20</td>
<td>91</td>
<td>13</td>
<td>169</td>
<td></td>
</tr>
</tbody>
</table>

You can also do the formula to get for the Total one at a time for practice but do not do it more often. One of the advantages of using Excel is not a consuming time software program wherein you can use some shortcuts to lessen your burdens in creating formula.

Save your work with the filename Grade Report.

Activity:

Answer the following.

A. Write down three possible addition formulas for the given data to get the Total.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Monday</td>
<td>Tuesday</td>
<td>Wednesday</td>
<td>Thursday</td>
<td>Friday</td>
<td>Saturday</td>
<td>Sunday</td>
<td>Total</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>15</td>
<td>23</td>
<td>56</td>
<td>54</td>
<td>31</td>
<td>22</td>
<td></td>
<td>54</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. _______________________________

b. _______________________________

c. _______________________________

d. Total _________________________
B. Write down the formula using \( fx \) to compute for the Total in Area 1, Area 2 and Area 3.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Items</td>
<td>Area 1</td>
<td>Area 2</td>
<td>Area 3</td>
</tr>
<tr>
<td>4</td>
<td>M</td>
<td>56</td>
<td>88</td>
<td>86</td>
</tr>
<tr>
<td>5</td>
<td>N</td>
<td>25</td>
<td>75</td>
<td>56</td>
</tr>
<tr>
<td>6</td>
<td>O</td>
<td>69</td>
<td>80</td>
<td>32</td>
</tr>
<tr>
<td>7</td>
<td>TOTAL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. Formula: 

Total for Area 1 ________________________________

b. Formula:

Total for Area 2 ________________________________

c. Formula:

Total for Area 3 ________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Summary**

You have come to the end of Lesson 13. In this lesson, you learned to identify the steps in adding numbers and to add numbers in various cells.

---

NOW DO PRACTICAL EXERCISE 13 ON THE NEXT PAGE.
Practical Exercise 13

A. Write the steps on how to use the function formula \( fx \) in creating formula.

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

B. Compute for the Total using the function formula \( fx \).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Class</td>
<td>Grade 9</td>
<td>Grade 10</td>
<td>Grade 11</td>
<td>Grade 12</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>P</td>
<td>50</td>
<td>54</td>
<td>55</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>N</td>
<td>45</td>
<td>50</td>
<td>51</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>G</td>
<td>49</td>
<td>49</td>
<td>55</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>TOTAL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity

A. Write down three possible formulas for the given data to get the Total. (In any order)

a. \( =\text{SUM}(A3:G3) \)

b. \( =(A3+B3+C3+D3+E3+F3+G3) \)

c. \( =(15+23+56+54+31+22+54) \)

d. Total is 255
B. Write the formula using $\text{fx}$ to compute for the Total in Area 1, Area 2 and Area 3.

a. Formula: $=\text{SUM(B4:B6)}$
   Total for Area 1 150

b. Formula: $=\text{SUM(C4:C6)}$
   Total for Area 2 243

c. Formula: $=\text{SUM(D4:D6)}$
   Total for Area 3 174
Lesson 14: Subtracting Numbers in Various Cells

Welcome to Lesson 14 of Unit 3. In Lesson 13, you learned the steps in summing numbers.

In this lesson, you will be able to enumerate the process of subtracting numbers in various cells and to calculate numbers using the subtraction in various cells.

Your Aims:
- identify the steps in subtracting numbers in various cells
- subtract numbers in various cells

Subtracting numbers in Various Cells

Formulas are the heart of Excel. With huge list of built-in formula and functions, Excel stands out from other datasheet handling applications. Please refer to your Grade 9 Lesson 14. Formulas are used for calculating and analysing data based on values in designated cells. It supports trigonometric, statistical and other functions. You can also create a new rule, or constraint to apply over your datasheet. This post covers writing formulas and applying conditional formatting on a basic level.

You learned from Lesson 13 the steps in summing numbers and that the symbol for your addition is a plus (+). You can find it on top of number keys on your keyboard by pressing the Shift key and at the same time the equal sign (=).

As you already learned the addition you will also follow the same approach for subtractions.

Note: Remember to always put your cursor in the cell where you want to put your Answer.

As what you learned from addition which is the Sum you will use a different method which is the subtraction to get the difference between two numbers.

IMSUB is also one of many Excel built-in functions. It subtracts the series of subtractions to produce the required result. You will look at other built-in functions in a moment. You will also follow the addition rules for subtraction.

Remember, a formula must always begin with an equal sign (=).

1. Before creating a formula, make sure that you are in your right cell reference.
2. Type the given data into your blank worksheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Items</td>
<td>Real Prices</td>
<td>Discount</td>
<td>Discounted Prices</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>40&quot; Samsung Flat Screen TV</td>
<td>3500</td>
<td>220</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Double Door Freezer</td>
<td>2200</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>DVD Player</td>
<td>350</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5.1 Channel 220 Watts Amplifier</td>
<td>185</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Sony Laptop</td>
<td>2900</td>
<td>185</td>
<td></td>
</tr>
</tbody>
</table>

3. Compute for the Discounted Prices by subtracting columns B to columns C.

4. As what you had for addition, you can also apply to subtraction.

You can try it manually and using the cell references involved.

5. Type \( (B3 - C3) \) to cell reference D3 to get the Discounted Prices.

Or

1. Use the function formula \( fx \). Click \( fx \) from Insert Function and choose **IMSUB** to subtract columns B and columns C. Or, if you cannot find it in your Insert function, type **IMSUB**.

The Insert Function is found by selecting \( fx \).

2. If the function you want to use is in a selection menu, then just highlight it and click **OK**.
And this will be shown on to your screen.

3. Type the first cell reference to subtract in Inumber1, B3.

4. Type the second cell reference to subtract with B3 in Inumber2, C3.

5. Click OK if you are sure for your cell references.

6. Use the Fill Handle to drag and drop to complete the Answers for Discounted Prices.

The Answer you saw from the Function Arguments and the Answer that shown to D3 are the same.

6. Use the Fill Handle to drag and drop to complete the Answers for Discounted Prices.
After using the drag and drop for Fill Handle.

7. Save your work with the filename ITEMS.
   Or, using ALL instead of most recently used.

---

**Activities:**

**Answer the following.**

1. Write the steps on how to use the fx or formula function (IMSUB) to subtract: 43 which is in cell reference A2 and 23 which is in cell reference B2. Write your Answer to cell reference C3.

---

2. Write the steps on how to get the difference from the given data below. Use this (−) symbol to calculate for your Answer.

   Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.
Summary
You have come to the end of Lesson 14. In this lesson, you learned to identify the steps in subtracting numbers and to subtract numbers in various cells.

NOW DO PRACTICAL EXERCISE 14 ON THE NEXT PAGE.
Practical Exercise 14

1. Type this in your Excel Spreadsheet and compute for the Answers using the formula function \( fx \).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee’s Name</td>
<td>Monthly Salary (K)</td>
<td>Tax -20%</td>
<td>Net Salary Per Month</td>
</tr>
<tr>
<td>Bonbon, Micahel</td>
<td>2200</td>
<td>440</td>
<td></td>
</tr>
<tr>
<td>Calway, Jonathan</td>
<td>1800</td>
<td>360</td>
<td></td>
</tr>
<tr>
<td>Demore, Debbie</td>
<td>3500</td>
<td>700</td>
<td></td>
</tr>
<tr>
<td>Manechan, Beth</td>
<td>4000</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>Yannee, Eddie</td>
<td>2100</td>
<td>420</td>
<td></td>
</tr>
</tbody>
</table>

2. In order to get the Net Pay Salary Per Year first, you must add all the deductions (tax, medicare, social security and housing) and deduct it from the Annual Salary. Compute for the following:
   1) Get the Net Pay
   2) Add all the deduction

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names</td>
<td>Annual Salary ($)</td>
<td>Deductions (%)</td>
<td>Medicare (2%)</td>
<td>Social Security (2%)</td>
<td>Housing (3%)</td>
<td>TOTAL Deductions</td>
<td>Net Pay Salary Per Year</td>
</tr>
<tr>
<td>Dela Cost, Marilyn</td>
<td>48000</td>
<td>2400</td>
<td>960</td>
<td>960</td>
<td>1440</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emmanuel, Emmie</td>
<td>52000</td>
<td>2600</td>
<td>1040</td>
<td>1040</td>
<td>1560</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go, George</td>
<td>63000</td>
<td>3150</td>
<td>1260</td>
<td>1260</td>
<td>1890</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hanana, Bryan</td>
<td>48000</td>
<td>2400</td>
<td>960</td>
<td>960</td>
<td>1440</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jacob, Jacobie</td>
<td>75000</td>
<td>3750</td>
<td>1500</td>
<td>1500</td>
<td>2250</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity

1. Steps using the formula functions to subtract two numbers:
   a. Click the \( fx \) function from the formula bar.
   b. Choose and click IMSUB from the Insert Function.
   c. Click OK.
d. Type the cell references that need to be subtracted from the Function Arguments.
   
   Inumber1 A2
   Inumber2 B2

e. Click OK.

2. Steps on how to calculate the difference using the minus ( - ) symbol.

a. Position your active cell to B3 to write your Answer.

b. Place and click your mouse to the Formula Bar.

c. Type =B1-B2.

d. Press Enter key to get the Answer.
Lesson 15: Multiplying Numbers in Various Cells

Welcome to Lesson 15 of Unit 3. In Lesson 14, you learned the steps in subtracting numbers.

In this lesson you, will be able to enumerate the process of multiplying numbers in various cells and to calculate numbers using the multiplication in various cells

Your Aims:
- identify the steps in multiplying numbers in various cells
- multiply numbers in various cells

Multiplying in Various Cells

The symbol for our multiplication is an asterisk (*). You can find it on top of THE number keys on your keyboard. Press the Shift key and at the same time the number 8 key to get the asterisk or press the asterisk key of your keyboard. Please refer to your Grade 9 Topic 3, Lesson 15.

As you already learned the addition and the subtraction, you will also follow the same approach for multiplication.

Creating multiplication formulas is very similar to addition and subtraction formulas. To multiply two formula cells, the formula, B2 and B3, you would need to insert a multiplication operator which is the asterisk symbol (*) between them, =B2*B3.

Please review your Grade 9 Design and Technology – Computing, Spreadsheet 1 on Topic 3, Lesson 15, and use simple formula for multiplication. In this lesson, you will use the formula function fx to get the product of two numbers.

The same steps and applications for addition and subtraction can be applied for multiplication. But, instead of using Sum and IMSUB, you will use Product from the Insert Function of formula.
To compute for the Product.

Try re-do this practice exercise on page 144 by changing the percentage deductions.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Information Technology Department Payroll</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TOTAL Deductions</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Per Year</td>
</tr>
<tr>
<td>3 Names</td>
<td>Annual Salary ($)</td>
<td>Deductions:</td>
<td>Social Security (%)</td>
<td>(3%) Housing (%) (2%)</td>
<td>Deductions</td>
<td>Net Pay Salary ($)</td>
<td>G TOTAL</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Tax (%)</td>
<td>Medicare</td>
<td></td>
<td></td>
<td></td>
<td>Per Year</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Deductions</td>
</tr>
<tr>
<td>6 Dela Cost, Marilyn</td>
<td>48000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Tax (7%)</td>
</tr>
<tr>
<td>7 Emmanuel, Emmanuel</td>
<td>52000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Medicare (3%)</td>
</tr>
<tr>
<td>8 Go, George</td>
<td>63000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Social Security (3%)</td>
</tr>
<tr>
<td>9 Hanana, Bryan</td>
<td>48000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Housing (2%)</td>
</tr>
<tr>
<td>10 Jacob, Jacobie</td>
<td>75000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Start getting the percentage for the Tax which is 7%. Click the active cell where to place your Answer (C6).

2. The first cell that you need to get the product is cell reference B6 multiplied by 7%. Click function formula `fx` and from the Insert function of the formula choose Product.

3. **PRODUCT** is to multiply two numbers from the given cells. Choose Product from the Insert Function.

4. Click **OK**.
5. After clicking OK, Excel will show you the Function Arguments for Product. The Excel will suggest and show you the cell reference to be multiplied. Since B6 is the correct cell reference for **Number1**, then you can press Enter key. **Number2** will show to ask for the next cell entry. Since you need to multiply B6 to 7%, then you can type 7% to **Number2** box as shown below.

6. Click OK.

The result after clicking OK from the Function Arguments.
7. Use the drag and drop (Fill handle) to get the Tax deductions from B6 to B10.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Information Technology Department Payroll</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Names</td>
<td>Annual Salary ($)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deductions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tax (7%) Medicare (3%) Social Security (3%) Housing (2%)</td>
</tr>
<tr>
<td>6 Dela Cost, Marilyn</td>
<td>48000</td>
<td>3360 1440 1440 960</td>
</tr>
<tr>
<td>7 Emmanuel, Emmanuel</td>
<td>52000</td>
<td>3640 1560 1560 1040</td>
</tr>
<tr>
<td>8 Go, George</td>
<td>63000</td>
<td>4410 1890 1890 1260</td>
</tr>
<tr>
<td>9 Hanana, Bryan</td>
<td>48000</td>
<td>3360 1440 1440 960</td>
</tr>
<tr>
<td>10 Jacob, Jacobie</td>
<td>75000</td>
<td>5250 2250 2250 1500</td>
</tr>
</tbody>
</table>

The result after the drag and drop for the Tax.

8. Apply the same steps to get the percentage for the Medicare, Social Security and Housing by following steps 1 to 7.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Information Technology Department Payroll</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Names</td>
<td>Annual Salary ($)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deductions:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tax (7%) Medicare (3%) Social Security (3%) Housing (2%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 Dela Cost, Marilyn</td>
<td>48000</td>
<td>3360 1440 1440 960</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 Emmanuel, Emmanuel</td>
<td>52000</td>
<td>3640 1560 1560 1040</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 Go, George</td>
<td>63000</td>
<td>4410 1890 1890 1260</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 Hanana, Bryan</td>
<td>48000</td>
<td>3360 1440 1440 960</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 Jacob, Jacobie</td>
<td>75000</td>
<td>5250 2250 2250 1500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The result after multiplying the percentage.

9. From Lesson 13, add cell references C6 to F6 to get the Total Deductions for cell reference G6. Apply the drag and drop to get the rest of the Answers.

10. From Lesson 14, subtract cell references B6 to G6 to get the difference for cell reference H6 for the Net Pay Salary Per Year.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Information Technology Department Payroll</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Names</td>
<td>Annual Salary ($)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deductions:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tax (7%) Medicare (3%) Social Security (3%) Housing (2%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 Dela Cost, Marilyn</td>
<td>48000</td>
<td>3360 1440 1440 960</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 Emmanuel, Emmanuel</td>
<td>52000</td>
<td>3640 1560 1560 1040</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 Go, George</td>
<td>63000</td>
<td>4410 1890 1890 1260</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 Hanana, Bryan</td>
<td>48000</td>
<td>3360 1440 1440 960</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 Jacob, Jacobie</td>
<td>75000</td>
<td>5250 2250 2250 1500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The complete result for the Net Pay Salary Per Year.
Activity 1: Answer the following.

1. Give three formulas to solve the Product for the following given data.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>35</td>
<td>65</td>
<td></td>
</tr>
</tbody>
</table>

   a. ___________________________________________________________________

   b. ___________________________________________________________________

   c. ___________________________________________________________________

2. Complete the Table, write the formula to obtain the product of B3 and C3.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>21</td>
<td></td>
</tr>
</tbody>
</table>

   Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 15. In this lesson, you learned to identify the steps in multiplying numbers and to multiply numbers in various cells.
Practical Exercise 15

The Toyota Motors Japan will export the following types of cars to different countries listed below for every month.

1. Open a new Excel and type in the following data.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toyota Motors Japan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Philippines</td>
<td>Camry</td>
<td>Vios</td>
<td>Hilux</td>
<td>Corola</td>
</tr>
<tr>
<td>4</td>
<td>200</td>
<td>333</td>
<td>562</td>
<td>355</td>
<td>222</td>
</tr>
<tr>
<td>5</td>
<td>Papua New Guinea</td>
<td>231</td>
<td>180</td>
<td>236</td>
<td>652</td>
</tr>
<tr>
<td>6</td>
<td>Thailand</td>
<td>401</td>
<td>321</td>
<td>952</td>
<td>500</td>
</tr>
<tr>
<td>7</td>
<td>Malaysia</td>
<td>212</td>
<td>211</td>
<td>555</td>
<td>410</td>
</tr>
<tr>
<td>8</td>
<td>Indonesia</td>
<td>321</td>
<td>300</td>
<td>568</td>
<td>350</td>
</tr>
</tbody>
</table>

2. Insert a column on every brand of car and title it as Total.

3. Compute for the Total number of cars to be exported by Toyota Motors Japan for one year.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity

1. Three formulas to solve for the Product.
   a. =PRODUCT(B2:C2) or =PRODUCT(B2,C2)
   b. =(B2*C2)
   c. =(35*65)

2. The formula using the formula function fx is =PRODUCT(B3:C3) or =PRODUCT(B3,C3)

Note: Do not forget to use the drag and drop from cell reference D4 after getting the first product.
Lesson 16: Dividing Numbers in Various Cells

Welcome to Lesson 16 of Unit 3. In Lesson 15, you learned the steps in multiplying numbers.

In this lesson, you will be able to enumerate the process of dividing numbers in various cells and to calculate numbers using the division in various cells.

Your aims:
- identify the steps in dividing numbers in various cells
- divide numbers in various cells

Dividing Numbers in Various Cells

In division, it is similar to multiplication. Review your Grade 9 Design and Technology Computing, Spreadsheet 1, Topic 3, Lesson 16. It is about dividing two numbers. In the expression \( A / B = C \), \( A \) is called the **dividend or numerator**, \( B \) the **divisor or denominator** and the result \( C \) is called the **quotient**.

Your mathematical operator for division is the slash symbol (/). In division, it describes two distinct but related settings. Partitioning involves taking a set of size \( A \) and forming \( B \) groups that are equal in size. The size of each group formed, \( C \) is the quotient of \( A \) and \( B \). Even though you can use numbers directly in your division formula, it is much better to use the references or addresses of the cells containing your data. If you use the **cell references** rather than the actual data, later, if you need to change the data in either cell, the results of the formula will update automatically without having to rewrite the formula again.

Example:

\[
\begin{array}{ccc}
A & B & C \\
1 & & \\
2 & A & B & C \\
3 & 10 & 5 & 2 \\
\end{array}
\]

Now, take the following steps on how to divide two numbers.

1. As what you did from the previous (addition, subtraction and multiplication) you need to type the data into your blank Spreadsheet.

2. Type the given data.
The number of Girl Scouts collected empty plastic bottles to donate to 5 schools who are in need to make these empty plastic bottles for their big project to make the new invention called new plastic bottles walls that can save more money to make walls for the classrooms. Compute for the empty plastic bottles that the school needed to create for their school's walls.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Empty bottles</td>
<td>Collected</td>
<td>Kla Kla School</td>
<td>Gordon School</td>
<td>Jubilee School</td>
<td>Gerehu School</td>
<td>Canitas School</td>
</tr>
<tr>
<td>2.</td>
<td>3.</td>
<td>4.</td>
<td>5. TOTAL</td>
<td>6.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>112,235</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Use the formula function $fx$ to get the quotient. If this is your first time to use this method and you couldn't find it in your Insert Function, type Quotient on the Search for a Function and click Go. The word Quotient will appear and it is now ready for use.

4. Make sure that you place your active cell to the cell where you put your quotient. Suppose you will use cell reference C5 to print for the quotient.

5. Click OK.
6. The Function Arguments for the Insert Function will appear.

Type the Numerator which is B5 and your denominator which is 5 for the five schools.

As you can see after typing the cell reference to the Numerator, the value of B5 appears to the right side of the Function Arguments, as well as the denominator and the quotient.

7. Click OK.

8. Therefore, each school will receive 22447 empty plastic bottles from the Girl Scout.
Activity 1: Answer the following.

1. Write TRUE if the Answer is correct and write FALSE if the statement is wrong.
   a. The other name for dividend is called the numerator. _________
   b. The other name for the divisor is called the denominator. _________
   c. The result or the Answer for this division is called the quotient. _________
   d. The mathematical operator for division is called the asterisk. _________
   e. In division, it describes two distinct but related settings. _________
   f. Using the cell reference rather than the actual data is much better to update automatically the value without having rewriting the formula again. _________

2. Number the given Insert Function accordingly.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 16. In this lesson, you learned to identify the steps in dividing numbers and to divide numbers in various cells.

NOW DO PRACTICAL EXERCISE 16 ON THE NEXT PAGE.
Practical Exercise 16

A. Compute for the quotient:

a. There were 550 students in NCD who will take part in the inauguration of the new Stadium in Port Moresby. The government will provide 25 seater buses to collect the students from their respective schools to bring them to the new Stadium. Solve on how many buses needed to collect the students.

\[ A4 = 550 \quad B4 = 25 \quad C4 = \text{Answer} \]

b. Mr. Brown bought 3,587 acres of land to given to his seven children. Compute for the quotient on how many acres of land he can give to his children.

c. The Rotary Club of Port Moresby brought 880 pieces of blankets, 440 sacks of rice, 2000 bottled water and 250 boxes of tin fish to the affected area of the typhoon. There were about 250 families waiting for the Rotary for their donations. Compute on how many blankets, sacks of rice, bottled water and boxes of tin fish will be given for each family.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity

1.

a. TRUE  

b. TRUE  

c. TRUE  

d. FALSE, slash (/) is correct Answer and not asterisk  

e. TRUE  

f. TRUE  

2. 

[Image of Excel function dialog box]
Lesson 17: Using Auto Sum

Welcome to Lesson 17 of Unit 3. In Lesson 16 you learned the steps in dividing numbers.

In this lesson, you will be able to enumerate the process the steps in using the Auto Sum and the importance of the Auto Sum.

**Your aims:**
- identify the steps in quickly adding consecutive list of numbers
- identify the importance of using the Auto Sum

The Auto Sum

**Auto Sum** is a shortcut for the **SUM function**. As you take a look at your Grade 9 Design and Technology – Computing, Spreadsheet 1, Lesson 17 on page 163, a **function** in a Spreadsheet program inserts a formula in the selected cell that adds the numbers in the column. It sets the range of cells by looking for numeric data above the selected cell.

The importance of the Auto Sum tabulation tool is; it is used to quickly add numbers in consecutive cells.

A **function** is a predefined formula that performs calculations using specific values in a particular order. While you may think of formulas as being short mathematical equations, like $2 + 2$ or $F2 \times C2$, they can actually be very lengthy and involve complex mathematical calculations. One of the key benefits of functions is that they can save you time since you do not have to write the formula yourself. For example, you could use an Excel function called **Average** to quickly find the average of a range of numbers or the **Sum** function to find the sum of a cell range.

In this lesson, you will learn how to use basic functions such as SUM and AVG, use functions with more than one argument, and how to access the other Excel 2010 functions.

**The Parts of a Function**

Each function has a specific order, called **syntax**, which must be strictly followed for the function to work correctly.

**Syntax Order:**

1. All functions begin with the = sign.
2. After the = sign, define the **function name** (e.g., Sum).
3. Then, there will be an argument. An argument is the cell range or cell references that are enclosed by parentheses. If there is more than one argument, separate each by a comma.

4. An example of a function with one argument that adds a range of cells, A3 through A9:

\[=\text{SUM (A3:A9)}\]

An example of a function with more than one argument that calculates the sum of two cell ranges:

\[=\text{SUM (A3:A9, B3:B5)}\]

Excel literally has hundreds of different functions to assist with your calculations. Building formulas can be difficult and time-consuming. Excel's functions can save you a lot of time and headaches.

**Excel's Different Functions**

There are many different functions in Excel 2010. Some of the more common functions include:

**Statistical Functions:**

- **SUM** - summation adds a range of cells together.
- **AVERAGE** - average calculates the average of a range of cells.
- **COUNT** - counts the number of chosen data in a range of cells.
- **MAX** - identifies the largest number in a range of cells.
- **MIN** - identifies the smallest number in a range of cells.
Start to type this given data and value to use the following functions.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Student's Name</td>
<td>Test1</td>
<td>Test2</td>
<td>Test3</td>
<td>Test4</td>
<td>TOTAL</td>
<td>Average</td>
</tr>
<tr>
<td>2</td>
<td>Abad, Romeo Jnr</td>
<td>18</td>
<td>12</td>
<td>20</td>
<td>33</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Ben, Benjamin</td>
<td>15</td>
<td>15</td>
<td>14</td>
<td>35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Calos, Elizabeth</td>
<td>20</td>
<td>19</td>
<td>13</td>
<td>36</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>McJohn, David</td>
<td>11</td>
<td>18</td>
<td>16</td>
<td>29</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Spears, Maroa</td>
<td>15</td>
<td>17</td>
<td>17</td>
<td>28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Tango, May</td>
<td>9</td>
<td>9</td>
<td>18</td>
<td>38</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Ubra, Mary Joyce</td>
<td>10</td>
<td>12</td>
<td>12</td>
<td>30</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Start to compute for the TOTAL, using the **Auto SUM**. Position your active cell to cell reference F7 to compute for the TOTAL for the first student.

2. Click **Auto Sum**, drop down arrow to choose function name.

3. Select **SUM** to compute for the TOTAL.

4. As soon as you click the **Sum**, the cells will have these marching ants' lines to suggest if those are the correct values to be added.
5. Since cell references B7 to E7 are the correct cells, just press the Enter Key. The first sum will appear to F7.

6. Continue for the TOTAL by using the drag and drop.

7. Compute for the Average by using the drop down arrow again for the Auto Sum and select the Average this time.

8. Click Average.

9. Since you need to get the Average from the TOTAL which is in cell reference F7, you need to edit the argument by changing the argument to F7. Click the Enter Key and you will have the first Average in G7; continue to get the Average using the drag and drop.
10. In cell reference B15, you need to get the number of students by clicking the Auto Sum and click Count Numbers.

11. Position your active cell to cell reference B15. Click the Auto Sum again and click Count Numbers.

12. Next, you will be to get the Highest on every test the students take. Position your active cell to cell reference B16; click the Auto Sum again and click MAX.
13. Since for this Highest (Max) you need to get the highest score for the test, you need to change the argument to **B7:B13** for the seven students' cell references.

![Excel screenshot showing the formula =MAX(B7:B13) in cell B16]

14. Press the **Enter** key after you change the argument. Use the drag and drop to get highest from Test 1 to Average.

![Excel screenshot showing the formula =MAX(B7:B13) in cell B16]

15. Apply the same technique for the Lowest by clicking the **MIN** from the Auto Sum.
16. Save your file with the filename AUTOSUM.

In addition to Auto Sum you can also use the different function names:

**Date and Time functions:**

**DATE** - Converts a serial number to a day of the month

**Day of Week**

**DAYS360** - Calculates the number of days between two dates based on a 360-day year

**TIME** - Returns the serial number of a particular time

**HOUR** - Converts a serial number to an hour

**MINUTE** - Converts a serial number to a minute

**TODAY** - Returns the serial number of today's date

**MONTH** - Converts a serial number to a month

**YEAR** - Converts a serial number to a year

You do not have to memorize the functions but you should have an idea of what each can do for you.

In addition to your formula functions, you also have:

**The Equation Editor**

The **Equation Editor** is new in Excel 2010 and is designed to create a mathematical equation as a graphical object.

The Equation Editor in Excel 2010 is difficult to navigate at first. The second time I tried creating an equation, it got slightly easier, and the third time with the same equation seemed to almost get the hang of it. The trick was to just type the equation in and let the Editor do its thing in rearranging what you’re typing.
Tools Ribbon is two helpful selections: Professional and Linear. Playing around with these will help you understand how the Editor can manipulate simple equations.

Advanced equations will take some time to figure out, but the editor should handle most anything you can throw at it.

**Entering an Equation**
To enter an equation with the Equation Editor, go to the Insert tab on the Ribbon, and click Equation. This gives you a text box with the words “Type equation here.” You will also notice two additional menu tabs on the Ribbon: Equation Tools, which becomes active, and Drawing Tools.

There are varied Symbols readily available for insertion on the Equation Tools Ribbon tab. There are also several drop-down menu items that can expand to show even more symbols for things like: Fraction, Script, Radical, Integral, Large Operator, Bracket, Function, Accent, Limit and Log, Operator, and Matrix.

---

**Activity 1:** Answer the following.

1. Give the five Statistical Functions and explain.
   a. 
   b. 
   c. 
   d. 
   e.
2. Name the five Statistical Functions.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Summary**

You have come to the end of Lesson 17. In this lesson, you learned to identify the steps in using the Auto Sum and the importance of the Auto Sum.

**NOW DO PRACTICAL EXERCISE 17 ON THE NEXT PAGE.**
Practical Exercise  17

1. **Write three steps on how to use the Statistical functions**
   
   a. **SUM**

   b. **Average**

   c. **Count Numbers**

   d. **MAX**

   e. **MIN**

---

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.
Answers to Activity

1.

a. **SUM** - summation adds a range of cells together.

b. **AVERAGE** - average calculates the average of a range of cells.

c. **COUNT** - counts the number of chosen data in a range of cells.

d. **MAX** - identifies the largest number in a range of cells.

e. **MIN** - identifies the smallest number in a range of cells.

2.

1. **SUM**

2. **AVERAGE**

3. **COUNT**

4. **MAX**

5. **MIN**
Lesson 18: Copying Data or Formula

Welcome to Lesson 18 of Unit 3. In Lesson 17, you learned the steps in quickly adding consecutive list of numbers using the Auto Sum.

In this lesson, you will be able to enumerate the steps in copying data or formula, the importance of copying data or formula in an Excel sheet.

Your Aims:
- identify the steps in copying and pasting text, numbers or formulas
- identify the importance of copying data or formula

Copying Formula

From your Grade 9 Design and Technology – Computing, Spreadsheet, Lesson 18 you learned about Copying. When setting up a Spreadsheet. It is useful to be able to copy formulas from one place in the sheet to another. The formula may need to be copied to a different page of the workbook. Copied formulas can save time and you are sure that your formula is accurate. Sometimes, the formula needs to refer to different field ranges based on the page that it is on.

Since you already discussed from your Grade on how to copy using the ribbon, you will have the other way around to copy using the Mini Toolbar.

Copying using the Mini Toolbar

By clicking the right button of your mouse, you can see and use the menus you want to work with your Excel.

1. Type the following in your Excel Spreadsheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Practice 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Practice 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Practice 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Practice 4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


3. Click the right button of your mouse.
4. After clicking Copy, you will see that A2 will change from highlighted line to marching ants line, meaning the Excel is ready to move your text into another cell reference. Click the right button of your mouse again to see the Mini Toolbar and this time, you click Paste to the destination you want to copy the text. Suppose you will copy the text to C2.

5. After clicking the right button of your mouse the Paste options will appear.

Paste (P): This option will paste the text to the destination cell that you assigned.
Values (V): This option will paste the numbers to the destination cell that you assigned.

Formulas (F): This option will paste the formulas to the destination cell that you assigned.

Transpose (T)  Formatting (R)  Paste Link (N)

The Paste Special Options.

6. You will choose Paste (P) since you are copying a text but make sure you are positioning your cell reference to the target cell where you want to transfer your text.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Practice 1</td>
<td></td>
<td>Practice 1</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Practice 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Practice 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Practice 4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remember, when you click Paste (P) using the Mini Tool Bar the text will automatically transfer but the original text that you copy will still have the marching
ants lines. In order to remove the marching ants lines click the left button of your mouse.

Do the same to A4, A6 and A8, and transfer the files in to column C.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Practice 1</td>
<td>Practice 1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Practice 2</td>
<td>Practice 2</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Practice 3</td>
<td>Practice 3</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Practice 4</td>
<td>Practice 4</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The result after using the Copy / Paste (P).

**Copy / Paste Numbers using the Mini Toolbar**

Follow the steps below on how to copy or paste numbers using the Mini Toolbar.

1. Copy the given numbers into your Spreadsheet.

2. You will apply the steps you have for the Copy / Paste (P) for the text for these numbers, but you will change the clipboard from Paste (P) to Values (V).

3. Transfer all these numbers from cell references A2 to A4. Highlight the three cells and click **Copy** from the Mini Toolbar.
4. After clicking the Copy Command, the three cells to be copied will be changed to marching ant lines. Click again the right button and choose Values (V) to the clipboard to transfer the numbers to column B.

How about if you will copy the formula?

It is possible for you to copy and paste formulas in order for you not to re-type the formula to the other cells. Type the following numbers into our Spreadsheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>12345</td>
<td>12345</td>
</tr>
<tr>
<td>3</td>
<td>56987</td>
<td>56987</td>
</tr>
<tr>
<td>4</td>
<td>89652</td>
<td>89652</td>
</tr>
</tbody>
</table>

Apply the complex formula for your given data.

Simple formulas have one mathematical operation, such as 5+5. **Complex formulas** have more than one mathematical operation, such as 5+5-2. When there is more than one operation in a formula, the **order of operations** tells you which operation to calculate first. In order to use Excel to calculate complex formulas, you will need to understand the order of operations. Please refer to Lesson 13 to review for your order of operations.

Suppose Part 1 will be multiplied to Part 2 and be added to Part 3.

=23*45+85 means that the Excel will multiply it first and add later. Can you remember the mathematical order of operations? The PEMDAS

- **Parenthesis**
- **Exponential**
- **Multiplication**
- **Division**
- **Addition**
- **Subtraction**
5. Do your first formula for row 4. Go to formula bar to compute for the product in cell references A4 and B4 and for the Total.

![Formula in Excel](image)

After typing complex formula.

6. Press Enter Key or press (✓) to confirm that your formula is correct. But do not worry Excel will suggest and tell you if your formula is not correct or you miss something in your formula.

![Formula after clicking Enter Key](image)

After clicking Enter Key to confirm the formula.

7. Use the drag and drop to get the Answer1 for rows 5 and 6.

![Formula after drag and drop](image)

After using the drag and drop to copy the Answers for rows 5 and 6

8. Type Answer2 to column E, cell reference E2.

9. Copy the Formula from D4 to E4.
10. Click the Formulas (F) from the Paste options to confirm it.

11. As you notice, Answer2 copies the formula but adjusts the cells to columns B, C, and D and not column A. You can make some corrections manually according to what you want and need.

12. Use the drag and drop to get the Answers for rows 5 and 6.
Activity 1: Answer the following.

   a. ________________________________
   b. ________________________________
   c. ________________________________
   d. ________________________________
   e. ________________________________
   f. ________________________________

2. Name the Six Paste Options
   1. ________________________________
   2. ________________________________
   3. ________________________________
   4. ________________________________
   5. ________________________________
   6. ________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 18. In this lesson you learned to identify the steps in copying data or formula and the importance of copying data or formula in an Excel sheet.

NOW DO PRACTICAL EXERCISE 18 ON THE NEXT PAGE.
Practice Exercise 18

Type the given data into your worksheet and use the Copy and Paste commands.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Fruits</td>
<td>Set A</td>
<td></td>
<td>Set B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Apples</td>
<td></td>
<td>562</td>
<td></td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Oranges</td>
<td></td>
<td>529</td>
<td></td>
<td>562</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Grapes</td>
<td></td>
<td>561</td>
<td></td>
<td>562</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Bananas</td>
<td></td>
<td>258</td>
<td></td>
<td>521</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Kiwis</td>
<td></td>
<td>897</td>
<td></td>
<td>541</td>
<td></td>
</tr>
</tbody>
</table>

1. Copy Column A to B using the Copy / Paste commands in a Mini Tool bar.
2. Copy C4 to C8 to column D rows 4 to 8.
3. Add columns C and E and place your TOTAL in column F.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity
1. 
   a. Parenthesis  
   b. Exponential  
   c. Multiplication  
   d. Division  
   e. Addition  
   f. Subtraction
2. The Paste Options
   - Paste (P)
   - Values (V)
   - Formulas (F)
   - Transpose (T)
   - Formatting (R)
   - Paste Link (N)
Answers to Practical Exercises

Practical Exercise 13

A.
1. Place your active cell to the corresponding cell reference that need to compute for the Total.
2. Click function formula \( fx \).
3. Choose SUM to add the cell references.
4. Click OK from the Insert function.
5. Type the cell references to add or just click OK if the cell reference that is shown is correct from the Function arguments.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Class</td>
<td>Grade 9</td>
<td>Grade 10</td>
<td>Grade 11</td>
<td>Grade 12</td>
<td>TOTAL</td>
</tr>
<tr>
<td>2</td>
<td>P</td>
<td>50</td>
<td>54</td>
<td>55</td>
<td>51</td>
<td>210</td>
</tr>
<tr>
<td>3</td>
<td>N</td>
<td>45</td>
<td>50</td>
<td>51</td>
<td>52</td>
<td>198</td>
</tr>
<tr>
<td>4</td>
<td>G</td>
<td>49</td>
<td>49</td>
<td>55</td>
<td>50</td>
<td>203</td>
</tr>
<tr>
<td>5</td>
<td>TOTAL</td>
<td>144</td>
<td>153</td>
<td>161</td>
<td>153</td>
<td>611</td>
</tr>
</tbody>
</table>

Practical Exercise 14

1.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Employee’s Name</td>
<td>Monthly Salary (K)</td>
<td>Tax</td>
<td>Net Salary Per Month</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-20%</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bonbon, Micahel</td>
<td>2200</td>
<td>440</td>
<td>1760</td>
</tr>
<tr>
<td>3</td>
<td>Calway, Jonathan</td>
<td>1800</td>
<td>360</td>
<td>1440</td>
</tr>
<tr>
<td>4</td>
<td>Demore, Debbie</td>
<td>3500</td>
<td>700</td>
<td>2800</td>
</tr>
<tr>
<td>5</td>
<td>Maneechan, Beth</td>
<td>4000</td>
<td>800</td>
<td>3200</td>
</tr>
<tr>
<td>6</td>
<td>Yannee, Eddie</td>
<td>2100</td>
<td>420</td>
<td>1680</td>
</tr>
</tbody>
</table>
**Practical Exercise 15**

Insert one column on every brand of the car and type the Title for the Product which will be multiplied by 12 (one year).

Use the drag and drop method to get the Product for every country.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Toyota Motors Japan</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Total for</td>
<td>Total for</td>
<td>Total for</td>
<td>Total for</td>
<td>Total for</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Camry One Year</td>
<td>Vios One Year</td>
<td>Hilux One Year</td>
<td>Corolla One Year</td>
<td>Hybrid One Year</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Philippines</td>
<td>200</td>
<td>2400</td>
<td>333</td>
<td>3996</td>
<td>562</td>
<td>6744</td>
<td>355</td>
<td>4260</td>
<td>222</td>
<td>2664</td>
</tr>
<tr>
<td>5</td>
<td>Papua New Guinea</td>
<td>231</td>
<td>2772</td>
<td>180</td>
<td>2160</td>
<td>236</td>
<td>2832</td>
<td>652</td>
<td>7824</td>
<td>102</td>
<td>1224</td>
</tr>
<tr>
<td>6</td>
<td>Thailand</td>
<td>401</td>
<td>4812</td>
<td>321</td>
<td>3852</td>
<td>952</td>
<td>11424</td>
<td>500</td>
<td>6000</td>
<td>654</td>
<td>7848</td>
</tr>
<tr>
<td>7</td>
<td>Malaysia</td>
<td>212</td>
<td>2544</td>
<td>211</td>
<td>2532</td>
<td>555</td>
<td>6660</td>
<td>410</td>
<td>4920</td>
<td>654</td>
<td>7848</td>
</tr>
<tr>
<td>8</td>
<td>Indonesia</td>
<td>321</td>
<td>3852</td>
<td>300</td>
<td>3600</td>
<td>568</td>
<td>6816</td>
<td>350</td>
<td>4200</td>
<td>658</td>
<td>7896</td>
</tr>
</tbody>
</table>

---

**Practice Exercise 16**

a. There were 550 students in NCD who will take part in the inauguration of the new Stadium in Port Moresby. The government will provide 25 seater buses to collect the students from their respective schools to bring them to the new Stadium. Solve on how many buses needed to collect the students.

A4 = 550   B4 = 25   C4 = Answer

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>550</td>
<td>25</td>
<td>22</td>
<td></td>
</tr>
</tbody>
</table>

b. Mr. Brown bought 3,587 acres of land to given to his seven children. Compute for the quotient on how many acres of land he can give to his children.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3587</td>
<td>7</td>
<td>512.4286</td>
<td></td>
</tr>
</tbody>
</table>

c. The Rotary Club of Port Moresby brought 880 pieces of blankets, 500 sacks of rice, 2000 bottled water and 250 boxes of tin fish to the affected area of the typhoon. There were about 250 families waiting for the Rotary for their...
donations. Compute on how many blankets, sacks of rice, bottled water and boxes of tin fish will be given for each family.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>250</td>
</tr>
<tr>
<td>3</td>
<td>Blankets</td>
<td>880</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Sack of Rice</td>
<td>500</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Bottled Water</td>
<td>2000</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Boxes of Tin fish</td>
<td>250</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Answer to Practice 17

a. **SUM**

1. Click the Auto Sum function
2. Select SUM, and press the Enter Key.
3. Check if the cell references given were correct. Press the Enter Key to confirm.

b. **AVERAGE**

1. Click the Auto Sum function
2. Select AVERAGE, and press the Enter Key.
3. Check if the cell references given were correct. Press the Enter Key to confirm.

c. **COUNT**

1. Click the Auto Sum function
2. Select COUNT, and press the Enter Key.
3. Check if the cell references given were correct. Press the Enter Key to confirm.

d. **MAX**

1. Click the Auto Sum function
2. Select MAX, and press the Enter Key.
3. Check if the cell references given were correct. Press the Enter Key to confirm.

e. MIN

1. Click the Auto Sum function
2. Select MIN, and press the Enter Key.
3. Check if the cell references given were correct. Press the Enter Key to confirm.

---

**Practical Exercise 18**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Fruits</td>
<td>Fruits</td>
<td>Set A</td>
<td></td>
<td></td>
<td>TOTAL</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Apples</td>
<td>Apples</td>
<td>562</td>
<td>562</td>
<td>231</td>
<td>1355</td>
</tr>
<tr>
<td>5</td>
<td>Oranges</td>
<td>Oranges</td>
<td>529</td>
<td>529</td>
<td>562</td>
<td>1620</td>
</tr>
<tr>
<td>6</td>
<td>Grapes</td>
<td>Grapes</td>
<td>561</td>
<td>561</td>
<td>562</td>
<td>1684</td>
</tr>
<tr>
<td>7</td>
<td>Bananas</td>
<td>Bananas</td>
<td>258</td>
<td>258</td>
<td>521</td>
<td>1037</td>
</tr>
<tr>
<td>8</td>
<td>Kiwis</td>
<td>Kiwis</td>
<td>897</td>
<td>897</td>
<td>541</td>
<td>2335</td>
</tr>
</tbody>
</table>

End of Topic 3.

Now Do Exercise 3 in Assignment Book 3 Then Go to Topic 4.
TOPIC 4

SPREADSHEET 2

LESSON 19: Creating a Chart from a Set of Data
LESSON 20: Applying Different Styles of Chart
LESSON 21: Applying Chart Lay Outs
LESSON 22: Chart Components and Controls
LESSON 23: Formatting Data Series (axis titles, colours and backgrounds)
LESSON 24: Formatting Data Series (legends and labels)
TOPIC 4:  GRAPHICAL REPRESENTATION OF DATA

Today you are in danger of being overwhelmed by too much data which is the raw material of information. Charts are graphic, colorful, eye-catching, and mind-enriching which for thousands of years, has been a powerful way to convey what would otherwise be complex information.

The Office Excel 2010 spreadsheet makes it easy to create dozens of different types of charts. You can create a chart from information gathered in almost of any spreadsheet. It is not an exaggeration to say that your ability to take advantage of Excel’s charting capability will make you a more effective spreadsheet user.

In this topic you will learn about the concepts of using chart in an Excel. A spreadsheet user can take advantage of charts that are based on the numbers stored in its rows and columns of cells. Charts enable the user to visualize the data. "A picture," as they say, "is worth a thousand words." By the same token, a well-designed chart can help you make sense of a thousand numbers. Charts are also useful when you need to increase the impact of any oral or written presentation.

The following will be studied:

**Lesson 19** creates a chart from a set of data. You will list down the steps in creating a chart from a set of data and to create chart from the given data.

**Lesson 20** applies different styles of chart. You will discuss the steps in applying different styles of charts in an Excel sheet, to use different chart styles and to discuss the importance of applying different styles of charts.

**Lesson 21** applies chart layouts. You will discuss the different chart layouts, to list down the steps in applying charts layouts in an Excel sheet, to use and apply the different chart layout outs and to discuss the importance of applying chart layout outs.

**Lesson 22** uses chart components and controls. You will list the steps in using chart components and controls, the use of chart components and controls and to discuss the importance of using chart components and controls in an Excel sheet.

**Lesson 23** formats data series (Axis Titles, Colors, and Backgrounds). You will enumerate the steps in formatting data series, to format axis titles, colors and backgrounds and to discuss the importance of formatting data series in an Excel.

**Lesson 24** formats data series (legends and labels). You will enumerate the steps in formatting legends and labels in an Excel sheet to format legends and labels and to discuss the importance of formatting legends and labels in an Excel.

By the end of Topic 4, you should be able to know how to create a chart from a set of data, to apply different styles of chart, apply chart layout outs, to use chart components and controls, to format data series (axis titles, colours and backgrounds) and to format data series (legends and labels).
Lesson 19: Creating a Chart from a Set of Data

Welcome to Lesson 19 of Unit 3. In Lesson 18, you learned to copy data or formula and the importance of copying data or formula in an Excel sheet.

In this lesson, you will be able to enumerate the steps in creating a chart from a set of data and to create chart from a given data set.

Your Aim:
- identify the steps in creating a chart from a set of data

Creating a chart

Once a table has set up, the information in the table can easily be turned into one of several different chart types. These include:

- Column and bar graphs
- Line graphs
- Pie charts

Creating a chart in Excel involves following the steps below:

1. Select the data to be included in the chart.
2. The selection should include table headings. Excel can use headings as labels on the chart.
3. The selection should not include totals.
4. Begin the chart wizard which will prompt you for details about the chart.
5. Customize the completed chart.

The values represented in a chart are called a data series or a data set. In the chart you are about to create, numbers in the given days ranges (A, B, C, etc.) will be represented by bars. The chart will have a title and a legend with names descriptive of the data series. Most charts, except pie charts, have axes, which are the perpendicular lines along which the data are plotted or displayed. The Y axis is the vertical axis (running from top to bottom). The X axis is the horizontal axis (running from left to right). To create a chart in Excel, you must first designate the set of cells in the spreadsheet that you want included in the chart. This is called the chart range. Select the Chart Range now. Follow the steps on the next page to select a chart range.
1. Select by dragging and highlighting, cells A1 through F2.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Monday</td>
<td>Tuesday</td>
<td>Wednesday</td>
<td>Thursday</td>
<td>Friday</td>
<td>Saturday</td>
</tr>
<tr>
<td>2</td>
<td>5226</td>
<td>2555</td>
<td>5842</td>
<td>2554</td>
<td>8652</td>
<td>4562</td>
</tr>
</tbody>
</table>

Check out each of the 7 categories of charts.

2. In the Insert Ribbon ➔ Charts Group, click on the Column charts icon and look at the 19 different types of Column Charts you can make.
Please review our Design and Technology – Computing for Grade 9, Spreadsheet 1 on Lesson 23 about Creating a Graph with Chart Wizard.

3. Click on the **Line charts** icon and look at the **7** different types of Line Charts you can make.

4. Click on the **Pie charts** icon and look at the **6** different types of Pie Charts you can make.

5. Click on the **Bar charts** icon and look at the **15** different types of Bar Charts you can make.
6. Click on the **Area charts** icon and look at the 6 different types of Area Charts you can make.

7. Click on the **Scatter charts** icon and look at the 5 different types of Scatter Charts you can make.
8. Click on the Other charts icon and look at the 15 different types of Charts you can make.

Begin to type your data into your blank worksheet.
No matter what type of chart or graph you are creating, the first step in creating an Excel chart is **always** to enter the data into the worksheet.

When entering the data, it helps to keep a few **simple rules** in mind:

a. Do not leave blank rows and columns when entering your data. If you do leave a blank row, it will make it harder to use the Excel Chart Wizard. While it is possible to include individual rows or columns, it makes creating the chart a bit trickier than if the data is altogether.

b. Enter your data in columns whenever possible. When laying out your spreadsheet, list the names describing the data in one column and, to the right, the data itself. If there is more than one data series, list them one after the other in columns with the title for each data series at the top.

**Steps in Creating a Chart**

Follow the steps below on how to create a chart in Microsoft Excel.

1. Click and hold down the left mouse button over one corner cell of your spreadsheet data.
2. Drag the mouse pointer over the data to select it.

**Note:** Be sure to include any column and row titles that you want to include in the Chart.

Highlight the block of cells from A3 to B12, which includes the column titles, Location and January.
3. Choose **Insert ➔ Chart** from the menu.

4. Pick a Chart on the **Standard Tab**.

5. Pick a **Chart type** from the left panel

6. Pick a **chart sub-type** from the right panel

   **Note:** If you want to create charts that are a bit more exotic, choose the Custom Types tab at the top of the Chart Type dialog box.

**For our data**

(On the Standard Chart Types tab)

7. Choose the **Column** chart type in the left hand pane.

8. Choose the **Clustered Column** chart sub-type in the right hand pane.

9. Click **Enter**.
10. Save your work with filename Country.

Activity 1: Name the following Standard symbols for creating Charts.

1. ____________________________________________________
2. ____________________________________________________
Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

___________________________________________________________________

Summary
You have come to the end of Lesson 19. In this lesson, you learned to enumerate the steps in creating charts from a set of data.

NOW DO PRACTICE EXERCISE 19 ON THE NEXT PAGE.
Practice Exercise 19

A. Write T if the sentence is correct and F if it is false.

1. The values represented in a chart are called a data series or a data set.  
   _________

2. The Y axis is the vertical axis (running from top to bottom).  _________

3. The X axis is the horizontal axis (running from left to right).  _________

4. Chart range is the set of cells in the spreadsheet that you want to include in the chart.  
   _________

5. Column chart has 19 different types of Charts.  _________

6. Line chart has 6 different types of Charts.  _________

7. Do not leave blank rows and columns when entering your data. If you do leave a blank row, it will make it harder to use the Excel Chart Wizard.  _________

8. The first step in creating an Excel chart is always to enter the data into the worksheet.  _________

9. Other charts have 17 different types of Charts.  _________

10. Most charts, except pie charts, have axes, which are the perpendicular lines along which the data are plotted or displayed.  _________

B. Write steps on how to create a Chart.

1. ______________________________________________________________

2. ______________________________________________________________

3. ______________________________________________________________

4. ______________________________________________________________

5. ______________________________________________________________

6. ______________________________________________________________

7. ______________________________________________________________

8. ______________________________________________________________

9. ______________________________________________________________

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4.
**Answers to Activity**

1. Column Chart  
2. Line Chart  
3. Pie Chart  
4. Bar Chart  
5. Area Chart  
6. Scatter Chart  
7. Other Charts
Lesson 20: Applying Different Styles of Chart

Welcome to Lesson 20 of Unit 3. In Lesson 19, you learned the steps in creating a chart.

In this lesson, you will be able to enumerate the different styles of charts, the steps in applying different styles of charts in an Excel sheet and to discuss the importance of applying different styles of charts.

Your Aims:
- identify the different styles of charts
- identify the steps in applying the different styles of chart
- identify the importance of applying different styles of chart

Charts and Graphs
The Excel charting capability
Today, you are in danger of being overwhelmed by a superabundance of data—the raw material of information. Charts—graphic, colorful, eye-catching, mind enriching—have, for thousands of years, have been a powerful way to convey what would otherwise be complex information. The Office Excel 2010 spreadsheet makes it easy to create dozens of different types of charts. You can create a chart from information gathered in most of any spreadsheet. It is not an exaggeration to say that your ability to take advantage of Excel’s charting capability will make you a more effective student.

Creating a Column chart
The values represented in a chart are called a data series or a data set. In the chart you are about to create, the number of students in the various grade ranges (A, B, C, etc.) will be represented by bars. The chart will have a title and a legend with names descriptive of the data series. Most charts, except pie charts, have axes, which are the perpendicular lines along which the data are plotted or displayed. The Y axis is the vertical axis (running from top to bottom). The X axis is the horizontal axis (running from left to right). To create a chart in Excel, you must first designate the set of cells in the spreadsheet that you want included in the chart. This is called the chart range.

Charts and graphs are a great way of representing your data. Microsoft Excel 2010 offers almost every chart type and makes it easier to draw them so that your data can quickly be understood in a graphical format. In this lesson, you will learn what each chart and graph represents and the additional functionality that you might not have heard about.

1. Make sure that there are some data in your Excel sheet and that your Excel sheet does not contain any blank cells between the different columns. Please refer to our Lesson 19 and follow the steps.
2. Click the Insert menu and choose the chart type that you wish to draw. The data in your Excel sheet will be organized as a chart.

3. Once the chart is drawn, it becomes very easy to change the attributes: Right click the chart and you will see the options for changing chart types, data and other formatting. The charts or graph type will depend on the data for which you are going to plot the chart. The most commonly used types include Column Chart, Line Graphs, Pie Chart, Bar Graph, Area Chart, Scatter Graphs, Stock Chart and Surface Chart among many others. Let us discuss these chart types and the situations in which a specific chart type is used.

**The Column Chart**

The Column chart is one of the most commonly used chart type and is used to show the changes in data over a period of time or illustrate comparisons among items. As you discussed earlier, the steps on how to choose a certain chart by clicking the Insert Menu and choose Column Chart as your practice chart.
After clicking the Column chart menu, varieties of column chart designs will appear.

**The Line Graphs**

Line Graphs are mainly used to plot changes in data over time.
The best example of this chart type can be the weekly change in temperature.

![Line Graph](image1)

**The Pie Chart**
The pie chart is very useful when you wish to emphasize on a significant element in the data. It represents data in the form of pie.

![Pie Chart Menu](image2)

![Pie Chart](image3)

![Types of Pie Chart](image4)
The Bar Graph
A bar illustrates comparisons among individual items.

Sample of a Bar Graph.

The types of Bar graph.

The Area Chart
An area chart displays the magnitude of change over time.

The Area Menu.
The Scatter Graphs
The Scatter Graph and Line Chart are almost similar, but the Scatter Graph is displayed with a scribble line whereas the Line Graph uses connected lines to display data.
The Surface Charts
A surface chart comes in handy if you are to determine the optimum combination between two sets of data. The Surface chart is under the Other Charts Menu.

The Chart Plot Area
The area that is covered by a specific chart is called the Chart Plot Area. By default Excel draws charts according to the default configuration, but it is very easy to edit the plot area. Simply right click the chart and choose the Format Plot Area option. Now you will see a dialogue box which lets you see the chart's fill style, borders, Glow and Soft Edges, and 3-D effects.
Activity 1: Match Column A to Column B.

Column A

_________1.

_________2.

_________3.

_________4.

_________5.

_________6.

_________7.

Column B

a. Line Graph

b. Pie Graph

c. Column Chart

d. Surface Chart

e. Scatter Graph

f. Area Chart

g. Bar Graph

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary

You have come to the end of Lesson 20. In this lesson, you learned to identify different styles of charts and identify the importance of applying different styles of chart.

NOW DO PRACTICE EXERCISE 20 ON THE NEXT PAGE.
Practice Exercise 20

A. Write the correct names for the given charts.

<table>
<thead>
<tr>
<th>Column</th>
<th>Line</th>
<th>Pie</th>
<th>Bar</th>
<th>Area</th>
<th>Scatter</th>
<th>Other Charts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4.

Answers to Activity

1. c
2. e
3. d
4. g
5. b
6. a
7. f
Lesson 21: Applying Chart Lay Outs

Welcome to Lesson 21 of Unit 3. In Lesson 20, you learned different styles of charts; identify the steps applying the different styles of chart and the importance of applying different styles of chart.

In this lesson, you will be able to discuss the different chart lay outs, enumerate the steps in applying chart lay outs in an Excel sheet and the importance of applying chart lay outs.

Your Aims:
- identify the different lay outs of charts
- identify the steps in applying chart lay outs
- identify the importance of applying chart lay outs

The Chart Tools

You can easily change the Style of your chart. If you cannot see the Styles, click anywhere on your chart to select it, and you should see the Ribbon change.

The Chart Lay Outs

You can also change the Lay out of your chart in the same way. Locate the Chart Layout panel on the Design tab of the Excel 2010 Ribbon bar. Chart Lay out will bring life to our chart by choosing the different lay out design.

1. As mentioned earlier, highlight the columns and data that you want to make a chart and from the Ribbon bar, choose Insert Menu for your chart.
To start to make a new Chart.

2. Choose **Column Menu** from the **Insert Menu** and for this January Chart you will use 2-D Column which is the **Clustered Column**.

3. Click **Enter** or click the left button of your mouse to see the result for your chart.
The Design Layout
Choosing from any of this Design Layout will give you variety of colours to choose for your Column chart. Design Layout will give us the different colour aspect of the chart. Try to click each of the design and you will see the change of the color for the chart.

![January Chart using the 2-D Column Chart](image1)

The Lay out menu
Follow the steps below on how to use the Lay out menu.

![The Lay out menu](image2)

1. [Steps on how to use Lay out menu]
3. Clicking the drop down arrow of the **Chart Title** from the Layout menu will change the title of your chart.

2. Try clicking the three options and you will see the different format design in your chart.

3. Click the drop down arrow of Axis Titles menu.
For the Primary Vertical Axis Title, the vertical axis title will appear. Try clicking the different options and you will notice the different styles for the vertical axis title.

**The Legend Menu**
For the Legend Menu, this will change the appearance of the Legend title. Try clicking the Legend menu and you will see the different styles to choose for your chart.

**The Data Labels**
For the Data Labels, it is important to put the data labels in your chart to know the different values of the chart.
The Data Table menu
The Data Table menu is another option for you to choose if you do not want the Data Labels menu in your chart layout. The Data Table will show us the data you have for your chart. You have two options to choose from the Data Table menu.
The Axes Menu
For the Axes menu of the Lay out, you have two options to choose, either vertical axis or horizontal axis. These will give you a chart that will change the axis title either from your left going to your right of the chart. Display axis with numbers either in thousands, millions or billions.
The Primary Horizontal Axis menu.

The Primary Vertical Axis menu.

The Gridlines
The Gridlines menu will give you lines as a background in your chart.
The Chart Layouts

By choosing the Chart Tools for your chart, you can also see that the Ribbon Bar will change.

From the Chart Layouts of the Chart Tools, you can choose variety of styles for your chart by clicking the options and clicking the down arrow for more chart layouts.

By clicking the chart options will automatically change chart styles of our chart too. Try to choose one of the styles and see your chart.
For **Line Chart**, the same steps and procedures apply as what you have for the Column Chart.

---

### Activity 1. Answer the questions.

1. Write the steps on how to create a chart using the Chart Layout.

    ____________________________________________________________________
    ____________________________________________________________________
    ____________________________________________________________________
    ____________________________________________________________________
    ____________________________________________________________________
    ____________________________________________________________________
    ____________________________________________________________________
    ____________________________________________________________________

2. Fill in the correct Answers on the spaces provided.
   
   a. From the Ribbon bar you can choose ________________ for the chart.
   
   b. If the chart will overlap the data in our Excel worksheet, you can move the chart using the ________________.
   
   c. You can also place your chart in a different worksheet. Right click anywhere on your chart. Click the right button of your mouse and you see the options to select to ________________.
   
   d. If you want your chart in a new worksheet, select the first option. Then delete the text "______________" from the textbox, and then type a name of your own.
e. You can resize a chart, and any elements on it, by moving your mouse over the sizing handles. For the chart itself, the sizing handles are the _______ in Excel 2010.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 21. In this lesson, you learned to identify the different layout of charts, the steps in applying chart layouts and the importance of applying chart layouts.
Practice Exercise 21

A. Using the 11 options of the Chart Layouts (Column) options, show your charts for January, April, July and October. Highlight your worksheet data from A3 through E12. You should have 11 different charts for this practice exercise.

Answers to Activity

1.
   a. Highlight the data to create the chart.
   b. Choose Insert Menu from the Ribbon.
   c. Choose the Column Chart from the Charts menu options.
   d. Chart will appear after clicking the right button of the mouse or the Enter key.
   d. Click anywhere on your chart to select.
   e. Choose Column menu from the Chart Tools.
   f. Choose any chart styles from the 11 options of the Chart Layouts.

2.
   a. Insert More
   b. Mouse
   c. Move Chart
   d. Chart1
   e. Dots around the edges of the chart
Lesson 22: Using Chart Components and Controls

Welcome to Lesson 22 of Unit 3. In Lesson 21, you learned to identify the different layouts of charts, identify the steps in applying chart layouts and the importance of applying chart layouts.

In this lesson, you will be able to list the use of chart components and controls, uses of chart components and controls and the importance of using the chart components and controls.

Your Aims:
- identify chart components and controls
- identify the steps in using chart components and controls
- determine the importance of using chart components and controls.

To Move and Resize a Chart

You might see that your chart from the previous lesson is covering your data. Your chart is overlapping the data. The importance of the chart components and controls is to move the chart from different locations to avoid overlapping the data and other charts. Follow the steps below on how to move and resize a chart.

To Move a Chart

Follow the steps below on how to move a chart:

1. To move it, hold your mouse over the chart until your cursor changes shape.
2. Press and hold down the mouse button when your cursor looks like this, and then drag your chart to a new location. In the image below, you have placed the chart below the data.

3. You can also place your chart in a different worksheet. To do this in Excel 2010, right click anywhere on your chart. Click the right button of your mouse and you see the options to select to **Move Chart**.

To move Chart.
4. If you want your chart in a new worksheet, select the first option.

5. Delete the text "Chart1" from the textbox, and then type a name of your own.

If you look along the bottom of Excel, you’ll see Sheet1, Sheet2, and Sheet3. Your data is in Sheet1. If you click the drop down list to the right of **Object in** on the dialogue box above, you will see the other worksheets you have open.

6. You can select one from the list and click OK. But for this first chart, leave it in Sheet1.

**To Resize an Excel Chart**

Follow the steps below on how to resize your chart:

1. You can resize a chart, and any elements on it, by moving your mouse over the sizing handles. For the chart itself, the sizing handles are the dots around the edges of the chart in Excel 2010.

2. When your mouse changes shape to a double-headed arrow, hold down your left mouse button. Then drag to a new location. You can resize using the corners, or the edges.

**The Chart Tools Menu**

Most charts, except pie charts, have axes, which are the perpendicular lines along which the data are plotted or displayed. The Y axis is the vertical axis (running from top to bottom). The X axis is the horizontal axis (running from left to right).

To create a chart in Excel, you must first designate the set of cells in the spreadsheet that you want included in the chart. This is called the chart range. After this, follow the steps below to create a chart.
1. Click the arrow down to the right of the Chart Lay Outs panels to see the available Design you can choose from.

2. Next to Design Menu is the Lay Out Menu of the Chart.

The Lay Out menu is a bit big for this page, so you split it into six. But the chart Lay Out panel is split into a number of different sections and allows you to change the information in the chart.
For all versions of Excel, the first thing you may want to do is to give your chart a name.

To change the name of your chart in Excel 2010, locate the Properties panel on the Layout menu.

3. Highlight the default name in the text box and type a new name.

4. If you click away from your chart, and then click back on it, you will notice the name of the chart change.
5. For **Axes**, there are two menus to choose from the **Axes** and the **Gridlines**. The **Axes** can change the format layout of each axis whilst the **Gridlines** will turn the gridlines of your chart on and off. Try to click an option on this menu and watch what happens to your chart.

![Axes and Gridlines Menu](image)

The Primary Horizontal Axis for Axes Menu Options.

The Primary Vertical Axis for Axes Menu Options.

6. For **Analysis**, the **Trendline** and the **Error Bars** are the two highlighted. This is to add either a Trendline or an Error Bars to the chart. Try to click an option on the menu and watch what happens to your chart. Click the undo button if you are not satisfied with the outcome.
Activity 1. Answer the following.

1. Name the five options for the Labels options from the Layout Menu of the Chart Tools.
   a. _____________________________________
   b. _____________________________________
   c. _____________________________________
   d. _____________________________________

The Result of your Chart after using the Lay Outs Options
2. Change your Chart by using the Axis Title for the horizontal and vertical title of your Chart.

a. For the horizontal title (World Cities), click the Primary Horizontal Axis Title Options, click the Pattern Fill and choose the Foreground Color (orange) and the Background Color (Green). Choose Large Checker Board from the Pattern Fill.

b. For the vertical title (Average Precipitation), click the Primary Vertical Axis Title, choose Horizontal Title.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

Summary

You have come to the end of Lesson 22. In this lesson, you learned to identify the different chart components and controls, the steps in applying chart components and controls and the importance of chart components and controls.

---

NOW DO PRACTICE EXERCISE 22 ON THE NEXT PAGE.
Practice Exercise 22

A. Using your data from January, April, July and October (A3 through E12). Use the Bar Chart to create a chart and use Axes and Gridlines.

<table>
<thead>
<tr>
<th>Location</th>
<th>January</th>
<th>April</th>
<th>July</th>
<th>October</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acapulco</td>
<td>10</td>
<td>5</td>
<td>208</td>
<td>145</td>
</tr>
<tr>
<td>Amsterdam</td>
<td>69</td>
<td>53</td>
<td>76</td>
<td>74</td>
</tr>
<tr>
<td>Anchorage</td>
<td>17</td>
<td>13</td>
<td>42.5</td>
<td>52</td>
</tr>
<tr>
<td>Dallas</td>
<td>48</td>
<td>87.5</td>
<td>62</td>
<td>118</td>
</tr>
<tr>
<td>Glasgow</td>
<td>110</td>
<td>50</td>
<td>61</td>
<td>112</td>
</tr>
<tr>
<td>Mandal</td>
<td>39</td>
<td>48</td>
<td>11</td>
<td>53</td>
</tr>
<tr>
<td>New York</td>
<td>99</td>
<td>100</td>
<td>115</td>
<td>86</td>
</tr>
<tr>
<td>Tokyo</td>
<td>101</td>
<td>121</td>
<td>189</td>
<td>172</td>
</tr>
<tr>
<td>Toronto</td>
<td>55.2</td>
<td>65.4</td>
<td>71</td>
<td>63.3</td>
</tr>
</tbody>
</table>

CHECK YOUR WORK. ANS YOURS ARE AT THE END OF TOPIC 4.

Answer to Activity

1. The five option menu for the Label options for the Layout Menu of the Chart Tools.
   a. Chart Title
   b. Axis Title
   c. Legend
   d. Data Labels
   e. Data Table

2. Change the Chart by using the Axis Title for the horizontal and vertical title of your Chart.
Welcome to Lesson 23 of Unit 3. In Lesson 22, you learned to identify the chart components and controls, identify the steps in using chart components and controls and the importance of using chart components and controls.

In this lesson, you will be able to enumerate the steps in formatting data series, format axis title, colours and backgrounds and the importance of formatting data series in an Excel sheet.

Your Aims:
- define data series
- identify the steps in formatting axis titles, colours and backgrounds
- determine the importance of formatting axis titles, colours and backgrounds

Axis Titles, Colours and Backgrounds

From Lesson 19 you defined data series or data set as the values represented in a chart. In the chart you are about to create, numbers in the given days ranges (A, B, C, etc.) will be represented by bars.

It is important to learn how to format axis titles, apply colour and background to a chart as this will define more accurately all the data that is being plotted. It will highlight the importance of each part of the chart as emphasis will be shown with proper application of colours and backgrounds.

The chart will have a title and a legend with names descriptive of the data series. Most charts, except pie charts, have axes, which are the perpendicular lines along which the data are plotted or displayed. The Y axis is the vertical axis (running from top to bottom). The X axis is the horizontal axis (running from left to right). To create a chart in Excel, you must first designate the set of cells in the spreadsheet that you want included in the chart. This is called the chart range. Select the Chart Range now.

The next item on the Labels panel is the Axis Title. Click down the arrow to see options.
At the moment, your chart has no Axis Title. It only has cities running across the bottom. Someone looking at the chart will not know what the cities represent. Here is what your chart looks like at the moment.

To add an Axis Title
Follow the steps below on how to add an axis title:

1. Click on Primary Horizontal Axis Title from the sub menu
2. Click Title Below Axis.

After clicking the Title Below Axis or Primary Horizontal, a new title will be added to the chart.
3. Highlight the default text, and type your own Title. Type **World Cities**.

![Graph with default text highlighted and new title typed]

4. Click away from the chart to see what it looks like.

![Graph with new title added]

Now, you have some explanation for what the numbers represent. You can add a Vertical Axis, as well.

5. Click on the **Primary Vertical Axis Title**. Type **Average Precipitation**.

![Graph with vertical axis title added]

Result after typing the Title.
Axis Colours and Backgrounds
From Axis Title Menu Options, you can format your title by changing colours and backgrounds.

Click **More Options** at the very end of the menu options. If you are working with Axis Title, drag your mouse to the last menu options and choose More Options. You can format the data series either by title, legends, data labels, axes, gridlines and plot area.

There are many options to choose for this More Options menu. The first option is the Fill, wherein you can format your data by changing the colours and backgrounds.

Follow the steps below on how to format your data by using Fill:

1. **Click Axis Title.**

2. **Highlight the Axis Title and type Different Cities.**
3. You can format this axis title by clicking Pattern Fill from the More Options.

There are two options to choose from, the Foreground Colour and the Background Colour.

4. Try to click all the Fill options to see how it works with your title.

5. Click Close if you are done.
Activity 1: Name the “More Options”. Write your Answers on the spaces provided.

a. _______________________

b. _______________________

c. _______________________

d. _______________________

e. _______________________

f. _______________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your Answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 23. In this lesson, you learned to define data series, identify the steps in formatting axis titles, colours and backgrounds and the importance of formatting axis titles, colours and backgrounds.

NOW DO PRACTICE EXERCISE 23 ON THE NEXT PAGE.
Practice Exercise 23

A. From your given Excel worksheet, you already have your practice for the month of January. Make 3 charts for April, July and October. Follow the steps for the Lay Outs.

<table>
<thead>
<tr>
<th>Location</th>
<th>January</th>
<th>April</th>
<th>July</th>
<th>October</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acapulco</td>
<td>10</td>
<td>5</td>
<td>208</td>
<td>145</td>
</tr>
<tr>
<td>Amsterdam</td>
<td>69</td>
<td>53</td>
<td>76</td>
<td>74</td>
</tr>
<tr>
<td>Anchorage</td>
<td>17</td>
<td>13</td>
<td>42.5</td>
<td>52</td>
</tr>
<tr>
<td>Dallas</td>
<td>48</td>
<td>87.5</td>
<td>62</td>
<td>118</td>
</tr>
<tr>
<td>Glasgow</td>
<td>110</td>
<td>50</td>
<td>61</td>
<td>112</td>
</tr>
<tr>
<td>Madrid</td>
<td>39</td>
<td>48</td>
<td>11</td>
<td>53</td>
</tr>
<tr>
<td>New York</td>
<td>99</td>
<td>100</td>
<td>115</td>
<td>86</td>
</tr>
<tr>
<td>Tokyo</td>
<td>101</td>
<td>121</td>
<td>189</td>
<td>172</td>
</tr>
<tr>
<td>Toronto</td>
<td>55.2</td>
<td>65.4</td>
<td>71</td>
<td>63.3</td>
</tr>
</tbody>
</table>

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.

Answers to Activity

1.

a. No fill
b. Solid fill
c. Gradient fill
d. Picture or texture fill
e. Pattern fill
f. Automatic
Lesson 24: Formatting Data Series (Legends and Labels)

Welcome to Lesson 24 of Unit 3. In Lesson 23, you learned to define data series, identify the steps in formatting axis titles, colours and backgrounds and the importance of formatting axis titles, colours and backgrounds.

In this lesson, you will be able to enumerate the steps in formatting legends and labels, format legends and labels and the importance of formatting legends and labels.

Your Aims

- identify the steps in formatting legends and labels
- determine the importance of formatting legends and labels

Legend and Labels

Legend and labels are equally important in formatting your chart as these will identify the identity of what the chart is all about.

The Labels panel on the Lay Out menu lets you format the titles and legends on your chart, while the Legend panels represent the sub title of the chart from the given data of the Excel. Follow the steps below on how to use the Legends and Labels:

1. Click each item on the menu in turn to see what they do.
2. Then click More Title Options. The following dialogue box will appear.
As you can see, there are options to change the Fill, Line Style, Shadow, 3-D Format and Alignment. Play around with the options on the dialogue box to see what they do. The only thing you are changing here is the Chart Title.

3. Click **Close** when you are done.

4. If you do not like what you see, click the undo arrow at the top of the Excel.

**The Chart Legend**
The Chart Legend enables the user to provide legend to the chart to signify what the data present in the chart. Continuing the steps from your previous lesson, do the next steps to change and add legends.
At the moment, your Legend is on the right of the Chart. But you can move this.

5. Click the **Legend** item on the **Layout** panel to see the various options.

6. Click an option on the menu and watch what happens to your legend. You should see it move around the chart. Suppose you will choose **Show Legend At Bottom**, this will appear in your chart.

A **Data Label** is information overlaid on the chart bars. Since in our chart it does not have an overlaid data, you can apply and put the data label on it. Here is the illustration on how the **Data Label** works.

Put the values for each city by clicking the **Outside End**.
You can also see the options if you click More Data Label Options from the menu.

A Data Table is to add a Data Table in your chart. You have three options for this menu.

1. Click an option on the menu and watch what happens to your chart.

2. Click the undo button if you are not satisfied with the outcome.

Activity 1: Choose January and April for the chart. Use Line chart, create a title by typing Only for Two Months, use Legend option and click Show legend on Top.

<table>
<thead>
<tr>
<th>Location</th>
<th>January</th>
<th>April</th>
<th>July</th>
<th>October</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acapulco</td>
<td>10</td>
<td>5</td>
<td>208</td>
<td>145</td>
</tr>
<tr>
<td>Amsterdam</td>
<td>69</td>
<td>53</td>
<td>76</td>
<td>74</td>
</tr>
<tr>
<td>Anchorage</td>
<td>17</td>
<td>13</td>
<td>42.5</td>
<td>52</td>
</tr>
<tr>
<td>Dallas</td>
<td>48</td>
<td>87.5</td>
<td>62</td>
<td>118</td>
</tr>
<tr>
<td>Glasgow</td>
<td>110</td>
<td>50</td>
<td>61</td>
<td>112</td>
</tr>
<tr>
<td>Madrid</td>
<td>39</td>
<td>48</td>
<td>11</td>
<td>53</td>
</tr>
<tr>
<td>New York</td>
<td>99</td>
<td>100</td>
<td>115</td>
<td>86</td>
</tr>
<tr>
<td>Tokyo</td>
<td>101</td>
<td>121</td>
<td>189</td>
<td>172</td>
</tr>
<tr>
<td>Toronto</td>
<td>55.2</td>
<td>65.4</td>
<td>71</td>
<td>63.3</td>
</tr>
</tbody>
</table>
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 24. In this lesson, you learned to identify the steps in formatting legends and labels and determined the importance of formatting legends and labels.

NOW DO PRACTICE EXERCISE 24 ON THE NEXT PAGE.
Practice Exercise  24

A. Follow the instructions.

1. Type the following given data in Excel worksheet:

   **Cell - Data**

   A1 - The Cookie Shop 2012 Revenue from Sales
   A2 - Peanut Butter
   A3 - Chocolate Chip
   A4 - Oatmeal Raisin
   A5 - Lemon
   B2 - 15,500
   B3 - 27,589
   B4 - 24,980
   B5 - 14,768

2. Use Pie chart to create your chart. Create a title by typing on Top the Cookie Shop 2012 Revenue Sales. Show your Legend at the bottom of the chart.

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4.

Answers to Activity
Answers to Practice Exercises

Practice Exercise 19

A. True or False

1. True
2. True
3. True
4. True
5. True
6. False, 7
7. True
8. True
9. False, 15
10. True

B. Steps in creating a Chart

1. Click and hold down the left mouse button over one corner cell of your spreadsheet data.
2. Drag the mouse pointer over the data to select it. Highlight the block of cells from which includes the column titles.
3. Choose Insert, Chart from the menu.
5. Pick a Chart type from the left panel.
6. Pick a chart sub-type from the right panel.
7. Choose the Column chart type from the Standard Chart Types in the left hand pane.
8. Choose the Clustered Column chart sub-type in the right hand pane.
9. Click Enter.

Practice Exercise 20

1. Column
2. Scatter
3. Line
4. Pie
5. Bar
6. Other Charts
7. Area
Practice Exercise 21
Practice Exercise 22

Possible Answer for this Practice Exercise using the Axes and Gridlines.

Practice Exercise 23

For April
For July

![July precipitation chart](chart)

For October

![October precipitation chart](chart)
Practice Exercise 24

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Cookie Shop 2012 Revenue Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Peanut Butter</td>
<td>15,500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chocolate Chip</td>
<td>27,589</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oatmeal Raisin</td>
<td>24,980</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lemon</td>
<td>14,768</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Cookie Shop 2012 Revenue Sales

- Peanut Butter
- Chocolate Chip
- Oatmeal Raisin
- Lemon

End of Topic 4

Now Do Exercise 4 in Assignment Book 4.
REFERENCES

e excel do easy.meebly.com

https://support.office.com/... Excel _ Glossary


hub pages.com.Microsoft office_ Microsoft Excel

intelligentedu.com/microsoft_excel_glossary,html- MS Excel Glossary

spreadsheets.about.com

www.dummiz.com/... Basic formula in excel 2010

www.gcflearnfue.org/excel 2010 - Getting to know Excel

www.keynotesupport.com/excel - basics/excel - basics/ excel- for- beginners - guide,shtml

www.pcmag.com

www.youbepedia.com/TERM/microsoft_excel.htm/
GLOSSARY

3-D reference
A reference to a range that spans two or more worksheets in a workbook.

3-D walls and floor
The areas surrounding many 3-D chart types that give dimension and boundaries to the chart. Two walls and one floor are displayed within the plot area.

Activate
To make a chart sheet or worksheet the active, or selected sheet. The sheet that you activate determines which tabs are displayed. To activate a sheet, click the tab for the sheet in the workbook.

Active Cell
The selected cell in which data is entered when you begin typing. Only one cell is active at a time. The active cell is bounded by a heavy border.

Active Sheet
The sheet that you're working on in a workbook. The name on the tab of the active sheet is bold.

Address
The path to an object, document, file, page, or other destination. An address can be a URL (Youb address) or a UNC path (network address), and can include a specific location within a file, such as a Word bookmark or an Excel cell range.

Alternate Startup Folder
A folder in addition to the XLStart folder that contains workbooks or other files that you want to be opened automatically when you start Excel and templates that you want to be available when you create new workbooks.

Argument
The values that a function uses to perform operations or calculations. The type of argument a function uses is specific to the function. Common arguments that are used within functions include numbers, text, cell references, and names.

Array
Used to build single formulas that produce multiple results or that operate on a group of arguments that are arranged in rows and columns. An array range shares a common formula; an array constant is a group of constants used as an argument.

Array Formula
A formula that performs multiple calculations on one or more sets of values, and then returns either a single result or multiple results. Array formulas are enclosed between braces { } and are entered by pressing CTRL+SHIFT+ENTER.

Associated Pivot table Report
The PivotTable report that supplies the source data to the PivotChart report. It is created automatically when you create a new PivotChart report. When you change the layout of either report, the other also changes.

Auto Format
A built-in collection of cell formats (such as font size, patterns, and alignment) that you can apply to a range of data. Excel determines the levels of summary and detail in the selected range and applies the formats accordingly.
Axis
A line bordering the chart plot area used as a frame of reference for measurement. The y axis is usually the vertical axis and contains data. The x-axis is usually the horizontal axis and contains categories.

Base Address
The relative path that Excel uses for the destination address when you insert a hyperlink. This can be an Internet address (URL), a path to a folder on your hard drive, or a path to a folder on a network.

Border
A decorative line that can be applied to worksheet cells or objects, such as charts, pictures, or text boxes. Borders distinguish, emphasize, or group items.

Calculated Column
In an Excel table, a calculated column uses a single formula that adjusts for each row. It automatically expands to include additional rows so that the formula is immediately extended to those rows.

Calculated Field (Database)
A field in the result set of a query that displays the result of an expression rather than data from a database.

Calculated Field (PivotTable Report)
A field in a PivotTable report or PivotChart report that uses a formula you create. Calculated fields can perform calculations by using the contents of other fields in the PivotTable report or PivotChart report.

Calculated Item
An item within a PivotTable field or PivotChart field that uses a formula you create. Calculated items can perform calculations by using the contents of other items within the same field of the PivotTable report or PivotChart report.

Category Axis
A chart axis that represents the category for each data point. It displays arbitrary text values like Qtr1, Qtr2, and Qtr3. It cannot display scaled numerical values.

Category Field
A field that's displayed in the category area of the PivotChart report. Items in a category field appear as the labels on the category axis.

Cell
A box formed by the intersection of a row and column in a worksheet or a table, in which you enter information.

Cell Reference
The set of coordinates that a cell occupies on a worksheet. For example, the reference of the cell that appears at the intersection of column B and row 3 is B3.

Certifying Authority
A commercial organization, or a group within a company, that uses tools such as Microsoft Certificate Server to provide digital certificates that software developers can use to sign macros and users can use to sign documents.

Change History
In a shared workbook, information that is maintained about changes made in past editing sessions. The information includes the name of the person who made each change, when the change was made, and what data was changed.
Chart Area
The entire chart and all its elements.

Chart Sheet
A sheet in a workbook that contains only a chart. A chart sheet is beneficial when you want to view a chart or a PivotChart report separately from worksheet data or a PivotTable report.

Column Field
A field that's assigned a column orientation in a PivotTable report. Items associated with a column field are displayed as column labels.

Column Heading
The shaded area at the top of each Data pane column that contains the field name.

Column Heading
The lettered or numbered gray area at the top of each column. Click the column heading to select an entire column. To increase or decrease the width of a column, drag the line to the right of the column heading.

Comparison Criteria
A set of search conditions that is used to find data. Comparison criteria can be a series of characters that you want to match, such as "Northwind Traders," or an expression, such as ">=3000."

Comparison Operator
A sign that is used in comparison criteria to compare two values. The six standards are = Equal to, > Greater than, < Less than, >= Greater than or equal to, <= Less than or equal to, and <> Not equal to.

Conditional Format
A format, such as cell shading or font colour, that Excel automatically applies to cells if a specified condition is true.

Consolidation Table
The table of combined results that appears in the destination area. Excel creates the consolidation table by applying the summary function that you select to the source area values that you specify.

Constant
A value that is not calculated. For example, the number 210 and the text "Quarterly Earnings" are constants. An expression, or a value resulting from an expression, is not a constant.

Constraints
The limitations placed on a Solver problem. You can apply constraints to adjustable cells, the target cell, or other cells that are directly or indirectly related to the target cell.

Copy Area
The cells that you copy when you want to paste data into another location. After you copy cells, a moving border appears around them to indicate that they've been copied.

Criteria
Conditions you specify to limit which records are included in the result set of a query. For example, the following criterion selects records for which the value for the Order Amount field is greater than 30,000: Order Amount > 30000.
Criteria Pane
The area of the window that displays the criteria used to limit the records included in the result set of your query.

Current Region
The block of filled-in cells that includes the currently selected cell or cells. The region extends in all directions to the first empty row or column.

Custom Calculation
A method of summarizing values in the data area of a PivotTable report by using the values in other cells in the data area. Use the Show data as list on the PivotTable Field dialogue for a data field to create custom calculations.

Data Form
A dialogue box that displays one complete record at a time. You can use data forms to add, change, locate, and delete records.

Data Label
A label that provides additional information about a data marker, which represents a single data point or value that originates from a datasheet cell.

Data Marker
A bar, area, dot, slice, or other symbol in a chart that represents a single data point or value that originates from a datasheet cell. Related data markers in a chart constitute a data series.

Data Pane
The area of the window that displays the result set of your query.

Data Points
Individual values that are plotted in a chart. Related data points make up a data series. Data points are represented by bars, columns, lines, slices, dots, and other shapes. These shapes are called data markers.

Data Region
A range of cells that contains data and that is bounded by empty cells or datasheet borders.

Data Series
Related data points that are plotted in a chart and originate from datasheet rows or columns. Each data series in a chart has a unique colour or pattern. You can plot one or more data series in a chart. Pie charts have only one data series.

Data Source
A stored set of "source" information used to connect to a database. A data source can include the name and location of the database server, the name of the database driver, and information that the database needs when you log on.

Data Source Driver
A program file used to connect to a specific database. Each database program or management system requires a different driver.

Data Table
A range of cells that shows the results of substituting different values in one or more formulas. There are two types of data tables: one-input tables and two-input tables.
Data Table in Charts
A grid that can be added to some charts and contains the numeric data used to create the chart. The data table usually is attached to the horizontal axis of the chart and replaces the tick-mark labels on the horizontal axis.

Data Validation
An Excel feature that you can use to define restrictions on what data can or should be entered in a cell, and to display messages that prompt users for correct entries and notify users about incorrect entries.

Database
A collection of data related to a particular subject or purpose. Within a database, information about a particular entity, such as an employee or order, is categorized into tables, records, and fields.

DDE Conversation
The interaction between two applications that are communicating and exchanging data through special functions and code known as dynamic data exchange (DDE).

Default Startup Workbook
The new, unsaved workbook that's displayed when you start Excel. The default startup workbook is displayed only if you haven't included other workbooks in the XLStart folder.

Default Workbook Template
The Book.xlt template that you create to change the default format of new workbooks. Excel uses the template to create a blank workbook when you start Excel or create a new workbook without specifying a template.

Default Worksheet Template
The Sheet.xlt template that you create to change the default format of new worksheets. Excel uses the template to create a blank worksheet when you add a new worksheet to a workbook.

Dependents
Cells that contain formulas that refer to other cells. For example, if cell D10 contains the formula =B5, cell D10 is a dependent of cell B5.

Destination Area
The range of cells that you select to hold the summarized data in a consolidation. The destination area can be on the same worksheet as the source data or on a different worksheet. A worksheet can contain only one consolidation.

Detail Data
For automatic subtotals and worksheet outlines, the subtotal rows or columns that are totalled by summary data. Detail data is typically adjacent to and either above or to the left of the summary data.

Drop Lines
In line and area charts, lines that extend from a data point to the category (x) axis. Useful in area charts to clarify where one data marker ends and the next begins.

Drop-Down List Box
A control on a menu, toolbar, or dialogue box that displays a list of options when you click the small arrow next to the list box.
Embedded Chart
A chart that is placed on a worksheet rather than on a separate chart sheet. Embedded charts are beneficial when you want to view or print a chart or a PivotChart report with its source data or other information in a worksheet.

Error Bars
Usually used in statistical or scientific data. Error bars show potential error or degree of uncertainty relative to each data marker in a series.

Excel add-in
Components that can be installed on your computer to add commands and functions to Excel. These add-in programs are specific to Excel. Other add-in programs that are available for Excel or Office are Component Object Model (COM) add-ins.

Excel table
Formerly known as an Excel list, you can create, format, and expand an Excel table to organize the data on your worksheet.

Expression
A combination of operators, field names, functions, literals, and constants that evaluates to a single value. Expressions can specify criteria (such as Order Amount>10000) or perform calculations on field values (such as Price*Quantity).

External Data
Data that is stored in a database, such as Access, dBASE, or SQL Server, that is separate from Query and the program from which you start Query.

External Data Range
A range of data that is brought into a worksheet but that originates outside of Excel, such as in a database or text file. In Excel, you can format the data or use it in calculations as you would in any other data.

External Reference
A reference to a cell or range on a sheet in another Excel workbook, or a reference to a defined name in another workbook.

Field (database)
A category of information, such as last name or order amount, that is stored in a table. When Query displays a result set in its Data pane, a field is represented as a column.

Field (pivot table report)
In a PivotTable or PivotChart report, a category of data that's derived from a field in the source data. PivotTable reports have row, column, page, and data fields. PivotChart reports have series, category, page, and data fields.
Fill Handle
The small black square in the lower-right corner of the selection. When you point to the fill handle, the pointer changes to a black cross.

Filter
To display only the rows in a list that satisfy the conditions you specify. You use the AutoFilter command to display rows that match one or more specific values, calculated values, or conditions.

Font
A graphic design applied to all numerals, symbols, and alphabetic characters. Also called type or typeface. Arial and Courier New are examples of fonts. Fonts usually come in different sizes, such as 10 point, and various styles, such as bold.

Formula
A sequence of values, cell references, names, functions, or operators in a cell that together produce a new value. A formula always begins with an equal sign (=).

Formula Bar
A bar at the top of the Excel window that you use to enter or edit values or formulas in cells or charts. Displays the constant value or formula stored in the active cell.

Formula Palette
A tool that helps you create or edit a formula and also provides information about functions and their arguments.

Function (Microsoft Query)
An expression that returns a value based on the results of a calculation. Query assumes that data sources support the Avg, Count, Max, Min, and Sum functions. Some data sources may not support all of these, or may support additional functions.

Function (Office Excel)
A prewritten formula that takes a value or values, performs an operation, and returns a value or values. Use functions to simplify and shorten formulas on a worksheet, especially those that perform lengthy or complex calculations.

Goal Seek
A method to find a specific value for a cell by adjusting the value of one other cell. When goal seeking, Excel varies the value in a cell that you specify until a formula that's dependent on that cell returns the result you want.

Grid
A set of intersecting lines used to align objects.

Gridlines in Charts
Lines you can add to a chart that make it easier to view and evaluate data. Gridlines extend from the tick marks on an axis across the plot area.

Group
In an outline or PivotTable report, one or more detail rows or columns that are adjacent and subordinate to a summary row or column.

High-Low Lines
In 2-D line charts, lines that extend from the highest to the Lowest value in each category. High-low lines are often used in stock charts.

History worksheet
A separate worksheet that lists changes being tracked in a shared workbook, including the name of the person who made the change, when and where it was made, what data was deleted or replaced, and how conflicts were resolved.
Identifier
A field name used in an expression. For example, Order Amount is the identifier (field name) for a field that contains order amounts. You can use an expression (such as Price*Quantity) in place of an identifier.

Implicit Intersection
A reference to a range of cells, instead of a single cell, that is calculated like a single cell. If cell C10 contains the formula =B5:B15*5, Excel multiplies the value in cell B10 by 5 because cells B10 and C10 are in the same row.

Index
A database component that speeds up searching for data. When a table has an index, data in the table can be found by looking it up in the index.

Inner Join
In Query, default type of join between two tables where only the records that have the same values in the joined fields are selected. The two matching records from each table are combined and displayed as one record in the result set.

Input Cell
The cell in which each input value from a data table is substituted. Any cell on a worksheet can be the input cell. Although the input cell does not need to be part of the data table, the formulas in data tables must refer to the input cell.

Insert Row
In an Excel table, a special row that facilitates data entry. The Insert row is indicated by an asterisk.

Internet Explorer
A Youb browser that interprets HTML files, formats them into Youb pages, and displays them to the user. You can download Internet Explorer from the Microsoft Youb site at http://www.microsoft.com.

Item
A subcategory of a field in PivotTable and PivotChart reports. For instance, the field "Month" could have items such as "January," "February," and so on.

Iteration
Repeated calculation of a worksheet until a specific numeric condition is met.

Join
A connection between multiple tables where records from related fields that match are combined and shown as one record. Records that don't match may be included or excluded, depending on the type of join.

Join Line
In Query, a line that connects fields between two tables and shows Query how the data is related. The type of join indicates which records are selected for the query’s result set.

Join line
In Query, a line that connects fields between two tables and shows how the data is related. The type of join indicates which records are selected for the query's result set.

Justify
To adjust horizontal spacing so that text is aligned evenly along both the left and right margins. Justifying text creates a smooth edge on both sides.
Legend
A box that identifies the patterns or colours that are assigned to the data series or categories in a chart.

Legend Keys
Symbols in legends that show the patterns and colours assigned to the data series (or categories) in a chart. Legend keys appear to the left of legend entries. Formatting a legend key also formats the data marker that's associated with it.

Locked Field or Record
The condition of a record, field, or other object in a database that permits it to be viewed but not changed (read-only) in Query.

Mapped Range
A range in an XML list that has been linked to an element in an XML map.

Matrix
A rectangular array of values or a range of cells that is combined with other arrays or ranges to produce multiple sums or products. Excel has predefined matrix functions that can produce the sums or products.

Merged Cell
A single cell that is created by combining two or more selected cells. The cell reference for a merged cell is the upper-left cell in the original selected range.

Microsoft Excel control
A native Excel control other than an ActiveX control.

Microsoft Visual Basic Help
To get help for Visual Basic in Excel, on the Developer tab, in the Code group, click Visual Basic, and then under the Help menu, click Microsoft Visual Basic Help.

Moving Average
A sequence of averages computed from parts of a data series. In a chart, a moving average smooth the fluctuations in data, thus showing the pattern or trend more clearly.

Moving Border
An animated border that appears around a worksheet range that has been cut or copied. To cancel a moving border, press ESC.

Multiple-Level Category Labels
Category labels in a chart that, based on worksheet data, are automatically displayed on more than one line in a hierarchy. For example, the heading Produce might appear above a row with headings Tofu, Apples, and Pears.

Name
A word or string of characters that represents a cell, range of cells, formula, or constant value. Use easy-to-understand names, such as Products, to refer to hard to understand ranges, such as Sales!C20:C30.

Name box
Box at left end of the formula bar that identifies the selected cell, chart item, or drawing object. To name a cell or range, type the name in the Name box and press ENTER. To move to and select a named cell, click its name in the Name box.

Non-adjacent selection
A selection of two or more cells or ranges that don't touch each other. When plotting non-adjacent selections in a chart, make sure that the combined selections form a rectangular shape.
**Non-OLAP source data**  
Underlying data for a PivotTable or PivotChart report that comes from a source other than an OLAP database. These sources include relational databases, tables on Excel worksheets, and text file databases.

**ObjectLink**  
An OLE data format that describes a linked object, identifying the class, document name, and name of an object. Each of these data items is a null-terminated string.

**Offline Cube File**  
A file you create on your hard disk or a network share to store OLAP source data for a PivotTable or PivotChart report. Offline cube files allow you to keep working when you are not connected to the OLAP server.

**OLAP**  
A database technology that has been optimized for querying and reporting, instead of processing transactions. OLAP data is organized hierarchically and stored in cubes instead of tables.

**OLAP provider**  
A set of software that provides access to a particular type of OLAP database. This software can include a data source driver and other client software that is necessary to connect to a database.

**Operand**  
Items on either side of an operator in a formula. In Excel, operands can be values, cell references, names, labels, and functions.

**Operator**  
A sign or symbol that specifies the type of calculation to perform within an expression. There are mathematical, comparison, logical, and reference operators.

**Outer join**  
In Query, a join where all records from one table are selected, even if there are no matching records in another table. Records that match are combined and shown as one. Records that don't have matches in the other table are shown empty.

**Outer Join**  
Join in which all records from one table are selected, even if there are no matching records in another table. Records that match are combined and shown as one. Records that don't have matches in the other table are shown as empty.

**Outline**  
Worksheet data in which rows or columns of detail data are grouped so that you can create summary reports. The outline can summarize either an entire worksheet or a selected portion of it.

**Outline Data**  
The data that is contained within a worksheet outline. Outline data includes both the summary and detail rows or columns of an outline.

**Outline Symbols**  
Symbols that you use to change the view of an outlined worksheet. You can show or hide detailed data by pressing the plus sign, minus sign, and the numbers 1, 2, 3, or 4, indicating the outline level.
OwnerLink
An OLE data format that describes an embedded object, identifying the class, document name, and name of an object. Each of these data items is a null-terminated string.

Page Break
Divider that breaks a worksheet into separate pages for printing. Excel inserts automatic page breaks based on the paper size, margin settings, scaling options, and the positions of any manual page breaks that you insert.

Page Break Preview
Worksheet view that displays the areas to be printed and the locations of page breaks. The area to be printed is displayed in white, automatic page breaks appear as dashed lines, and manual page breaks appear as solid lines.

Parameter
In Excel, you can add, change, or remove parameters to specify cells that are editable in the viewable worksheet data of Excel Services. When you save the workbook, the changes are automatically reflected on the server.

Parameter Query
A type of query that, when you run it, prompts for values (criteria) to use to select the records for the result set so that the same query can be used to retrieve different result sets.

Password
A way to protect your worksheet or workbook. When you protect worksheet or workbook elements with a password, it is very important that you remember that password. Without it, there is no way to unprotect the workbook or worksheet. You should always use strong passwords that combine uppercase and lowercase letters, numbers, and symbols. Youak passwords don't mix these elements. Strong password: Y6dh1et5. Youak password: House27. Use a strong password that you can remember so that you don't have to write it down.

Paste Area
The target destination for data that's been cut or copied by using the Office Clipboard.

Pivot Area
The worksheet area into which you drag PivotTable or PivotChart fields to change the layout of the report. On a new report, dashed blue outlines indicate the pivot area on the worksheet.

PivotChart category field
A field that is assigned a category orientation in a PivotChart report. In a chart, categories usually appear on the x-axis, or horizontal axis, of the chart.

PivotChart report
A chart that provides interactive analysis of data, like a PivotTable report. You can change views of data, see different levels of detail, or reorganize the chart layout by dragging fields and by showing or hiding items in fields.

PivotChart Series Field
A field that is assigned a series orientation in a PivotChart report. In a chart, series are represented in the legend.

PivotTable Data
In a PivotTable report, the summarized data that's calculated from the data fields of a source list or table.
PivotTable grand totals
Total values for all cells in a row or all cells in a column of a PivotTable report. Values in a grand total row or column are calculated by using the same summary function used in the data area of the PivotTable report.

PivotTable list
A Microsoft Office Youb Component that allows you to create a structure similar to an Excel PivotTable report. Users can view the PivotTable list in a Youb browser and change its layout in a manner similar to an Excel PivotTable report.

PivotTable report
An interactive, cross-tabulated Excel report that summarizes and analyses data, such as database records, from various sources, including ones that are external to Excel.

PivotTable report
An interactive, cross-tabulated Excel report that summarizes and analyses data, such as database records, from various sources including ones external to Excel.

PivotTable subtotal
A row or column that uses a summary function to display the total of detail items in a PivotTable field.

Plot Area
In a 2-D chart, the area bounded by the axes, including all data series. In a 3-D chart, the area bounded by the axes, including the data series, category names, tick-mark labels, and axis titles.

Point
A unit of measurement equal to 1/72 of an inch.

Precedents
Cells that are referred to by a formula in another cell. For example, if cell D10 contains the formula =B5, cell B5 is a precedent to cell D10.

Primary Key
One or more fields that uniquely identify each record in a table. In the same way that a license plate number identifies a car, the primary key uniquely identifies a record.

Print Area
One or more ranges of cells that you designate to print when you don't want to print the entire worksheet. If a worksheet includes a print area, only the print area is printed.

Print Titles
Row or column labels that are printed at the top of or on the left side of every page on a printed worksheet.

Property Fields
Independent attributes associated with items, or members, in an OLAP cube. For example, if city items have size and population properties stored in the server cube, a PivotTable report can display the size and population of each city.

Protect
To make settings for a worksheet or workbook that prevent users from viewing or gaining access to the specified worksheet or workbook elements.

Report Filter
A field that's used to filter a subset of data in a PivotTable or PivotChart report into one page for further layout and analysis. You can either display a summary of all
items in a report filter, or display one item at a time, which filters out the data for all other items.

**Query**
In Query or Access, a means of finding the records that Answer a particular question you ask about the data stored in a database.

**Query Channel**
You use a query channel in a DDE conversation between the destination application and a specific query (for example, Query1) in Query. To use a query channel, you must have already opened the query window using a system channel.

**Query Design**
All elements included in the Query window, such as tables, criteria, the order in which fields are arranged, and so on. The design also specifies whether Auto Query is turned on, and whether you can edit the source data.

**Range**
Two or more cells on a sheet. The cells in a range can be adjacent or non-adjacent.

**Read-only**
A setting that allows a file to be read or copied but not changed or saved.

**Record**
A collection of information about a particular person, place, event, or thing. When Query displays a result set in the Data pane, a record is represented as a row.

**Refresh (External Data Range)**
To update data from an external data source. Each time you refresh data, you see the most recent version of the information in the database, including any changes that were made to the data.

**Refresh (pivot table report)**
To update the contents of a PivotTable or PivotChart report to reflect changes to the underlying source data. If the report is based on external data, refreshing runs the underlying query to retrieve new or changed data.

**Regression Analysis**
A form of statistical analysis used for forecasting. Regression analysis estimates the relationship between variables so that a given variable can be predicted from one or more other variables.

**Relative Reference**
In a formula, the address of a cell based on the relative position of the cell that contains the formula and the cell referred to. If you copy the formula, the reference automatically adjusts. A relative reference takes the form A1.

**Remote Reference**
A reference to data stored in a document from another program.

**Report Template**
An Excel template (.xlt file) that includes one or more queries or PivotTable reports that are based on external data. When you save a report template, Excel saves the query definition but doesn't store the queried data in the template.

**Result Set**
The set of records returned when you run a query. You can see the result set of a query in Query, or you can return a result set to an Excel worksheet for further analysis.
Row Heading
The numbered gray area to the left of each row. Click the row heading to select an entire row. To increase or decrease the height of a row, drag the line below the row heading.

Row Label
A field that's assigned a row orientation in a PivotTable report.

R-squared value
A number from 0 to 1 that reveals how closely the estimated values for the trendline correspond to your actual data. A trendline is most reliable when its R-squared value is at or near 1. Also known as the coefficient of determination.

Scenario
A named set of input values that you can substitute in a worksheet model.

Scroll Lock
With scroll lock turned on, the arrow keys scroll the active sheet rather than make a different cell active. To turn scroll lock off or on, press the SCROLL LOCK key.

Section
Any combination of a worksheet, view, and scenario that you choose when you create a report. A report can contain several sections.

Select
To highlight a cell or range of cells on a worksheet. The selected cells will be affected by the next command or action.

Select All button
The gray rectangle in the upper-left corner of a datasheet where the row and column headings meet. Click this button to select all cells on a datasheet.

Series Axis
A chart axis that represents the depth dimension in a true 3-D chart. It displays the series names as arbitrary text values; it cannot display scaled numerical values.

Series Field
A field that's displayed in the series area of a PivotChart report. Items in a series field are listed in the legend and provide the names of the individual data series.

Series Lines
In 2-D stacked bar and column charts, lines that connect the data markers in each data series that are used to emphasize the difference in measurement between each series.

Shared Workbook
A workbook set up to allow multiple users on a network to view and make changes at the same time. Each user who saves the workbook sees the changes made by other users.

Single-mapped cell
A cell that has been linked to a non-repeating element in an XML map.

Sort Order
A way to arrange data based on value or data type. You can sort data alphabetically, numerically, or by date. Sort orders use an ascending (1 to 9, A to Z) or descending (9 to 1, Z to A) order.
**Source Areas**
The cell ranges that you consolidate in the destination area you specify. Source areas can be on any worksheet in a workbook, in other open or closed workbooks, or on Lotus 1-2-3 worksheets.

**Source Data**
The list or table that's used to create a PivotTable or PivotChart report. Source data can be taken from an Excel table or range, an external database or cube, or another PivotTable report.

**SQL**
A language used to retrieve, update, and manage data. When you create a query, Query uses SQL to build the corresponding SQL SELECT statement. If you know SQL, you can view or change the SQL SELECT statement.

**Standard Font**
The default text font for worksheets. The standard font determines the default font for the Normal cell style.

**Summary Data**
For automatic subtotals and worksheet outlines, all rows or columns that summarize detail data. Summary data usually is adjacent to and below the detail data.

**Summary Function**
A type of calculation that combines source data in a PivotTable report or a consolidation table, or when you are inserting automatic subtotals in a list or database. Examples of summary functions include Sum, Count, and Average.

**System Channel**
Used in a DDE conversation between applications to get information about the system, such as the current connections, open queries, and the status of the destination application.

**Table Pane**
The area of the Query window that displays the tables in a query. Each table displays the fields from which you can retrieve data.

**Template**
A workbook that you create and use as the basis for other similar workbooks. You can create templates for workbooks and worksheets. The default template for workbooks is called Book.xlt. The default template for worksheets is called Sheet.xlt.

**Text Box**
A rectangular object on a worksheet or chart, in which you can type text.

**Tick Marks and Tick-Mark Labels**
Tick marks are small lines of measurement, similar to divisions on a ruler, which intersect an axis. Tick-mark labels identify the categories, values, or series in the chart.

**Titles in Charts**
Descriptive text that is automatically aligned to an axis or centered at the top of a chart.

**Total Row**
A special row in an Excel table that provides a selection of aggregate functions useful for working with numerical data.
Totals
One of the five calculation types Query defines for you: Sum, Avg, Count, Min, and Max.

Tracer Arrows
Arrows that show the relationship between the active cell and its related cells. Tracer arrows are blue when pointing from a cell that provides data to another cell, and red if a cell contains an error value, such as #DIV/0!.

Trendline
A graphic representation of trends in data series, such as a line sloping upward to represent increased sales over a period of months. Trendlines are used for the study of problems of prediction, also called regression analysis.

Trendline Label
Optional text for a trendline, including either the regression equation or the R-squared value, or both. A trendline label can be formatted and moved; it cannot be sized.

Up-Down Bars
In line charts with multiple data series, bars that indicate the difference between data points in the first and last series.

Value
The text, date, number, or logical input that completes a condition that a field must meet for searching or filtering. For example, the field Author with the condition <b>equals</b> must include a value, such as <b>John</b>, to be complete.

Value Axis
A chart axis that displays scaled numerical values.

Values Area
The part of a PivotTable report that contains summary data. Values in each cell of the values area represent a summary of data from the source records or rows.

Value Field
A field from a source list, table, or database that contains data that is summarized in a PivotTable report or PivotChart report. A value field usually contains numeric data, such as statistics or sales amounts.

Vertexes
Black, square, drag gable points that appear at the ends and intersections of lines or curves in certain AutoShapes (such as freeforms, scribbles, and curves) when you edit points on the AutoShape.

View
A set of display and print settings that you can name and apply to a workbook. You can create more than one view of the same workbook without saving separate copies of the workbook.

Youb query
A query that retrieves data stored on your intranet or the Internet.

What-if analysis
A process of changing the values in cells to see how those changes affect the outcome of formulas on the worksheet. For example, varying the interest rate that is used in an amortization table to determine the amount of the payments.
Workbook
A spreadsheet program file that you create in Excel. A workbook contains worksheets of rows and columns in which you can enter and calculate data.

Worksheet
The primary document that you use in Excel to store and work with data. Also called a spreadsheet. A worksheet consists of cells that are organized into columns and rows; a worksheet is always stored in a workbook.

Workspace file
A file that saves display information about open workbooks, so that you can later resume work with the same window sizes, print areas, screen magnification, and display settings. A workspace file doesn't contain the workbooks themselves.

World Wide Youb
A system for navigating the Internet or through a collection of workbooks and other Office documents connected by hyperlinks and located on a network share, a company intranet or the Internet. When you use a Youb browser, the Youb appears as a collection of text, pictures, sounds, and digital movies.

Wrap
In text, to break a line of text automatically on reaching a margin or object and continue the text on a new line.

XML
Extensible Markup Language (XML): A condensed form of Standard Generalized Markup Language (SGML) that enables developers to create customized tags that offer flexibility in organizing and presenting information.